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Chapter One
WELCOME TO SYSTEM 6

One Small Step...

Apple 1IGS System Software 6.0 is a giant leap forward for the Apple I, the computer which
launched the personal computer revolution. In its current incarnation as the Apple IIGS, the
Apple I remembers the past with complete compatibility with older software, while looking into
the future with a Macintosh-style graphic user interface and toolbox. Now with System 6, the
IGS gains even more speed, power, and compatibility. And the best part is that System 6 works
on the computer you own now!

You've probably heard a lot about System 6, thanks to Apple. Developers saw a very rough
version of System 6 at the A2-Central Summer Conference in July, 1991 and were mailed a pre-
release version on CD-ROM later that year. Unexpectedly, these developers were actually
encouraged to discuss System 6 on electronic information services and in other media. Apple
software engineers, too, were permitted to talk about System 6 publicly, leading to an
unprecedented amount of pre-release discussion.

We're pleased to tell you that most of what you've heard is true. System 6 will catapult your
lIGS into the nineties and beyond. We think you'll enjoy the trip.

What’s New

Here are the most important new features of System Software 6.0.

* StyleWriter printer support. Now you can use Apple’s low-cost inkjet printer with any
Apple HIGS Desktop program. System 6 also has more large fonts to take advantage of
the capabilities of this and other high-resolution printers.

* Macintosh, Apple DOS 3.3, and Apple Pascal disk support. Now your IIGS can read
Macintosh, DOS, and Pascal disks as easily as standard ProDOS disks. System 6 can
format and write to Macintosh disks as well (DOS and Pascal disks can only be read).
The 11GS still can’t run Macintosh software, but exchanging data is easier than ever,

* A completely redesigned Finder. Faster, friendlier, and more powerful than ever
before, with advanced features like tunneling and Finder extensions.




s All-new desk accessorics featuring a Calculator and Find File. Even the Control Panel
has been revamped-—eceach Control Panel now appears in its own independent
window, just like on Macintosh System 7.

* A general rounding-off of rough edges. The Finder can be set to avoid grinding your
5.25” drives. When the computer asks you to insert a disk it needs, you no longer have
to hit Return—the computer detects it automatically. The screen no longer switches to
text mode and back to graphics when launching some Desktop programs.

* New music tools and applications to allow new programs to sound even better. You
may have heard of SynthLab, Apple’s prototype music program—it’s included.

* Media-control toolset and desk accessorics to allow even easier integration of video
with your multimedia presentations.

* Special Aids (Video Keyboard, CloseView, and Easy Access) for physically
handicapped users.

* More tools for programmers to write great programs. Like drivers for Apple flat-bed
scanners and SCSI tape drives. You may never use these tools directly, but they’ll make
writing quality 11GS software even casier. And eventually more and more 11GS programs
will take advantage of special System 6 features.

s Simpler and faster hard drive installation. The new Installer’s Easy Update option lets
you install System 6 painlessly from the self-booting Install disk. If you need to
customize your installation, of course, you can do that too!

* ProDOS 8 Enhancements. ProDOS 8 now remaps other hard drive partitions to unused
slots, starting with Slot 1. At last—if you have a hard drive attached to an Apple SCSI
card, you can now access all your partitions from ProDOS!

There’s much more, of course. System 6 is a project that took a team of skilled programmers
over a year to complete. To learn more about the new features of System 6, look for the sections
throughout this book labeled with a ®.

System Requirements

System 6 requires a minimum of 1.25 megabytes of RAM with ROM 01 (the standard
configuration plus a 1 megabyte expansion card), or 1.125 megabytes of RAM on ROM 03 (the
standard configuration), and a single 3.5” drive. A hard disk drive is highly recommended (hard
drive installation requires 2 megabytes of RAM). Additional memory and/or an additional 3.5”
drive are highly recommended. System 6 also supports many other peripherals, including
printers, modems, 5.25” drives, and modems.
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About This Book

Contents

We start out by telling you how to get started with System 6—by making backup copies and
installing System 6 on your hard drive, if you have one. Next, we talk about how System 6 and
the Apple IIGS Desktop work—this is must-read information if you're not familiar with using
Desktop programs. Then we talk about the Finder and System 6s desk accessories, control
panels and utilities.

Each section is divided into chapters, which are further divided into logical divisions that make
finding the material you need simple. We hope you find this book an enjoyable and useful
reference as you use System 6.

Conventions

We've made this book easier to navigate by differentiating the chapter titles and subheadings in
different sizes and styles of Optima, an extremely casy-to-read typeface. We also draw your
attention to the types of information below with special formatting:

= Note!
These paragraphs contain essential information that requires your complete attention.
Understanding this information is very important to effective use of System 6.

@ Warning!
These paragraphs alert you that you might damage equipment or lose data if you don’t follow
the instructions carefully. This icon is a sort of emphatic Note! icon.

ws  Shortcut
These paragraphs alert you to time-saving technigues that can make your life easier.

A By The Way...
These paragraphs contain interesting but nonessential information related to the topic at hand.

® New & Improved
These paragraphs tell you how System 6 differs from previous system versions, pointing out
completely new features or familiar features that work differently in System 6.

What Should I Read?

If you're new to the 11GS or have been using the 11GS only to run programs like AppleWorks and
have little experience with the 1IGS way of doing things, we suggest starting reading this entire
book. If you're a seasoned IIGS user updating from System 5, you'll want to skim the Desktop
and Finder chapters (looking for ® New & Improved scctions and similar information) and pay
close attention to the Utilities chapter.
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About The Disks

The Apple Disks
Apple ships [IGS System Software 6.0 on six 3.5” disks. Thesc disks are:

System Disk—System 6 on a bootable stand-alone 3.5” disk
System Tools 1 & 2—Additional system elements for installation
Fonts—Additional fonts for users with high-resolution printers
Install—A bootable 3.5” disk for performing System 6 installation
SynthLab—The SynthLab application and sample music files

e & & e o

The Bonus Pack Disks

If you bought the System 6 Bonus Pack, you got six additional 3.5” disks:

* Bonus Stuff—Desk accessories, icons, clip art, Shrinklt, FlashBoot, and HyperSound

* Bonus Fonts 1 & 2—More unique and interesting fonts to supplement Apple’s selection
e Bonus Sounds 1T & 2—Sounds to spice up your lIGS desktop and hypermedia stacks

» ZZCopy—Utility for backing up 3.5” disks, plus shareware programs
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Chapter Two

GETTING STARTED

Read This Before Doing Anything!

If You Don’t Have A Hard Drive

If you don't have a hard drive, we heartily suggest making the investment. While System 6 will
run fine on 3.5-only systems, you may end up with longer waits and, if you have only a single
3.5 drive, more disk swapping than with previous versions of the [IGS System Software. A good,
fast hard drive is the single most significant improvement you can make to your computer
because it allows you to store not only your System Software but all your programs and data on
a single high-speed storage device. Don't take our word for it—ask anyone who already uses a
hard drive on their IGS. If you don't have the funds for a hard drive, an additional 3.5 drive or
more memory can provide many of the same benefits at a lower cost.

If you decide not to get a hard drive, you won't really “install” System 6. You'll just start up the
computer from the System 6 System Disk, just as you started up the System 5 (or earlier) System
Disk when you wanted to use that System version. You may find that the additional features of
System 6 are worth the occasional disk swap and choose to run under System 6 all the time, or
you may decide to use System 6 only when you need its special features and start up directly
into other programs via whatever System Software they came with. It's your choice.

If you have more than two megabytes of memory installed in your Apple 11GS, you may want to
reserve some of your memory for use as a RAM Disk and install System 6 on the RAM Disk. See
the FlashBoot manual for more information on using your 11GS RAM Disk and our exclusive
FlashBoot utility.

= Note!
Be sure to back up your System 6 disks before using them. See the section after the next one
for instructions on using the ZZCopy program.

The System Disk included with the System 6 package is a minimum configuration. It's adequate
for running most programs, but a few programs may require additional tools, fonts, or drivers to
be installed. The System Disk has a little free space on it, so you can make another backup of
the original System Disk, install the additional software on it, and use that as a special-purpose
System 6 startup disk for a particular program. For more details on the Installer, see the hard
drive installation section in this chapter.




If You Do Have A Hard Drive

We suggest resisting the temptation to install everything at once. That makes getting used to
System 6 more difficult than it needs to be, and it also makes diagnosing your problems harder
too. First install the System 6 “Easy Update” (hard drive installation instructions will follow in a
moment). Then browse through this book and Icarn about System 6’s new features. Skip over
any sections that talk about software you haven’t installed yet. Then install any additional
System 6 features you want, and get used to them, too. Finally, install the System 6 Bonus Pack
if you purchased it, and learn to use its features.

Remember, even seasoned uscrs can feel overwhelmed by adding half a dozen disks” worth of
new software to their computing environment.

== Note!
Before doing anything, read this entire chapter and make sure you understand how to install
System 6. If you don't, call our Technical Support department for clarification.

Making Backup Copies

Before beginning installation of System 6, you should make a sct of backup disks. (The same is
true of any program you get. Back up the originals, put the originals in a safe place, and usc
only the backups.) Yeah, we know some of you won’t make the backups because there are 50
many disks—that’s not our fault, though. MAKE THE BACKUPS!

A By The Way...
If you have to calt our technical support line to get a new copy of a disk you somehow messed
up, the first thing our tech guys are going to ask is, “What happened to your backups?” and
you’re going to feel really, really stupid. Of course, if the disk was bad right out of the box we’ll

replace it promptly and we won't Jaugh at you at all.

If you have a favorite utility you use for making backup copies of disks (Copy Il Plus, for
example), feel free to use it to back up your disks and skip this section. The FastCopy program
that comes with AppleWorks is quite simple to use and will do an admirable job of backing up
the System 6 disks. Use whatever you’re most familiar with.

If you bought the System 6 Bonus Pack, we've also included a utility called ZZCopy which can
be used to make backup copies of the System 6 disks. To use this program to make backup
copies of your disks, follow these steps:

1. Make sure the IIGS Startup Slot is sct to “Slot 57 using the Control Panel. (If you’re not
familiar with the Control Panel, consult your Apple 11GS Owner’s Manual.)

2. Put the ZZCopy disk in your first (or only) 3.5” drive and start up the computer (turn on

the computer if it's off, or hold down & and Control while pressing Reset if the
computer is already on).
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3. When ZZCopy is finished loading, you'll see a picture of the designers of ZZCopy and
your HIGS will say “Welcome.” Then the ZZ Copy disk will be ejected and message
“Insert Source” will appear.

4. Grab one of your original System 6 disks (it doesn’t matter which one you start with as
long as you copy them all) and open the write-protect slide, then insert it in your first
3.5" drive. ZZCopy will read the disk, then display the message “Insert Target.”

5. Insert a blank or reusable disk. (If you have two disk drives, put it in your second
drive.) This disk will be completely erased, and ZZCopy won't ask you if it's OK to
erase it first, so make sure there’s nothing important on it! ZZCopy will write a copy of
the original disk onto your backup, then display the message “Insert Source.”

6. Repeat steps 4 and 5 until you've backed up all the System 6 (and Bonus Pack) disks,
including the ZZCopy disk.

7. Don’t forget to set the Startup Slot back to your usual setting—normally “Scan”—using
the Control Panel.

if, during the copy operation, ZZCopy detects an error, the IlGS will say “Alert!” and display an
error message on the screen. If the error is on your target disk (the one you're copying onto),
throw out the bad disk and go back to Step 4 to reload the original disk. Use a different target
disk this time. If there’s an error on the source disk (an original), call Quality Computers and
we’ll send you a new copy of that disk.

Installing System 6 On Your Hard Drive

Keeping Existing System Software

If your hard drive already has System 5 (or another older system) installed, you may want to
keep it around until you’re used to System 6 and are sure it's compatible with all the programs
you're already using. (Plus you’ll be able to move your favorite desk accessories, fonts, and
other system enhancements from the old System to the new System and back.)

The easiest way to keep System 5 on your hard drive while installing System 6 on the same
drive is to rename the System and Icons folder. You don't have to do this, and we definitely
suggest you don't do it just yet—read this whole section before doing anything—and make sure
you’ve made backup copies of your System 6 disks first.

Here's how (we'll assume you're already familiar with using your hard drive, at least a little):
» Start up your system as you normally do, booting from the hard drive.

° If any windows are open, close them all by pulling down the “File” menu and
selecting “Close All.”

Getting Started 7




* Double-click your startup disk’s icon (in the upper right corner of the screen) to open
its window,

* Make sure there's at least 1 megabyte (MB) free by looking at the information bar in
the window you just opened. If there’s not at least that much disk space free, you
should free up some space (by deleting unused files or moving information to other
hard drives or disks) before trying to install System 6.

* Scroll the window until you find the System folder, a folder with a rainbow apple on it.

* Click the System folder once, then type “System5” (without the quotes) on the
keyboard, and press Return.

* Find the Icons folder in the window. Click it once and type “lcons5” (again omitting
the quotes) and press Return.,

@ Warning!
Once you've performed this procedure, you won’t be able to start up from your hard drive until
you've installed new system software on it. You should install System 6 immediately after
performing this procedurs.

Preparing For Installation

Make sure your 11GS’s Startup Slot is set to Slot 5, so that the computer starts up from the 3.5”
floppy drive. (You can do this using the IGS Control Panel. If you're not familiar with the
Control Panel, see your Apple HGS Owner’s Manual.)

System 6 includes a self-booting installation disk that includes the driver for the Apple SCSI
Card. This means that System 6 will recognize most hard drives automatically. If you have a
SCSI-compatible hard drive connected to your computer via an Apple SCSI Card, start up your
system from the Install disk and proceed directly to the installation instructions.

If you have an Applied Engineering Vulcan hard drive, you must boot from a disk containing the
Vulcan driver before you can run the installer. If you don’t, the Installer will think you have
ejected your hard drive during the installation and ask you to “Insert the disk AE1.”

There’s not enough room on the Install disk for the Vulcan driver. The System Disk does have
some free space on it, so we suggest installing the Vulcan driver on the System Disk (placing it
in the Drivers folder, inside the System folder, as described in the Vulcan manual), starting up
from that disk, inserting the Install disk after the Finder appears, and double-clicking the Installer
to start it up. If you have a single 3.5 drive, you'll be in for some additional disk swapping, but
installation isn’t something you do cveryday, anyway.

If you have a RamFAST/SCSI hard drive controller, you don’t need its driver installed to perform

System 6 installation. The Install disk will work fine for installing System 6 on a hard drive
connected to a RamFAST/SCSI card; just start up from the Install disk and proceed.
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Easy Update

The Installer’s “Easy Update” screen (Figure 2A) is fairly straightforward. There's a message that
tells you what disk System 6 will be installed on—in our example, it says “Click ‘Easy Update’
to install Apple 1IGS System Software on the disk ‘Q1”.” If the name of the disk is wrong, use the
mouse to move the arrow to the “Change Disk” button, like it is in our example. Click the
mouse button once and wait to see what disk appears next. (It may take a second or two for the
next disk’s name to appear). If that's not the right disk, click the mouse button again and wait for
the next disk name to appear—keep doing that until the name of the disk you want to install
System 6 on appears on the screen,

A By The Way...
If you have a Q Drive, you probably want to install System 6 on the disk named “Q1.” If you
have a Vulcan, you'll probably want to install to “AE1.” If you have some other hard drive, the
name will probably be different, but you should recognize it when it appears. In any case, you
want to install System 6 on the first partition on your hard drive.

= Note!
If the correct disk name never appears, contact Technical Support for heip. If, on the other
hand, it appears briefly and then disappears, you're clicking the “Change Disk” button too
quickly. Remember to wait until the new disk name appears on the screen before clicking
“Change Disk” again.

ile £dit Help

Click *"tosy Update® to install Apple 116S E
§guslt'e| Software version 6.0 on the disk

FosylUpdate |

Click “Change Disk” if “Easy Update* is :
disubled. *Easy Update” can’t modify the Change Disk

current startup disk, the Installer ( Eject ) [
disks, or non-ProD0S disks. g
|

Figure 2A—System 6 Installer: Easy Update Screen
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Once you've selected the disk you want to install System 6 on, move the arrow to the “Easy
Update” button and click the mouse button. Installation will begin. You'll be prompted to
switch disks a few times—just remove the disk the computer is finished with, and insert the next
disk. The HIGS will automatically detect that you've inserted the new disk and continue—there’s
no need to press Return or click the on-screen “Ok” button.

= Note!
If the Easy Update button is “dimmed” (i.e., the words “Easy Update” are displayed in gray
instead of in black), you're probably trying to install System 6 on the disk you started up from.
Start up from the Installer disk (or from the System disk containing the Vulcan driver, if you
have a Vulcan hard drive) and try again.

After installation is complete, set the Startup Slot back to its usual value (“Scan” or “Slot 7" in
most systems) using the Control Panel. Hold down & and Contro! while you press and release
Reset to restart the computer and enter the world of System 6.

If you have an AE Vulcan hard drive, an AE High Density 3.5” drive, a RamFAST/SCSI card, or
any other third-party device requiring a driver {such as Hewlett-Packard printers) install their
drivers according to the directions that came with the device. (If the driver software is old, it
might be a good idea to contact the manufacturer to make sure the driver is compatible with
System 6 before installing it.)

You can install additional system software features right away, as well, but we suggest you get
used to System 6’s basic features before you add any other features, especially if you're fairly
new to the 1IGS. Read through this manual (particularly the chapter on the Finder) and then,
when you're comfortable with System 6, install additional features like Macintosh disk
compatibility, networking, sounds, and drivers for your other peripherals like CD-ROM.

Installing Additional Features

As we mentioned in the last section, the Installer can install many System 6 updates, not just the
“Easy Update.” Once you're familiar with the basic System 6 features, you can install additional
features as easily as you installed the original system software.

Remember, each additional feature you install needs more memory and more disk space. If you
plan to use all of System 6’s features, we suggest a minimum of 2 megabytes of RAM—and the
more, the better.

To install additional System 6 features, get into the Installer as described in the section above
and choose a disk using the “Change Disk” button. Then click the “Customize” button. A list of
available system updates (Figure 2B) will appear. Use the scroll bar to the right of the list to look
at the entire list of updates; select the updates you want to install from the list.

To select more than one update to be installed at once, hold down the & key while selecting the

second and subsequent updates. (The same maneuver can also be used to unselect an update
that you selected accidentally.)
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Figure 2B—System 6 Instalier: Custom Installation

System 6: Hard Disk or FDHD: Installs the “Easy Update,” plus some additional system
software such as the Calculator and Find File NDAs, the HFS FST (for accessing
Macintosh disks), the Sounds control panel, and the Special Aids software. This update
requires at least a megabyte of disk space (and thus, you must install it on a hard drive
or high-density 3.5” disk). We suggest that you install the “Easy Update” instead, and
then install the other items that interest you, because the Special Aids are incompatible
with several popular programs including AppleWorks GS.

System 6: No “Start” Update: Installs the same software as above, but doesn’t update
your existing Start application. (Use this update to completely replace older System
Software with System 6 while keeping your current program selector, such as ProSel or
Wings.)

System 6: On 800K Disk: Installs the bare minimum System Software on a blank 3.5”
disk or RAM Disk in less than 800K.

Application: Installs the named application—Advanced Disk Utilities (useful for
partitioning and formatting a hard drive), Apple Bow! (a bowling game), Archiver (a
backup utility for 3.5” and hard drive users), SynthLab (a new music program), or
Teach (a simple word processor). We suggest Archiver and Teach as definite must-
install programs, and SynthLab is great if you're at all interested in music. Having the
Advanced Disk Utilities on your hard drive doesn’t seem that useful to us—if you
format or partition the drive, everything, including ADU, will be erased.

Control Panel: Sound: Installs the Sound control panel and a few sample sounds. This
is a definite must-install for most hard drive users—it’s useful, and a lot of fun, too.

Getting Started
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Once you've selected the update(s) you want to install, click the “Install” button to begin
installation. The Installer will prompt you to swap disks when needed; just eject the old disk and
insert the correct disk. The Installer will automatically detect the new disk and continue the

Desk Acc: Installs the named desk accessory, the Calculator or Find File. Find File is a
must-have for hard drive users; the Calculator is also useful, but there’s a better one in
the System 6 Bonus Pack.

Drive and Driver: Installs drivers for the named devices. The “Easy Update”
automatically installs Apple Disk 5.25”, Apple Disk 3.5, and SCS! Hard Disk drivers if
you have those devices attached to your computer. If you have other devices, install
them here.

File System: Installs File System Translators (FSTs) for Macintosh (HFS) disks, Apple
DOS 3.3 disks, and Apple Pascal disks. The HFS FST is highly recommended; it allows
you to read, format, and write Macintosh disks in your Apple IIGS drives, and
additionally lets you access Macintosh hard drives attached to your computer. The
DOS 3.3 and Pascal FSTs allow you to read (not write) 5.25” disks in these older disk
formats.

Fonts: The “Easy Update” option installs “Standard” fonts if there’s enough room or
“Minimum” fonts otherwise. We recommend that hard drive users install “All” fonts.

Media Control: These install drivers for various types of video and audio disc players,
along with the Media Control Toolkit, which allows you to control these devices as
part of multimedia presentations. Media drivers should be installed if you have a MIDI
synthesizer interface; VideoMix should be installed if you have a Video Overlay Card.

Network: Network updates should be installed if you're attached to an AppleTalk
network and want to share files or print to a shared printer.

Printer: Install the correct update(s) for your printer(s), including network (marked as
“ATalk”) printers such as the LaserWriter, ImageWriter, and ImageWriter LQ.

Special Aids: These are tools for helping physically handicapped users use the IIGS.
CloseView magnifies the screen; Easy Access provides “Sticky Keys” and “Keyboard
Mouse” features; Video Keyboard provides an on-screen keyboard that users can click
instead of typing on the keyboard. We do not recommend Special Aids for most users,
because some are incompatible with popular programs such as AppleWorks GS.

installation,

When the installation is complete, change the Startup Slot (in the Control Panel) back to its

usual setting—usually “Scan”—and restart the system to begin using the updates.

12
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Summing up, then, we recommend the following updates for most hard drive users:

Easy Update to start with

Archiver, Teach, and SynthLab applications

The Sound control panel

The Find File and Calculator desk accessories

Drivers for any disk drives you have attached to your 11GS
All file System Translators (what the heck, you might as well)
All fonts

Driver(s) for your printer(s)

¢ & © & © © ¢ o
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Warning!

When installing Apple system software, always use the Installer. The Installer will always make
sure you have all the files you need for a particular installation. If you attempt to install system
software manually, using the Finder or a similar tool, it's all too sasy to miss files, or fo not
update files that need updating. This can cause unexplained system problems.

Installing The Bonus Pack

We recommend that you install the Bonus Pack only after you're thoroughly familiar with the
features of System 6. Installing before you’ve read this manual will only confuse you, because
some of the things we discuss elsewhere in this book apply only to standard Apple-issue System
6. The Bonus Pack adds a number of new features to System 6, but it is not provided by Apple.

The Bonus Pack is installed via a program called Shrinkit. Shrinklt allowed us to pack lots of
extras into the Bonus Pack—much more “stuff” than would normally fit onto a disk—because it
can actually make files smaller. Shrinklt isn't quite as easy to use as the Installer, though,
because it's a general-purpose program. We assume some familiarity with using Desktop
programs (which you'll gain if you read this manual, or which you may already have).

To get into Shrinklt, start up your system from your hard drive as you normally do. (If you don’t
usually start up into the Finder, get to the Finder by quitting your startup application or by
launching the Finder from your program selector.) Insert the Bonus Stuff disk and double-click
its icon. Then click the GSHK icon—that’s the GS Shrinklt application. Now you're ready to
install part or all of the Bonus Pack.

We'll run you through installation of the Bonus Desk Accessories; they're typical:
1. Choose “Open” on Shrinklt's File menu, insert the Bonus Stuff disk, and double-click
the file “Desk.Accs.SHK” to open it. The contents of the file will appear in Shrinklt's
archive window (Figure 2C).

2. Pull down the Edit menu and choose “Select All.” The files in the list will turn green.

3. Click the “Extract” button. A Standard Save dialog will appear. Click the “Volumes”
button, than double-click the disk you want to install on (your startup disk).

Getting Started 13




Once you've done that, you'll have a pretty good handle on how to install most of the other

When the list of files and folders on your startup disk appears, find the System folder
and double-click it to open it.

Find the Desk.Accs folder on that list, and double-click it to open it. The name at the
top of the window should now read “Desk.Accs” (Figure 2D).

_ Click the “Extract” button and stand back while Shrinklt places all the Bonus Desk

Accessories in the Desk.Accs folder on your startup disk.

. When that’s finished, select “Close” from the File menu.
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Figure 26—Shrinklt: Archive Window (Desk.Accs.SHK Opened)

Bonus Pack items. Here are some pointers:

« Sounds: Before you install the Bonus Sounds, make sure you've already installed the

14

Sound control panel (see previous section). There are two disks worth of sounds. You'll
insert the Bonus Sounds 1 disk first and open the “Sounds.1.SHK" file. Then choose
“Select All” from the Edit menu, and click “Extract.” Follow Steps 3 and 4 above. In
Step 5, open the Sounds folder (not Desk.Accs), then click Extract and stand back.
Now close the Sounds.1.SHK archive (“Close” from the File menu). Follow the same
procedure with the “Bonus Sounds 2” disk and the “Sounds.2.SHK” file. You won't
need to tell Shrinklt to move to the Sounds folder when you're unpacking the second
batch of sounds—it will remember that folder from the first extraction.
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* Fonts: There are also two disks of Bonus Fonts. They go in the Fonts folder inside the
System folder on your startup disk. Follow the instructions for “Sounds” above, except
remember that wherever it says “Sounds” you should think “Fonts.”

e Finder Extensions: The Bonus Finder Extensions are on the Bonus Stuff disk, in a file
called “Finder.Ext.SHK.” They go in the System.Setup folder inside the System folder
on your startup disk. Follow the instructions above for installing the Desk Accessories,
except open “Finder.Ext.SHK” in Step 1 and open the System.Setup folder in Step 5.

e Icons: The Bonus lcons are also on the Bonus Stuff disk, in a file called “lcons.SHK.”
Open this file as above. However, in Step 4, open the Icons folder instead of the
System folder. Skip step 5 entirely—the Bonus Icons go directly in the Icons folder on
your startup drive.

e Clip Art: The Bonus Clip Art is on the Bonus Stuff disk in a file called “Clip.Art.SHK.”
Open this file using Steps 1 through 3 above, using the appropriate disk and file. Skip
Steps 4 & 5—unpack the clip art to your startup disk by clicking “Extract” in the
Standard Save dialog. Shrinkit will automatically create a folder called Clip.Art and
place all your Bonus Clip Art files in this folder.

There, you're done (whew)! Choose “Quit” from Shrinklt’s File menu to return to the Finder,
then restart the computer to take advantage of the new Bonus Pack features!
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CZ2<abesk fAoes (Prof0s)
Iy Colouloter | ( Velumes )
[y CantyolPansd ]
5 Findfile Hew Folder...
ENIGMA
File Manager CEE:)
FileMgr.Docs
KeyFind -
HEMDRYBAR 3] € Extroct | )
Hinstrel < ios h
NOTEPAD Prompt before overwriting
SCR“PBOUK UNUW L) SUTUY ] AUUT1ICa.,. ) DD o
ShowPic NOR  65% 36636 M e
ShowPic.Docs TEXT  5i% 27718 NV ( AddDisk.. )|

Figure 2B—Shrinkit: Extracting Bonus Desk Accessories to Desk.Accs Folder
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= Note!
If you don’t want to install all of the Bonus Desk Accessories (or Sounds, or whatever), check
the disk for a Shrinklt instruction file. Among other things, this will tell you how to extract only
some of the files from a Shrinkit archive. (Basically, you click only the file you want to install
instead of choosing “Select All.”) Plus you'll learn how to use one of the most useful [I1GS
programs around! Alternately, you could unpack the Bonus files to another folder, and move
the ones you want to use into the appropriate folder inside your System folder.

¥elcome to the les
System 6.0

Figure 2E—System 6 “Splash Screen”

Starting Up System 6

You'll start up System 6 the same as any other disk—by turning the computer on with the
appropriate disk in a drive (or with your hard drive ready to go), or by holding down & and
Control while pressing and releasing the Reset key. And, on the surface, System 6 looks a lot
like System 5, which you may already be familiar with.

The first thing you see is the System 6 “splash screen” (Figure 2E). This screen tells you that

you're using System 6 and gives you some indication of how much longer the system will take
to start up, via the red thermometer bar, which fills as System 6 loads.

By The Way...

started up your computer from that disk. It's only an estimate. Your startup time may change

A
J}j"_) Z The thermometer fills at a rate that reflects how long it took to load System 6 the last time you
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when you add or remove items from the System folder.
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As System 6 loads, it displays small pictures—icons—across the bottom of the screen. These
small pictures tell you which startup items are loading—for example, the “boot” icon tells you
that the SetStart control panel has just loaded.

A By The Way...
You can keep your startup items (called “inits” in 11GS parlance) and desk accessories from
loading by holding down the Shift key as you start up the computer. When the message “No
Inits/DAs” appears under the “Welcome to the 11GS” banner, you can release the Shift key.

When the thermometer fills and the System 6 splash screen disappears, a program called the
Finder usually appears. (You can change your startup program with the SetStart control panel).
The Finder is “home base” for 11GS users—you’ll use the Finder to back up and maintain your
disks, as a “launch pad” for running your programs. If you’re unfamiliar with the Finder (or wish
to learn more), be sure to read Chapter 5.

Switching Between System 5 & System 6

Once System 6 has been installed, you can switch back to System 5 without removing System 6
by doing the following things (assuming you took our suggestion about renaming your existing
Icons and System folders): ‘

Open your startup drive’s icon.

Click the System folder, type “Systemé” and press Return.

Click the Icons folder, type “Icons6” and press Return.

Click the System5 folder, type “System” and press Return.

Click the Icons5 folder, type “Icons” and press Return.

Restart your 1IGS by holding down the & and Control keys while pressing and releasing
the Reset key.

You can switch back to System 6 from System 5 (assuming you've followed the above
procedure) by performing these steps:

Open your startup drive’s icon.

Click the System folder, type “System5” and press Return.

Click the Icons folder, type “Icons5” and press Return.

Click the Systemé folder, type “System” and press Return.

Click the Iconsé folder, type “Icons” and press Return.

Restart your IIGS by holding down the & and Control keys while pressing and releasing
the Reset key.

® © & o o o
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Don’t Forget!

Check the System 6 disks for “Read Mc” files that contain last-minute instructions that didn't

make it in time for the manual. The “Shortcuts” file on the System Tools 2 disk is full of
interesting information, some of which you won’t find anywhere in this book!

And... remember to enjoy System 6!
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Chapter Three
WELCOME TO THE DESKTOP

The Desktop Metaphor

In the early eighties, some software engineers at Xerox's Palo Alto Rescarch Center (PARC)
began working on more effective ways to allow people to communicate with computers. Their
studies found that most people process pictures faster than words, and that they prefer to
manipulate their work as directly as possible. Based on these results, they began designing a
brand new user interface that was intuitive, pictorial, and direct. (The user interface is how you,
the user, communicate with your computer. Early user interfaces were based on typing
commands. Today’s Graphic User Interfaces, also called GUIs, owe a lot to Xerox’s research.)

Steve Jobs, co-founder of Apple and father of the Macintosh, saw an early version of the Xerox
team’s user interface on a visit to PARC. He decided that the basic elements of the Xerox user
interface (an on-screen pointer linked to a pointing device called a mouse, along with movable
windows, small pictures called icons, and a compact pull-down menu system) would be a part
of Apple’s next computer—the Lisa,

The Lisa, which cost $10,000, was a less-than-stunning commercial success, so Apple soon
dumped it and introduced a similar but less expensive computer—the Macintosh. The rest of
that story is, of course, history—and the technology also made its way to the Apple Il line. The
Apple lIGS is the first Apple I to feature built-in support for the Apple Desktop user interface,

So What’s The Metaphor?

For keeping cows in, of course. But seriously, a metaphor (when you're talking about
computers—forget the definition you learned in English class) is simply a computerized model
of the real world. Most people work at a desk; the desktop metaphor is a way of allowing you to
do work on the computer in a manner as close as possible to the way you work in the real
world, using simulations of familiar tools.

Of course, the simulation isn’t perfect. No one who works with a computer really thinks they’re
working on a desktop. Most people’s desks aren't the bright blue of the 11GS Desktop, for one
thing, and when writing notes on a real notepad most people don’t reach for the Edit menu to
select Cut when they make a mistake. But the Apple Desktop has been tested and refined to
such an extent over the years that the 11GS is probably as easy to use as a computer can be—at
least until the next user interface breakthrough. The Desktop’s goal is to make the computer an
extension of your mind, so you can work without thinking about how to use the computer.
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Consistency

One of the real conceptual breakthroughs of the Apple Desktop is that all Desktop programs
behave similarly. When you see the blue desktop screen appear with the menu bar at the top,
you can assume that the program does certain things in certain well-defined ways, even if
you’ve never used that particular program before. For example, if you want to stop using the
program, you'll always find the Quit command in the File pull-down menu. If you want to move
some of your data from one part of a document to another, you first select the data you want to
copy, then you use the Cut and Paste functions in the Edit menu. Always. Furthermore, you can
safely assume that 3-X activates the Cut function and G-V activates the Paste function.

We'll cover all of the above information in more depth later. For now, just remember that
consistency is an important feature of the Apple Desktop. Individual programs may extend the
desktop metaphor in ways that make sense in that program, but every true Desktop program is,
to a point, similar to every other Desktop program.

Object-Action Orientation

When you're working on something in the real world, usually you first decide what you're
going to work with, then you decide what you're going to do. For example, if you're
proofreading your latest best-seller, you'll probably notice a misspelled word before you reach
for your red pencil to correct it.

The Apple Desktop works the same way. In the Apple Desktop, you always select the thing you
want to work on (the object) before telling the computer what to do with it (the action). For
example, if you want to remove a 3.5” disk from the Finder Desktop, you’ll first click on the
disk, then select “Put Away” from the File menu. If you want to copy a word from a word
processing document to the clipboard, you'd first select the word (by double-clicking it), then
select “Copy” from the Edit pull-down menu. This object-action orientation is consistent in
Desktop programs, and it's designed to make using the 11GS more like the way you really work.

Contrast this with the way programs like AppleWorks work. First you have to decide you want
to delete something, then you tell it what to delete. If you change your mind about the action
you want to perform, you have to cancel the operation and choose a new one. Then you have
to re-select the object you want to work with—even if it’s the same one as before.

in the most frequently used operations, the action and the object merge. For example, double-
clicking an icon in the Finder opens it. The first click selects the object and the second click is
the action, but they're so closely linked that they’re one intuitive operation in the user’s mind.
This is the Apple Desktop at its best!
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Split Personality 11Gs

The Apple IIGS is, uniquely, designed to run both 11GS Desktop programs and older Apple II-
compatible (8-bit) programs. It's possible to run both a friendly Desktop program like the Finder
and an older program with no user interface to speak of on the same machine! The authors of
this older Apple software had to design and program their own user interfaces because Apple |l
models before the 11GS didn’t have built-in support for the Apple Desktop. The result: no two
programs ever worked the same way. (The consistency factor, remember?)

some newer programs for 8-bit computers (Apple lle and lic) do use the Apple Desktop user
interface. The designers of these programs took it upon themselves to make their programs work
like the Apple Desktop, even though it meant programming a complete user interface. Although
Publish It! 4 and ProTERM 3.0 (to name two examples) run on the 11GS as well as older Apples,
and although they work somewhat like Desktop programs, they’re not 11GS Desktop programs.

When you're using any 8-bit program on your IIGS, your GS is essentially pretending to be a
lle, and most of the special features of the 11GS are not available. You won’t have access to
System 6 features like New Desk Accessorics (NDAs), File System Translators (FSTs), and 11Gs
printer drivers because, in its lle emulation mode, the 1IGS cannot support these features. That's
not to say these look-alike programs aren’t useful—many are. Just keep in mind that most of
System 6's features work only from real Desktop programs.

A By The Way... ,
If there’s a rainbow-colored Apple at the left end of the menu bar, you're probably using a real
Desktop program. If there’s no Apple or if the Apple isn’t rainbow-colored, you're probably
using a program that only looks like a Desktop program.

A Closer Look

Let’s take a look at a screen from a I1GS Desktop program (Figure 3A). This screen happens to be
from the Finder, but other Desktop programs have a similar look and feel. (The Finder is a bit
unusual because it is specifically designed not for a particular application like word processing,
but rather as an organizational tool for your disks, documents, and programs. Still, it's a program
you'll be using frequently, so it’s a good place to start.)

You'll first notice the menu bar at the top of the screen. The menu bar is the Desktop’s “main
menu.” In non-Desktop programs, you're usually presented with a main menu containing
general things you can do, which branches out into submenus. For example, in AppleWorks,
when you select “Add Files To Desktop” from the main menu, you're presented with a submenu
that allows you to create a new file or load an existing file to the Desktop.
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Figure 3A—Sample Desktop Screen (from Findar)

A By The Way...
The AppleWorks desktop, in case you haven't guessed, is not at all related to the desktop
metaphor we're talking about in this book. The AppleWorks desktop is just a place to store
your files while you're working on them. The Apple Desktop is a much more general concept—
it's a way of interacting with your computer.

The Desktop’s menu bar is its main menu—it lists all the kinds of things you can do in the
program you’re using. In the Finder, the things you can do are divided into the categories of
File, Edit, Windows, View, Disk, Special, and Color. The rainbow-colored & symbol to the left
of the File is also a menu. We'll explain how to use the menus and the options in them a little
later; for now, it's enough to realize that the menus are there.

The menu bar is almost always visible in a Desktop program. That's one of the basic ideas of the
Desktop—to make it clear at all times what you can do next. The menu bar takes up very little
space on the screen when you're not using it, but you can glance at it (or even browse through
it) at any time to remind yourself what options are available.

Another fundamental Desktop element is the window. A sample Finder window occupies most
of the middle of the screen. The Finder uses windows to represent the contents of a disk. Like
most Desktop windows , the Finder’'s windows can be moved, resized, opened, closed, and
scrolled. You can also open more than one window. (We'll get into window manipulation
shortly.) What you see in a window is called, naturally, a view.
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Icons are yet another Desktop element. Icons are small pictures representing documents,
programs, and other things. On the sample desktop, you can see icons for two hard drive
partitions (named Q1 and Q2), a RAM Disk (named RAMS5), a 3.5” disk {System.Disk), and an
AppleShare network volume (DATA.SERVER). There’s also a Trash can, which is used for
removing things from the Finder desktop. Additionally, the Q1 window contains even more
icons, representing documents and programs on the hard drive.

Finally, find the small arrow in the lower left hand corner of the screen. This is the pointer {(or
cursor). When you move the mouse, this small arrow moves correspondingly on the screen. You
use the pointer to select icons, manipulate windows, and choose items from pull-down menus.
In fact, our very next chapter is all about using the mouse—so stay tuned!

A By The Way...
The elements of the Desktop (windows, icons, menus, and pointer) happen to form an
acronym—WIMP. The term was originally coined by expert computer users who actually
resented the simplicity of graphic user interfaces like the Apple Desktop. These folks were used
to typing commands—and they liked it! These days, the term WIMP is used in a merely
descriptive fashion to refer to programs or computers that use a graphic user interface.
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Chapter Four

WORKING WITH THE MOUSE

Mouse Basics

This chapter is for 11GS users who have limited experience with the 11GS mouse. Although such a
chapter may seem unnecessary—most everyone has used a mouse at one time or another—this
chapter also ensures we're all talking about the same thing when we talk about mouse actions.

The mouse is a simple, elegant device for moving the pointer around on the lIGS screen. On the
bottom of the mouse is a small rubber ball, which rolls as you move the mouse around your
desktop. Sensors inside the mouse track the rotation of the ball, and, like magic, the on-screen
pointer follows your hand movement.

The mouse only detects movement when it is on a smooth, flat surface. If you run out of desk
space before you reach the spot you're aiming for on the screen, you can just pick up the mouse
and move it back. Since the ball isn’t touching the desk, the mouse doesn’t register the
movement, and you now have more room to move in the direction you want to go.
(Experienced mousers pick up the front end of the mouse just enough to move it without the
balf touching the desk.)

The mouse also has a long tail-like cord connecting it to the computer, and a button on the top.
(If the cord is the mouse’s tail, the button is positioned atop, well, its hind end.) This button is
used to select documents, icons, and menus. You may have seen mice on other computers with
two or three buttons—but you do can everything with a single button on the Apple Desktop.

If you're just getting started with the mouse, you may want to start up the System Disk to get to
the Finder and follow along.

Pointing

The simplest mouse action is pointing. To point to something on the screen, just move the
pointer to it. Position the pointer on top of the object you wish to point to—not above it, but
literally on top of it (Figure 4A), as if you were looking down on the desktop from above and the
pointer was on top of the object. (In Figure 4A, we're pointing to the System Disk. Look closely
at the System Disk icon to find the pointer.)
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When pointing to extremely small objects, like the small box in the upper left hand corner of a
window, it's useful to know that the arrow’s “hot spot” is at its tip. If the tip of the arrow is
inside the box, you're pointing to it. If the tip is out of the box, you're not pointing to it—even if
some other part of the pointer is in the box. So when we say to point to an object, we mean to
put the tip of the arrow on it.

By itself, pointing isn’t too useful—it merely tells the computer what object you want to work
with. To actually start working with an object, you nced another mouse action—clicking.

Clicking

Clicking is simple—a quick press and release of the mouse button. Clicking does different things
depending on what program you're in and where you click. In the Finder, clicking an icon turns
it black (we call that “highlighting” or “selecting” the icon). Clicking various parts of windows
also has interesting results. Clicking on text in a document moves the insertion point to the
clicked location (don’t worry, we won't talk about the insertion point untif Chapter 5, so you
haven’t missed anything). Clicking on a button in a dialog box activates that button. And so on.

By the way, in Desktop-speak, you don’t click on an object, you just click it. (You don’t “click
the mouse on the Q1 icon,” you just “click the Q1 icon.”) This usage encourages you to think of
the mouse and the on-screen pointer as being not just linked but literally the same thing.

w File Edit Windows View Disk Speciol Color Extras
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Figure 4A—Pointing to an Icon in the Finder
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Pressing, Dragging, & Dropping

Pressing

Pressing the the mouse button and holding it down is called, logically enough, pressing. As with
clicking, you don’t speak of pressing the mouse button; you speak instead of pressing the object
you're pointing to.

Pressing a menu title in the menu bar pulls down (displays) the menu. If you're following along
in the Finder, try it with the File menu. Pressing, alone, is useful to see what’s on a menu
without actually selecting an item. Release the button to remove the menu from the screen.

Dragging

To drag an object, continue to hold down the mouse button while moving the mouse. You'll
use the drag technique with icons (try dragging the System Disk icon around) and pull-down
menus. For now it may not seem too useful to drag icons around on the Desktop, but that's how
you copy files from one disk to another (more on that later).

Sometimes you’ll be required to “drag a rectangle.” You use this technique in the Finder to
select a group of icons that are close together on the screen, and to draw boxes in paint
programs. To drag a rectangle, you press the mouse at one corner of the rectangle you want to
define (it doesn’t matter which corner you start with, though most people start with the upper
left corner out of habit) and drag it to the comer diagonally opposite the corner you started from
(the lower right corner in our example). Try dragging a rectangle around some of the icons on
the Finder screen if you're following along.

Dropping

Dropping is the action that occurs when you release the mouse button after a drag. (Sometimes
this is simply called releasing, too—you generally “release” menus.) When you're dragging an
icon, you'll probably want to drop it eventually. It’s natural to speak of dropping it back onto
the desktop, or into a folder, or into the trash.

Other Mouse Maneuvers

Double-Clicking

Double-clicking is two quick clicks of the mouse with very little delay between the two clicks.
The computer registers these two clicks as one event. In the Finder, double-clicking an icon
opens it (a useful shortcut for selecting Open from the File menu); in most word processors,
double-clicking a word selects that word (remember, single-clicking in a document just moves
the insertion point). Occasionally you'll even be called upon to perform triple-clicking.
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A By The Way...
You can adjust just how the computer responds to double-clicks in the General Control Panel.
If you tend to double-click very quickly, but the computer is expecting you to double-click
slowly, you may find it occasionally registering double-clicks when you don’t mean them. If
you double-click slowly, and the computer is set for fast double-clicks, the computer may
interpret your double-clicks as two separate clicks.

Shift-Clicking

Shift-clicking means you hold down the Shift key on the keyboard while clicking. This is often
used to select a group of icons, or a number of items from a list, or a series of words in a word
processor, There’s also Apple-clicking, Command-clicking (the same as an Apple-click—that
weird propeller symbol is Apple-speak for “command”), Option-clicking, and Control-clicking;
different programs define these in different ways.

Cursors

The 1IGS uses several different cursors to give you clues about what various mouse actions will
do in a particular program. A cursor is just a more generic word for the on-screen pointer you're
already familiar with—the arrow is just one cursor, though it's probably the most common one.
The cursor changes when you move it from one type of area into another on the screen—for
example, from an arrow 1o an l-beam when you move it into a text area and back to an arrow
when you move it out of the text area. Visual feedback like this always lets you know what will
happen when you click (or drag, or double-click, or...) and lets you know instantly when a
program expects a certain kind of action.

The Arrow

k The Arrow cursor appears when you're selecting items from a menu, when you can click on
buttons in dialogs, and in places like the Finder where you can select and double-click icons.
(In some drawing programs, you can select an object in your drawing with an arrow cursor.)
Single-clicking selects an object; shift-clicking is used to select more than one object; double-
clicking opens the object. In many programs (like the Finder) you can drag a rectangle around a
group of objects to select them all. The arrow’s hot spot—the point that determines where the
computer thinks you're pointing—is at its tip.

The 1-Beam

I The 1-Beam cursor appears in word processing documents and whenever the cursor is over a
part of the screen where text can be entered. Clicking the mouse positions the insertion point;
shift-clicking selects text from the insertion point to the cursor; double-clicking selects a word.
The i-beam’s hot spot is in the center of the vertical bar.
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The Plus

The big plus-sign cursor (not the puny crosshairs you frequently see in graphics programs)
appears in spreadsheets and other programs that manipulate grids with data in them. Clicking
one data element (a cell) selects that cell: shift-clicking selects from the current cell to the
cursor; double-clicking often opens a cell for editing. The hot spot is in the center of the cursor.

The Watch & The Beach Ball

The 1IGs displays the wristwatch cursor when it’s doing something that will make you wait for a
moment. It's the visual equivalent of a “Please Wait” message. The rotating beach ball cursor
means pretty much the same thing—except for the minor difference that your computer is out
having fun at the beach while it’s displayed.

The Pointing Finger

The HyperCard and HyperStudio programs use this cursor to allow the user to click on buttons
on cards. Although HyperCard and HyperStudio allow you to have icon-like pictures in a stack,
you don’t double-click them to activate them (a single click is sufficient)—therefore, an arrow
cursor is inappropriate. A few other programs may also use this cursor to indicate the single-
clicking, not double-clicking, is used for activating icons. The hot spot is at the finger's tip.

Custom Cursors

Some programs have cursors of their own other than the ones we've described here. Paint
programs, in particular, have a wealth of unique cursors which remind you which tool you're
using. If you see an unfamiliar cursor, check the program’s documentation to see what it’s for.
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Chapter Five

WORKING ON THE DESKTOP

Pull-Down Menus

Using The Menu Bar

All Desktop programs feature a menu bar. The pull-down menus, accessed by pressing the
menu titles (8, File, Edit, etc.) are used for selecting the actions you want to perform and for
selecting options that affect the operation of the program. In the old days, menus took up the
whole screen (or a good portion of it) and you chose options from menus by typing numbers
and letters or by using the arrow keys to move a cursor from one item to the next. The Desktop’s
menu bar doesn’t require any typing, and it puts all your options literaily at your fingertips.

All Desktop menus work the same way, so once you've learned how to operate the pull-down
menus in one program, you've mastered them all. We'll be using the Finder for our examples
again, just because it’s easy to get to. Boot your System Disk and follow along if you like.

& m Special Color Extras
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Figure 5A—Pull-down menu (from Finder)
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To look at a pull-down menu in a Desktop program, just press the title of the menu you want to
look at (Figure 5A). The menu will appear and its title (e.g. “Disk”) will be highlighted (white
letters on a black background). To dismiss the pull-down menu, release the mouse button. If
you just want to browse through the available pull-down menus, continue pressing as you move
the mouse left and right across the menu bar. Menus will pull down and pop up as you move
the pointer across the menu titles.

Selecting an item from the pull-down menus is just as simple. Press the menu title and continue
to hold down the mouse button as you drag downward through the items on the menu. As the
pointer moves down, the items you point at will be highlighted. Once you’ve found and
selected the menu item you want to use, just release the mouse button. The menu item will
flash to signify that your choice has been accepted, and the menu will disappear.

If you decide you don’t want to select anything from the menu after all, just move the pointer off
the menu entirely and release the mouse button. Or, to select an item from another menu,
continue pressing the mouse button and point to one of the other menu titles on the menu bar.

Dimmed Menus & ltems

Some menu titles appear dimmed. This indicates that none of the options on the menu are valid
actions in the program under the current circumstances. For example, in Figure 5A, the
Windows menu is dimmed because no windows are open. Individual items within a menu can
also be dimmed—for example, the “Eject” option in the Finder’s Disk menu will be dimmed if
the disk icon you've selected can’t be ejected (if it's a hard drive, for example):

Checked Menu Items

Some menu items have a check mark beside them. For example, the Finder’s View menu (Figure
5B) contains a checked item which indicates how the icons in the window are organized. In our
example, “by lcon” is checked. If we selected “by Name” from the menu, the window would
change to display a list of the icons organized alphabetically by name and the check mark
would move to the “by Name” selection. In this case, we can use the menu for two things—to
actually change the view of a window, and to see which view a window currently has by
Jooking for the check mark.

The check mark is used in many other programs. For example, word processors have a check
mark in their Font menu to tell you which font (type style) you're using, as well as check marks
beside each style (bold, underlined, etc.) and size (10 point, 12 point, etc.) in use.

In some cases, the check mark is used in a slightly different way—for example, in a game, there
might be a menu item called “Sound.” If this item is checked, the game makes noise; if it’s not
checked, the game is silent. Selecting the “Sound” menu item toggles the check mark—turns it
on if it's off, or off if it's on. The context in which the check mark is used will help you
determine whether it's used in this way, or in the first way of choosing one choice from a
number of possible choices.
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Figure 5B—Check marks and menu items (from Finder)
Using Long Menus
Some menus have far too many options to fit on one screen. Platinum Paint (Figure 5C) is a

good example of a program with so many features that the author was hard pressed to cram
them all on one screen.
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Figure 5—Long Pull-Down Menu (from Platinum Paint)
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When you pull down, for example, the Misc menu, a small downward-pointing arrowhead
appears at the bottom to let you know there are more items than can be displayed. Drag the
pointer to this arrowhead and the menu will begin scrolling—moving the displayed menu items
upward and revealing new items at the bottom. An up-arrowhead appears at the top of the
menu; use it to scroll in the other direction and re-display the items that scrolled off the top.

Once you've found the item you want, selecting it works the same as if the menu didn’t scroll.
Just point to the item and release the mouse button.

Ellipsis...

Menu items followed by an ellipsis (three periods) always lead to a dialog. Dialogs are used to
specify information the computer needs to complete your request. For example, if you choose to
initialize a disk in the Finder, you'll need to tell the Finder the name for your new disk, as well
as the format you want to use. A dialog appears to request this information when you select
“Initialize” from the Disk menu. (We'll be talking about dialogs shortly.)

The Standard Menus

The first three menus on the menu bar are the same in nearly all Desktop programs. These are
the ® (Apple) menu, the File menu, and the Edit menu. (The rest of the menus will be tailored to
each program’s purpose.)

The & menu usually contains an “About” item which displays information about the program
you're running (its name, its author, the version number, and so forth). In many cases the &
menu also includes an option for on-screen help or other assistance. Below these menu items (if
any), the ® menu contains your New Desk Accessories (NDAs). NDAs are available from any
Desktop programs and are like real-life desk accessories—calculators, note pads, etc. We'll be
talking more about NDAs later.

The File menu contains options for creating, opening, saving, and closing documents (to work
with a document, you open it first; when you’re done, you close it). You'll also usually find a
few other file-related options in the File menu, like “Print,” as well as the program’s Quit option,

The Edit menu contains items which allow you to change the information you’ve selected in
some way. The “Cut,” “Copy,” and “Paste” options are used to transfer information from one
document to another using a llgs feature called the clipboard. The “Cut” option deletes the
selected information from the document and places it on the clipboard. The “Copy” option
leaves the information in your document but places a copy on the clipboard. The “Paste” option
places the contents of the clipboard into the document you're working on. The clipboard can be
used not only to exchange information between documents but also between programs.

The Edit menu usually also includes an “Undo” option, which reverses the effect of the last
action you performed. (Often selecting “Undo” again after undoing an action will “re-do” that
action). There’s also usually a “Select All” option, for selecting everything in the document
you're working on, and a “Clear” option, for deleting the current selection.
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Key Equivalents

In most programs, the most frequently used menu items are also available through keys on the
keyboard. Look for menu items with the G -symbol next to them, like Eject in Figure 5A. Holding
down the & key while pressing the letter E is the same as selecting “Eject” from the Disk menu.
As you become more familiar with the operation of the programs you use the most, you'll find
yourself reaching for the key equivalents more and more—they really are time-savers, especially
in programs like word processors where it can be a hassle to continually move your hand from
the keyboard to the mouse and back.

s Shortcut :
The following key equivalents are supported by many (but not all) Desktop programs. The first
four Edit menu key equivalents are the first four keys at the left of the bottom row of letters—
Apple chose them because they weren’t as likely to be needed by programs for other functions.

File menu Edit menu

Open &-0 Undo G-Z

Close &-W, &-K Cut A-X

New Document &-N Copy a-C

Save 4-S Paste &-V

Print G-P Select All G-A

Quit &-Q Clear Delete

Additionally, virtually all Desktop programs support &-Period and/or Escape to cancel or stop

an operation in progress.
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Figure 5B—Custom Menus (Color Menu, from Finder)
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Custom Menus

Some programs include menus that are somewhat different from the normal pull-down menus,
A good example is the Color menu in the Finder (Figure 5D). Pulling it down reveals not a list of
colors, but the colors themselves in a five-by-three grid. You select a color from this menu the
same way you'd select an item from a regular menu, except you can move the pointer sideways.
Some other programs—Ilike HyperStudio—display small icons for their tools in similar menus.

Tear-off menus are gaining popularity. In some programs, like HyperCard GS, you can detach a
menu from a menu bar and leave it lying on the screen. This is especially useful with pull-down
color menus and tool menus. Once menus are torn off, they become windoids which look and
behave somewhat like regular windows except that they stay in front of any other windows on
the screen. (Don’t worry, we'll explain windows and windoids in due course.) You can then
select an item from the torn-off menu simply by clicking on it, and you can move it around the
screen wherever you want. You can dismiss the menu by clicking the windoid’s close box.

To tear off such a menu, pull it down as usual. Then drag the pointer outside the menu. An
outline of the menu will follow the pointer. Release the mouse button and the menu appears on
your screen where you dragged it. Remember, this trick doesn’t work in all programs, just the
ones which are specifically designed to support it.

w  Note!
The Finder’s Color menu does not tear off. Attempting to do so will only make you feel silly.

Hierarchical menus are used frequently on the Macintosh but are rarely seen on the IIGS. In fact,
we only know of one program that uses them, and neither the ligs nor System 6 support them
directly, so you probably won't see very many of them. But nevertheless, if you see a rightward-
pointing arrowhead to the right of a menu item, you'll know you’re about to encounter a
hierarchical menu. When you highlight that menu item, a second menu will “pop up” to the
right of the arrowhead. Slide the pointer into this submenu and select an item from there (or
move the pointer back into the pull-down menu to get rid of the pop-up menu).

Alerts & Dialogs

Using Alerts

Alert windows (or just “alerts”) appear when something unexpected has happened to find out
what you intend to do about it. Take, for example, Figure 5E, where we have foolishly told the
computer to move the program “Teach” into a folder which already contains a program by that
name. (Well, actually, we might have meant to do that. Alerts don‘t necessarily mean you've
made a mistake.) In any case, the computer doesn’t know whether or not we meant to replace
the existing “Teach” program, so it asks us to confirm our action before erasing the old file.
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Figure 5E—Sample Alert (from Finder)

The alert window contains three important elements. First, there's an icon, which indicates what
level of alert you're looking at (Figure 5F). The three alerts you’ll encounter most often are:

 Note alert. The little talking guy with the flat face serves to tell us that the computer is
just telling us something that it thinks we should be aware of. We don’t necessarily
need to take any action, just acknowledge that the computer’s message is heard and
understood. For example, when you shut down the computer using the Finder’s “Shut
Down” option {on the Special menu), you get a Note alert that tells you it's OK to turn
the computer off.

e Caution alert. This is the type of alert we've encountered in Figure SE. It indicates that
there is a possibility of accidentally erasing something you didn’t mean to erase (or
otherwise messing something up), so the computer has decided to ask you to make
sure you really want to do what you said you wanted to do.

* Stop alert. With its distinctive red icon and white hand, the Stop alert is the computer’s
way of saying “You cant do that.” For example, if you try to remove a file that's in use
by the System software, a Stop alert says “This operation could not be completed
because a file on the disk is open.” Stop alerts should be considered error messages.

Note Alert Caution Alert Stop Alert

Figure 5SF—Alert icons

Working On The Desktop 37




Then there’s the alert message itself. In our case in Figure 5E, that's “The item ‘Teach’ already
exists. Replace this item?” Notice that the message tells us what has happened and also asks us
what we want to do.

Using Buttons

We respond via the oval buttons at the bottom of the alert. Click one of these buttons with the
mouse to tell the computer what to do. In this case, we can Cancel the operation, or we can
Replace the existing program with the one we're moving. A few words have specific meanings
when you see them in alerts like this. For example:

e “OK” {or “Okay”) means that you acknowledge the information the computer is
presenting and that it’s all right to continue.

* “Continue” means basically the same thing as “OK” but is usually used in a sense of
giving the computer permission to perform an operation after it has asked if it's all right
to do so (as opposed to “OK,” which is usually just an acknowledgement to a Note or
Stop alert).

¢ “Cancel” means that you want the computer to put things back exactly the way they
were before you started the operation, as if you never selected it. For example, if you
choose to initialize a disk and then click the Cancel button before the initialization
begins, the disk is not initialized and no information is lost. (In the case of the situation
depicted in Figure 5E, the move would never happen.)

* “Stop” means to stop the operation in progress. Unlike “Cancel,” the operation may be
partially complete. For example, if you're doing a search and replace operation in a
word processor, you may be able to stop the replace operation, but not cancel it, if
you‘ve already accepted some changes. If you see a “Stop” button, but not a “Cancel”
button, the computer has already completed at least part of the operation.

e Shortcut
One of the buttons usually has a double outline, like the “Replace” button in our example.
Pressing the Return key is the same as clicking the double-outlined, or default, button.
Pressing &-. (holding Apple and pressing the period key) or pressing Escape is the same as
clicking the Cancel button, if there is one.

©® New & Improved
In System 6, you can now click most alert buttons from the keyboard by pressing the first
letter of the button’s name (excluding double-outlined buttons and the Cancel button, which
have their own keyboard equivalents).
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Using Dialogs

Dialog windows (or dialog boxes, or just dialogs) are like alerts on steroids, or—if you'd rather
think of things the other way around-—alerts are stripped-down dialogs. The purpose of a dialog
is allow the computer to carry on a kind of “conversation” with the user—that’s you. It's a way
for the computer to ask for information it needs to carry out one of your requests.

For an example, take a look at the Initialize dialog in Figure 5G. It shares some features with the
alert we discussed in the last section. There’s a Caution icon (the black exclamation point in the
yellow triangle) and the warning that the operation will cause all the information on the disk to
be destroyed, and there are the buttons at the bottom of the window. (There’s also a line at the
top of the window that tells you the name of the device that holds the disk you're initializing.)

& File fdit Windows View JUY Special Color Exiras

Initialize device APPLEDISK3.5A
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This operation will destroy all of the
f information on this disk.

(tocel ] ) (intialize)

Figure 56—Sample Dialog (Initialize, from Finder)

There are also three other boxes in the dialog. The topmost one is a place to enter your name
for the disk you're initializing. (This box is filled in with the disk’s current name or, if the disk is
blank, with the default name of Untitled.) The box where you enter the disk’s name is called a
line-edit field because it's a place for entering and editing a single line of text; we'll describe it
in detail in a moment.

The two other boxes allow you to select what format the disk will be initialized with (either
ProDOS or HFS, the Macintosh disk format) and the disk’s size and interleave. (We'll leave a
discussion of these terms for later.) These two boxes are called lists because they contain a list
of your choices. To select one of the items in a list, simply click it. If there are more items in a
list than will fit on the screen, you can use the scroll arrows next to the list to scroll the list up
and down to reveal more of the items.
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Buttons, line-edit fields, lists, and other clickable things in dialogs are known as controls. You
set the controls the way you want them, then you activate the dialog by clicking the “OK”
button or dismiss it by clicking “Cancel.” We'll be providing specific examples of how to fill in
and use the various dialogs you’ll encounter; for now, it's enough just to understand in general
terms how the parts of a dialog work.

ws  Shortcut
System 6 allows you to select items from the lists (and select line-edit fields to type data into)
using the keyboard. Press the Tab key to move from one list {or field) to the next; a bold black
box surrounds the field you're editing. Use the up and down arrows to select the options in the
list. Hold down the & key while you press Tab to move to the previous list (or field).

Using Check Boxes & Radio Buttons

The Finder’s Preferences dialog (Figure 5H) shows another type of dialog element—the check
box. You generally use check boxes to turn a program’s features on and off—the Preferences
dialog is pretty typical. Clicking a check box turns it off if it's on—marked with an X—or on if
it’s off. (It's the old toggle effect again, which we last saw in the discussion of check marks in
the pull-down menus section.)

W% File [dit Windows View Disk Joqstall Color Extras

Finder Preferences A

i List Views <] Save Finder information onto disk

: <] Show date 2] Hide invisible files

Show size I When starting up, check 5.25" drives
; k<] Show kind Color selected icon’s background

Show disk info instead of its outline

in header

( Cancel l‘ fRccept ’

Figure 5H—Sample Check Boxes (Preferences, from Finder)

The Shut Down dialog (Figure 5)) shows the radio buttons—so named because they act like the
buttons used to choose your favorite stations on car radios. As with the real radio buttons, you
can choose only one option at a time—the options are mutually exclusive: that is, choosing one
automatically means that you are rejecting the others. (This makes logical sense—with your car
radio, you can't lister to more than one station at a time, either.)
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Figure 5J—Sample Radio Buttons (Shut Down, from Finder)

us  Shortcut .
In most cases, it's not necessary to click exactly on the check box or radio button: clicking on
the text to the right of it is usually just as good (and a lot easier to hit!).

Using Pop-Up Menus

Pop-up menus are often used in place of lists or huge numbers of radio buttons when there’s not
enough room on the screen to display all the lists or radio buttons. The Finder Help window
(Figure 5K) is typical. Though the little box at the top of the window looks like it might be a
button, it's actually a menu. It works much like pull-down menus—press it to display the menu,
then select an option from the menu by dragging the mouse up or down. The menu’s current
setting always appears at the cursor position when you first pop the menu up, so if you don't
wish to change the menu’s setting, simply release the mouse button without moving the mouse.

= Note!
Pop-up menus often contain more choices than will fit on the screen-—especially since the
item that pops up under the pointer is whatever option is selected: that can skew the menu
toward one end of the screen or the other. The trick for scrolling long menus up and down
works just as well with pop-up menus as it doss with pull-downs.

A By The Way...

A downward-pointing arrow (like at the right of the Topic pop-up menu) is often a signal that
you're looking at a pop-up menu.

Working On The Desktop 41




@ File Edit Windows View Disk Special Color Extras

Finder Help

Topic | Using Help

To get information on different Finder features,
choose g feature from the pop-up menu above.

When there is more text thon will fit in the
window, you can use the scroll-bar on the right to
see the rest.

Figure 5K—Sample Pop-Up Menu (Help, from Finder)

Text Fields
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Line-Edit Fields

You've already been introduced to line-cdit fields if you read the section on dialogs above.
Line-edit fields are used to fill in text data (such as the name of the disk in the Initialize dialog)
that your computer needs to complete a task. Since they're text-edit fields, you enter data into
them by typing. We've already discussed how to move from one line-edit field to another using
the Tab key (see the “Shortcut” in “Using Dialogs” above).

Text-Edit Fields

Text-edit fields are the multi-line equivalent of line-edit fields. Instead of being limited to a
single line of text, you can enter many lines—practically as many as you want, though there’s
usually some limit. As with list fields, you'll often see scroll arrows to allow you to move
through a long text-edit entry.

The Finder’s “Comment” card (in the lcon Info window) is a typical text-edit field (although it
doesn’t have scroll arrows). Most word processors are based on the conventions of text-edit
fields—the window containing your document is considered one big text-edit field.

Both line-edit and text-edit fields react to the same kinds of mouse and keyboard actions., so
we're covering them together. Of course, you're limited to a single line of text in line-edit fields.
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The Insertion Point

An important concept when dealing with any kind of text is the insertion point, which we
mentioned in passing in the last chapter. As we noted in that chapter, the mouse cursor changes
to an I-beam when it's positioned over a text entry area. Clicking the mouse when it’s in a text
area moves the insertion point to the cursor position.

So what's the insertion point, anyway? It's a second cursor that’s independent of the location of
the mouse cursor. The insertion point moves when you type and when you click the mouse on
a section of text, as opposed to moving whenever you move the mouse. The insertion point
keeps track of where the next key you press will be inserted into your text.

The arrow keys can also be used to move the insertion point around. Additionally, holding
down & and pressing the left or right arrow key moves the insertion point to the beginning or
end of the current line; using Option with the left and right arrow keys moves the insertion point
to the beginning of the next or previous word.

Selecting Text

To select one or more characters for editing, drag the I-beam cursor across the characters you
want to select. (Remember, in the Apple Desktop you first select the object you want to work
with—in this case, some text—then you tell the computer what you want to do. Object-action,
remember?)

For example, if you want to select the word “her” inside the word “there,” you'd first position
the I-beam to the left of the letter “h,” then press the mouse button and drag across the letters
“her” until all three of them are displayed as white letters on a black background. When this
happens, release the mouse button. The letters “her” are now selected for editing. (You can also
drag backward; the result is the same.)

You can also shift-click to select a section of text from the insertion point to the mouse cursor
position. For example, if the insertion point were already to the left of the letter “h,” you could
simply shift-click after “r” to select “her.”

w  Note!
When selecting multiple lines of text, the selection moves rightward first, then downward. For
example, if you click in the middie of the first line of text and drag down to the middle of the
third line of text, you have selected the right half of the first line, the entire second line, and the
left half of the third line. By the way, most word processing programs will automatically scroll
if your selection runs into the edge of the window.

Shift-clicking is also used to extend or contract a selection. If you've already selected text and
realize you want to select more (or less) text, hold down the shift key and click the I-beam
where you want the selection to end. The selection will grow or shrink as appropriate to where
you clicked.
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= Note!
What's actually happening when you extend (or contract) a selection is that the computer is
keeping track of the original insertion point and adjusting only the end of the selection. It's as if
one end of the selection is anchored to the insertion point and you can move the other end
around the document as if the selection were a rubber band. Remember, the ligs recognizes
backward drags, so it's possible to move the end of the selection before the insertion point and
switch a forward selection to a backward selection!

= Note!
It's also possible to select more text than will fit on the screen (in programs like word
processors) by shift-clicking. Click the insertion point, then scroll the window to find the end of
the desired selection and shift-click there. (See next section for more information on scrofling.)

Double-click to select an entire word. Triple-click to select an entire line (or the entire field if
it'’s a line-edit field). If you double-click and hold the second click, dragging selects entire
words; if you triple-click and hold the third click, dragging selects entire lines.

Selection can also be performed from the keyboard. Use the left and right arrow keys to move
the insertion point to the beginning of your selection. Now, hold down the Shift key and press
the right arrow key until the desired selection is highlighted. (You can also start at the end of the
selection and use Shift with the left-arrow key to “drag backward” with the keyboard.) And, of
course, you can also use the & and Option keys with Shift to extend the selection to the
beginning or end of a line or to the previous or next word.

Finally, when you use Tab (or &-Tab) to move from one field to another in a dialog, the field
you tab into is automatically selected. (When a dialog first appears, the first field is selected.)

ws  Shortcut
A quick way to select the entire contents of a line-edit field is to press & and Left Arrow (to
move the insertion point to the beginning of the line), then press &, Shift, and Right Arrow (to
extend the selection to the end of the line).

Editing Text

Once you've selected the text you wish to edit, editing can begin. The simplest operation is
deletion—to obliterate the text, just press the Delete key (or select “Clear” from the Edit menu,
or press the Clear key on the llgs’s numeric keypad).

If you want to replace the selected text with new text, simply begin typing. The selected text will
be deleted and the new text you type will be inserted. (Since the entire contents of a line-edit
field are selected when you Tab into it, you can just begin typing if you want to replace the
default text with new information. You'll get used to filling in and accepting dialogs this way—
type something, Tab, type something, Tab, Tab, type something, Return.)
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You can also use the Edit menu’s “Cut,” “Copy,” and “Paste” functions on the selection. “Cut”
moves the text to the Clipboard and removes it from the text entry area. “Copy” copies the
selection to the Clipboard but leaves the original selection intact. “Paste” deletes the selection
and replaces it with the contents of the Clipboard. (If no text is selected, the contents of the
Clipboard are inserted at the insertion point.)

Simply press the left or right arrow key to deselect the current text without performing any
operation on it. If you press the left arrow key, the insertion point will be positioned at the
beginning of the selection; if you press the right arrow key, the insertion point moves to the end
of the selection. You can, of course, click the mouse to chose a new insertion point as well.

w  Shortcut
If you're filling in a line-edit field and want only to add something to the end—for example, if
you’re formatting a number of blank disks and want to number them starting at Untitled1 and
going up—and the entire field is selected, just press the right arrow key and type your suffix
(the disk number in this exampie) to add it to the end of the default.

Keyboard Translation

HGs typefaces can contain a number of special and foreign characters that you can't type on a
normal keyboard. The foreign characters can be typed as follows:

Keystroke Character Produced

Option-A A

Option-C

Option-E Places accent on next vowel, e.g. 4, é,1,0, 4
Option-1 Places circumflex over next vowel, e.g. &, 8,1, 0, 0
Option-N Places tilde over next vowel (or N), e.g. fi

Option-0 ]

Option-U Places umiaut over next vowel, e.g. 4, &, 1, 6, {
Option-" Places grave accent over next vowel, e.g. a, 8,1, 0, U

The System 6 Bonus Pack includes a Desk Accessory (KeyFind) which will help you figure out
the other special characters included in most System 6 fonts.

=  Note!

Keyboard translation must be set to “Standard” in the General control panel to access foreign
and special characters this way.
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Windows

More About Windows

Windows are important parts of all Graphical User Interface. (Microsoft even named their entire
user interface system Windows!) A window represents a view into a document. A document is
any collection of data you're working with—for example, the first chapter of the Great American
Novel, or your quarterly report, or the spiffy new drawing you're working on for the cover of the

next Weird Al Yankovic album.

A view is just a way of looking at your document. For example, if you're working with a picture
in a paint program, the program probably allows you to work with the document at various
magnifications—those are your views. Some programs only have one view, but many let you
look at your data in more than one format. Since you might not be able to see the whole
document on the screen at once (that is, it might be larger than the screen), you can usually
scroll the document to view to different parts of it. Windows provide a way of manipulating
your views and keeping track of all the documents you have open.

As usual, we'll use a Finder window to illustrate our discussion. In Figure 5L you'll see a couple
of windows called “Q1” and “Q2.” (They’re from one of our Q Drives.) it's not only possible to
have more than one window open, it's actually pretty common—the Finder, for example, lets

you open twelve windows at once.
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Figure 5L—Sample Windows (from Finder)
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A By The Way...
We've spoken of windows as containing views into documents. It may not be immediately
obvious how this applies to the Finder, which actually allows you to directly manipulate your
documents in the form of icons. The Finder is a program for manipulating disks and files, so
its windows are views into the contents of your disks.

Window Order

If you look closely at Figure 5L, you'll notice that the “Q1” window looks like it’s in front of the
“Q2” window. And, in fact, the “Q1” window really is in front of the “Q2” window. On the
Apple Desktop, you work with one window at a time; that window becomes the “frontmost” (or
active) window. It’s just like having a stack of papers on your desk—you might put the
document you're working with on top of the other documents on your desk.

Sometimes the windows don't overlap, so the overlap clue can’t always tell you which window
is in front. There’s another clue, though—the Q1 window also features four black “racing
stripes” in its title bar. The title bar is the part of the window that contains the window’s name,
along with some controls which you'll use to manipulate the window. When you see the
stripes, you know exactly which window is ready to go.

To make an inactive window the active window, simply click anywhere in the window.
Clicking anywhere in the “Q2” window would bring it to the front and result in the “Q1
window becoming inactive. Some programs, such as the Finder, have a Windows menu that
allow you to bring any window to the front easily and quickly—just pull down the menu and
choose the window you want to work with.

Opening And Closing Windows

Most programs have an option on the File menu to open documents and to create new
documents. Since a window is a view into a document, opening a document opens a window
to view the document in. If you choose to open an existing document, you'll first see Standard
File Dialog (see Chapter 7) to select the document you want to work on. (In the Finder, you can
also double-click an icon to open it.)

When you're done with a document, you can close it. There's usually a Close option on the File

menu, but you’ll usually find it more convenient to click the close box, the little square at the
upper right hand corner of the window.

Moving & Resizing Windows

Desktop windows can be moved anywhere you need them. In our example, it'd be possible to
see the complete contents of both windows simultaneously if only we moved the “Q1” window
up slightly and moved the “Q2" window down a little bit. That's easy to do via dragging.
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Simply position the pointer on the window’s title and press the mouse button. While continuing
to press the button, drag the mouse. An outline of the window will move with the pointer;
position this outline where you want the window to be and release the mouse button. The
window will move to the location you choose. It's not necessary that the entire window be
visible on the screen—windows can be positioned so that part of the document is off the screen.

= Note!
To cancel the drag, move the pointer to the menu bar and release the mouse button.

To make a window larger or smaller, you’ll use the grow box, the small square in the lower right
corner of the window. Position the pointer on the grow box and press the mouse button. As you
drag the mouse, lines appear on the screen indicating the new size of the window. When you
release the mouse button, the window is redrawn at the size you selected.

A faster way to resize the window when you want to view it at its largest possible size is to click
the zoom box, the small box at the right end of the title bar. Clicking the zoom box once
expands the window to fill the entire screen. Click the zoom box again to return the window to
its original size and location.

Scrolling Through Windows

It often happens that the document you’re working on is larger than your computer’s screen. To
overcome this problem, most windows include horizontal and/or vertical scroll bars to allow
you to view any portion of your document within the window. In the “Q1” window in our
example (Figure 51), you'll notice two sets of arrows, at the right and at the bottom of the
window. The set of arrows on the right of the window allow you to scroll the contents of the
window up and down; the set on the bottom of the window allow you to scroll the contents left
and right.

To scroll by a small amount, click the appropriate arrow once.
To continuously scroll slowly, press the appropriate arrow.
To scroll by a large amount, click the gray area closest to the arrow that points in the
direction you want to scroll. (The gray areas scroll by an entire window-full.)

¢ To scroll to any arbitrary point within the document, drag the white box between the
arrows to a position proportional to the one you want to view.

The scroll bars not only allow you to scroll the window, they also tell you something about our
current position within the window. The elevator changes in size according to how much of the
document is currently in the window (in our example, about two-thirds of the contents of the
window are visible) and its position within the gray area tells us exactly where in the document
we are (at the top, in our example). (The elevator never gets so small that you can’t grab it—
there’s a minimum size which is maintained even when the document is very large.)

= Note!
In a word processing document, scrolling the document with the scroll arrows usually does
not move the insertion point. Thus, it's possible that the insertion point will move off the
screen. Click the [-beam on a new insertion point before you type anything.
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Windows With Missing Parts

The Finder windows are what you might call “full-featured windows”—they have all the
controls that we've discussed here. Windows that can’t be resized won't have a zoom box or a
grow box. Some windows can’t be closed, so they may be missing a close box. Some won't
even have a title in their title bar, or they may be missing a title bar entirely (indicating that they
can’t be moved).

And, of course, in some cases the elevator and gray areas may be missing entirely, like the
left/right scroll bar in our example—this indicates that the entire document fits horizontally
within the window’s current boundaries. If the contents of a window can never be arranged in
such a way as to need scrolling in a certain direction, the window might not even have a scroll
bar for that direction—some windows always contain the entire document, so they never have
scroll bars.

So when you're confronted with a window, you can tell almost immediately what actions are
allowed just by looking for the controls we've discussed.

Modal Windows

Modal windows are windows that demand your attention. They have a double-line border all
the way around their perimeter and they don’t go away until you've dealt with them. You can’t
use the pull-down menus or do anything but work the controls in them. We're talking about
alerts and dialogs, of course—they are, in reality, stripped-down windows.

A By The Way...

The term “modal” comes from the word “mode.” The Desktop tries to stay as far away from
modes as it can—instead of limiting your actions depending on what mode the program is in,
you usually can choose to do any operations in any order. Most importantly, you should
always have access to the menu bar, instead of having to exit the “working with a document”
mode to enter a “menu” mode the way you do in programs like AppleWorks. But sometimes
modes just can’t be avoided. When you Initialize a disk in the Finder, for example, it just
doesn’t make any sense to let you do anything else until you've finished with the dialog.

Windoids

Windoids are, as their name implies, objects that look like windows but aren’t, exactly. The
System 6 Video Keyboard (Figure 5M) is a windoid. Like a real window, there’s a “title bar” to
allow you to drag the windoid around the screen, but no actual title. The title bar looks
undernourished—it’s small and gray. There’s also a close box on the left end of the title bar,

The main difference between windows and windoids is that windoids always stay on top of the
window stack. It is impossible to bring a window in front of a windoid. That doesn’t mean that
you can’t work as you usually do—windoids don’t actually get in your way. The computer will
always work with the topmost real window, ignoring the windoid and behaving as it always did.
The only difference is that the windoid is always on your screen and can't be covered up.
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Figure 5M—Sample Windoid (Video Keyboard Desk Accessory)

Programs that let you tear off menus (see the section on menus earlier in this chapter) will turn
them into windoids. Clicking an item in the windoid is the same as selecting it from the original
pull-down menu. You can, of course, reposition the torn-off menus so that they don't get in your
way, and close them when you're done with them,
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Chapter Six
WORKING WITH THE FINDER

Welcome To The Finder

The Finder is a special 1IGS Desktop program for manipulating your disks, programs, and
documents. It's included with the 11GS System Software, and it's the first program most IIGS users
learn how to operate. When you boot your System Disk (or the hard drive on which you've
installed System 6) and the red bar has finished filling the thermometer, the Finder is normally
the first program that appears on your screen.

The Finder has most of the same functions as other Desktop programs, except that these
functions work directly on the contents of your disks instead of, for example, on word
processing documents. The Finder allows you to:

* Initialize new disks and erase existing ones for reuse
View your disks’ contents and organize files into folders
Move files from one folder to another

Copy files from one disk to another

Rename, lock and unlock, and delete files

Display information about your disks and files

Perform routine verification of disks and files

Launch programs and open documents

e 6 © o ¢ o o

We've already seen many of the Finder's menus and dialogs as examples in the previous
chapter. And since the Finder is a Desktop program, you only need to learn the features specific
to the Finder, not the features all Desktop programs have in common—and you'll find other
desktop programs equally easy to learn. Boot up the Finder and follow along.

The Icons

The Finder displays icons (small pictures) to represent the disks and devices you can work with,
Figure 6A is a “disktionary” of the disk icons you'll see in the Finder. The icons are arrayed
along the right side of the Finder screen, starting at the top. There's also a special icon called the
Trash in the lower right corner, which you'll use when you want to get rid of something, Each
icon is labeled with a “name tag” to identify the disk. (If any of the disks are write-protected—in
other words, if the notch is covered on a 5.25” disk or the window in the corner of a 3.5” disk is
open—a small padiock symbol appears to the left of the disk’s name.)
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Figure 6A—"Disktionary” of Desktop Icons

w  Note!
Hard drives, due to a ProDQS limitation that restricts disk sizes to 32 megabytes, may be
displayed as multipie icons. Each icon represents one partition, or division, of the drive, and
gach is accessed as a separate drive, although physically all the partitions are on one drive.

= Note!
Due to the nature of 5.25” drives, the Finder can’t tell when you insert a 5.25” disk in a drive
(or remove one). Therefore, the Finder displays 5.25” drives separately from the disks that are
in them. If you have a 5.25” drive with a disk in it, you'll see two icons for it—a drive icon
(called APPLEDISK5.25A) and an icon for the disk itself. If you don’t have a disk in the drive,
you'll only see the drive icon.

If you're following along, your Finder screen should look something like Figure 6B right now—
icons on the right side of the screen, Trash in the lower right corner of the screen, and no
windows open. (Your system is probably somewhat different from ours, so you probably won't
have exactly the same icons we do.) If you have some windows open, close them by pulling
down the File menu and choosing “Close All.”

A By The Way...
The Finder places the icon of disk you booted from in the upper right corner of the desktop,
and places the Trash icon in the lower right corner of the screen.

Icons don't always represent disks. The Finder also uses icons to represent files—collections of
information stored on disks. You probably don’t see any file icons right now, but you will soon
enough. “File” is a generic term; every bit of information stored on your disk is stored in a file of
some kind.

Files that contain instructions for the computer are called programs. Programs come in two
flavors: system software tells the computer how to behave in general terms; applications tell the
computer how to perform a specific task—word processing, for example. (The Finder is a
difficult program to categorize in this way; it's an application that comes with the system
software and is thus often considered to be system software.)

Files that contain information you (or some other human) entered are called documents. The

word “document” does not necessarily imply text or printed material; sound and music files, for
example, are also considered documents.
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Folders are files that contain other files; you can use them to keep the contents of your disks
organized. Folders can even contain other folders. Folders are really a special kind of file that
the computer uses to keep a list of the things you've placed “inside” the folder, but they're often
considered separately from other types of files because of their special properties. When a
discussion applies both files and folders, we'll use both terms.

= Note!
In the exercises we're about to do—selecting, coloring, renaming, and dragging icons—we’ll
just be using the disk icons on your desktop (and the Trash) to keep the examples simple. The
principles you'll learn, however, apply to all Finder icons, including files and folders.

Working With Icons

Selecting Icons

The Finder, like all Desktop programs, uses the object-action method: first you tell the Finder
what object(s) you want to work with, then you tell it what action to perform. Objects (disks,
documents, and programs) are represented by icons. Actions are selected from the pull-down
menus or performed directly on the icons by manipulating them with the mouse. So before you
do anything with the Finder, you tell it which icon you want to do something to.

You select individual icons by clicking them once. Try it—click any icon on the desktop and

watch it turn black. Click another. The first icon you clicked returns to its original coloring, and
the new icon is selected.
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To select more than one icon at the same time, click the first icon, then hold down Shift and
click the rest of the icons. The Shift key is a signal to the Finder that it should add the new icon
to the group of selected icons instead of making it the only selected icon. You can also shift-
click a selected icon to unselect it, should you select one you didn’t mean to select. To unselect
all icons, click any other icon that’s not already selected, or click anywhere that’s not an icon.
Here’s a summary of what happens when you click and shift-click in the Finder:

¢ Click an unselected icon: The clicked icon is selected; all other icons are un-selected.
* Shift-click an unselected icon: The clicked icon is selected; other icons stay selected.
¢ Shift-click a selected icon: The clicked icon is un-selected; other icons stay selected.
* Click anywhere that’s not an icon: All selected icons are un-selected.

You can also select icons by dragging a rectangle around them. To try this out, point to a spot
just below and to the right of the Trash. (Don't actually position the pointer on the Trash itself; if
you do, you’ll end up dragging the Trash around the screen.) Press the mouse button and drag
upward and to the left. As you do, a rectangle will appear. One corner is anchored at the point
where you started dragging. The comer of the rectangle diagonally opposite the fixed corner is
attached to the mouse pointer. Drag the mouse until the rectangle surrounds all the icons on
your screen, then release the button. All the icons enclosed-—or even touched—by the rectangle
turn black. If you need to select a group of icons without un-selecting the icons you have
already selected, hold down the Shift key while dragging a rectangle around them.

v Shortcut
To select all the icons, pull down the Edit menu and choose “Select All” (or press &-A). “Select
All” is especially useful when you want to work with most of the icons, but not all of them—
just choose “Select All,” then shift-click the icons that you don’t want.

Opening Icons

Once you've selected an icon (or a group of icons), it's natural 1o want to see what's inside it.
To do this, just pull down the File menu and select “Open” (or press ¢-O). Since we're working
with disk icons (and the Trash, which acts like a disk icon even though it really isn"t), opening
the icon will produce a window displaying the contents of the disk or the Trash. Try it on the
disk in the upper right comner of the screen (see Figure 6C).

we  Shortcut
To open icons more easily, just double-click them. If you selected a group of icons, double-
click any blackened icon to open them all. If you want to open a single icon, you don’t need to
click it first to select it—the double-click will select the icon and open it. We don’t know
anyone who ever actually uses the “Open” option on the Finder’s File menu.

The window that appears is a standard [IGS Desktop window and can be manipulated like any
other Desktop window. If you haven’t had a chance to practice moving and resizing windows,
you might want to turn back to Chapter 5 and try it out. Otherwise, close the window you
opened by clicking its close box or by choosing “Close” from the File menu (or pressing ¢-W),

54 Chapter Six



As we'll see later, different things happen when you open different kinds of icons. Opening a
disk icon the contents of the disk in a window. For now, that’s enough—we’'ll get to opening
applications, documents, and folders soon enough.
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Figure 6C—An Open Window In The Finder

Dragging Icons

You can drag icons around the desktop. Just point to one, hold down the mouse button, move
the icon to a new position, and release the mouse button. An outline of the icon follows the
arrow around—the icon itself stays where it was until you finish dragging, then it jumps to the
new location.

You can also drag groups of icons if you've selected more than one. Unfortunately, the Finder
doesn’t remember where you put disk icons (or the Trash), so even if you move the icons to the
other side of the screen, they’ll be back on the right side the next time you return to the Finder.
(The Finder does remember the positions of files you put on the desktop, but we haven't talked
about that yet.)

More interesting is what happens when you drag one icon onto another. If you don’t have a
3.5” disk icon on the desktop, put your System Disk in a drive. (If you already have a 3.5” disk
icon on the desktop, we'll use that one for this experiment. If you have more than one, it doesn’t
matter which one you use.)
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Drag your 3.5” disk icon to the Trash. More specifically, position the pointer on top of the 3.5”
disk icon and press the mouse button. Hold the mouse button while you drag the mouse to the
Trash icon—an outline of the 3.5” disk icon will follow the pointer. Position the pointer on top
of the Trash icon. Make sure the Trash icon has turned black (if it hasn’t, your pointer isn’t in the
right place) and release the mouse button.

If you did things right, your 3.5” disk drive whirred and spat out the disk, The disk should now
be gone from the desktop. (If you ejected the disk you started up from, a “shadow” of the disk
will remain on the desktop—you can’t permanently eject your startup disk.) For now, just put
the disk back in the drive and the 3.5” disk icon will reappear.

Other disk icons can be dragged to the Trash, too. For example, if you're on an AppleShare
network, you can drag a shared volume icon to the Trash to unmount it. You can also use the
Trash to make the Finder forget about the disk in a 5.25” drive—just drag the 5.25” disk icon to
the trash. You can’t put hard drives, RAM Disks, or most other disks in the Trash—only disks
with removable media and network disks can be “ejected” or “unmounted” this way.

The Trash is used for removing icons from the Finder desktop. In the case of disks, as we've
seen, this means ejecting them or unmounting them. Dragging files and folders to the trash, on
the other hand, actually removes them from the disk they’re on. We'll get to that later, though.

Coloring Icons

The Finder also allows you to color your black-and-white icons (such as the Trash). For this
example, we’ll color the Trash green, like one of those big industrial trash barrels. Just click the
icon, and then pull down the color menu. Choose the medium green (in the middle of the third
column) and release the mouse button. The trash can will instantly turn green. In effect, the
Color menu changes the white in the icon to whatever color you choose.

You can also color an icon’s outline {the black lines in the icon). Let's try that. Click the Trash
again. Now press the Control key and hold it down while you select the desired color from the
menu—Ilet’s try the yellow at the bottom of the second column. Release the mouse button and
your Trash icon appears green with yellow highlights.

> Note!
When you color an icon or its outline, the Finder automatically unselects it. (If it remained
black, you wouldn’t be able to see the change you made.)

The Finder cannot color icons that already contain colors. For example, you can’t color your
hard drive icons, since they contain gray and red; you can’t color RAM Disk icons, since they
contain green and yellow; you can’t even color 3.5” disk icons, since they contain gray. In fact,
the only icon on a normal desktop that you can color is the Trash. You can, however, color
most application, document, and folder icons, which is a tremendous aid in keeping your disks
organized and easy to use.
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w  Note!
The Finder does not remember the colors you've assigned to the Trash. So our little exercise in

coloring the Trash was, well, pretty pointless—but the Finder does remember the colors of
application, document, and folder icons.

Renaming Icons

Renaming an icon is as simple as clicking the icon and typing the new name. If the icon you
want to rename is already selected and has been used in another operation, or if more than one
icon is selected, you will need to unselect the icon (click the desktop or another icon) and click
the icon you want to rename once, then type the new name. (Or just press Return first.) Press
Return when you're finished, or, if you decide not to rename the icon after all, click the icon
once or press Escape to restore its original name.

= Note!
If you’re changing the name of a ProDOS disk (or a file on a ProDOS disk), remember that
ProDOS names must begin with a letter, can be up to fifteen characters fong, and can include
letters, digits, and periods. If you're changing the name of a Macintosh (HFS) disk, the name
may be up to 27 characters long and contain any character but a colon (:). Names of files and
folders on HFS disks (and network volumes) may be up to 31 characters long.

e Shortcut ‘
If you want to make only minor changes to an icon’s name, you can treat the icon’s name as a
miniature line-edit field. Position the mouse cursor over it: when the I-beam Cursor appears,
use the mouse to select a section of the name for editing. Or use the arrow keys to edit the
name. See the last chapter's section on line-edit fields for more tips on editing.

System 6 does not allow you to have two disks with the same name in drives at the same time.
Since the 11GS identifies your disks by name, it would be confusing—to you and to the
computer—if you had two disks with the same name on the desktop. Therefore, you can’t
change a disk’s name to be the same as a disk that’s already on the desktop. (You must first
remove one of the disks from the desktop.) You also can’t change the name of the Trash or of
your 5.25" drives (you can change the name of 5.25” disks, though). Curiously, you can name a
disk “Trash,” though we suggest that you don't.

w  Note!
System 6 disregards upper and lower case differences in disk and file names. For example,
disks named “System.Disk,” “system.disk,” “SYSTEM.DISK,” and even “SyStEm.dIsK” all have
the same name as far as the computer’s concerned.
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Working With Disks

Copying Disks

Making backup copies of your disks is simple. Just drag one disk onto another icon of the same
type (for example, 3.5” disk to 3.5” disk). The Finder will ask you (via an alert) if it's OK to erase
the contents of the disk you're copying to (the target disk) and replace them with the contents of
the original disk (the source disk). If you click the “Replace” button (or press Return), the copy
operation will begin. Since the two disks are the same size, an image (or disk-to-disk) copy is
performed, making an exact copy of the disk very quickly.

If the two disks are of different sizes, the Finder will create a folder on the target disk (giving it
the same name as the source disk) and copy the contents of the source disk into that folder. The
copy proceeds one file at a time and is thus known as a file-by-file copy. No information is
erased from the target disk; the contents of the source disk are added to the existing contents of
the target disk. This makes it easy to copy a new program to a hard drive, where each program
should be in a separate folder—in fact, it's virtually automatic.

==  Note!
Copying a disk file-by-file works best if the disk you're copying is smaller than the disk you're
copying to. If you drag a larger disk onto a smaller disk, you probably won’t have enough room
on the target disk for all the contents of the source disk, but the Finder will attempt the copy
operation anyway. (Your data won't be damaged; the Finder will merely cancel the copy when it
figures out there’s not enough room on the target disk to do your bidding.) And remember—
3.5 disks hold more data (800K) than 5.25” disks (140K) gven though they're smaller.

w File Edit $indows View Disk Specigl Color Extra;

Bisk Copy RIternatives
@ Put the contents of “System.Disk” in o folder on “RANS".

(O Replace the contents of “RANS* with the contents of A
“System.Disk”.

(O Add the contents of “System.Disk” to the contents of “RAKS*.

Figure 6D—Disk Copy Alternatives
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= Note!
Hold down the(Option key)while dragging one disk onto another for a dialog of Disk Copy
_Alternatives (Figure 6D). If you choose the first option, “Put the contents in a folder,” the

disk copy. If you £hoose “Agg the contents,” the Finder does a file-by-file copy, but merges the
contents of the jwo disks in?ead of making a folder for the contents of the new disk.

The “Copy in progres¢” dialbg (see Figure 6F) contains a thermometer, a red bar which indicates
how much of the operation has been completed. The number in the box tells you how many
blocks or files remain to be copied, and a status message lets you know exactly what the Finder
is doing at each stage of the copy operation.

& File Edit Yiadows Vi

Disk-to-disk copy in progress:

Reading...

Figure 6E—Copy In Progress Dialog

There’s also a Stop button. During a disk-to-disk copy, the Stop button stops the copy with no
loss of data only if the Finder hasn’t written any data to the target disk. If the Finder has written
to the target disk, the Finder naturally can’t unwrite it. During a file-by-file copy, any files that
were written to the target will be left in place if you Stop the copy; if you decide you don’t want
the files there, you will have to remove them yourself. (See the last chapter’s section on buttons
for more information on the differences between the terms “Cancel” and “Stop.”)

@ Warning!
If you initiate a disk-to-disk copy onto a disk you didn’'t mean to overwrite, then realize your
mistake and hit Stop, the original information may be partially or totally erased. Be completely
sure you want to overwrite the contents of the target disk before clicking “Replace.”
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If, during a file-by-file copy, the Finder discovers that a file already exists on the target disk with
the same name as a file being copied, it will display an alert (Figure 6F) to find out how to
handle the duplicate file. You can choose to Skip or Replace this item only (the Finder will
display another alert when it encounters another duplicate file), to Skip or Replace all duplicates
the Finder encounters during the operation, or to Cancel the entire copy operation.

@ File Edit Wiedows Yiee Disk Spepiql Color Extrus

A The item *System” already exists. Replace this item and
oll remaining duplicotes?

; This Item Only ;- A1l Duplicates -

h ) Cea )

((Replace ) ﬂ Replace J

Figure 6F—Replace/Skip Duplicate Files Dialog
Initializing & Erasing Disks

Initializing and erasing disks are two very similar operations the Finder can perform on disks.
Both have the effect of completely erasing every bit of information on the disk. Usually you
initialize blank disks that have never been used; you erase disks that have already been
initialized but have data on them that you no longer need. The procedures for the two
operations are nearly identical, so we'll cover them together.

@ Warning!
Remember, both “Initialize” and “Erase” will totally erase everything on the disk. In the case of
“Erase” some data recovery may be possible with programs like ProSel-16 or Salvation-
Deliverance, but usually your data will be gone for good. So be careful!

@ Warning!
The Finder will automatically attempt to format blank 3.5” disks inserted in a 3.5” drive. {f you
insert a disk which is supposed to have information on it and the Finder asks you if you want
to initialize it, the disk is probably damaged. Unless you really do want to initialize the disk, we
suggest clicking the “Eject” button so that any remaining data can be salvaged by a disk repair
utility such as ProSel-16 or Salvation-Dsliverance.
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® New & Improved
System 6 can read, write, and initialize disks in HFS (Macintosh) format as well as in ProD0S
(Apple 1) format if the HFS File System Translator is installed. System 6 can also read Apple
DOS 3.3 and Apple Pascal 5.25" disks with the appropriate File System Translators installed,
but it can’t write or initialize disks in these formats (the FSTs are read-only)

To perform an initialize or erase operation, first click on the disk you want to erase, then pull
down the Disk menu and select “Initialize...” or “Erase...”. The dialog which appears (Figure
6G) allows you to specify the new name of the disk (the default entry for the disk name is the
disk’s current name, or “Untitled” if the disk is blank).

® File [dit Windows View JUILR Special Col

Initialize device .APPLEDISK3.50
(ER 1Sustem. Disk

&l 800K 2:1
ProDs 800K 4:1

A

This operation will destroy all of the
-3 information on this disk.

\

Figure 6G—Disk Initialization Dialog

If you’re making a ProDOS disk, keep in mind that ProDOS disk names must begin with a letter
and that they can be up to fifteen characters long and can include letters, digits, and periods.
Macintosh disk names can be up to twenty-seven characters long and can contain any character
except a colon. Don't choose a name that's already used by a disk on the Finder desktop.

Next, select the desired format of the new disk from the list on the left. If you're making a new
5.25" disk, your only choice is ProDOS, since the Macintosh does not support 5.25” disks. If
you're using a 3.5” drive, and will be using the disk only on the I1GS, or if you will need to use it
with older programs like AppleWorks, choose ProDOS. If you will be using the 3.5” disk to
transfer files back and forth between the 11GS and the Macintosh, choose HFS.
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= Note!
We don’t recommend formatting your hard drive partitions or RAM Disk with HFS because you
e won'’t be able to access these drives from older (ProDOS 8) programs and because access will
/{ > be slower than.ProDQS format . We suggest initializing only 3.5” disks in HFS format, and only

if they will be used to exchange data with Macintosh programs.

= Note!
If you're making a new startup disk for your computer, it must be initialized in ProD0OS format.
You cant start up the computer Irom a HAESM,grims_,}i;:

Finally, select the interleave (initialization operations only—you don’t have this choice when
erasing a disk). If you're making a new HFS disk which will be used primarily on the Macintosh,
select 2:1. If you're making a new HFS disk and will be using it heavily on the IIGS, select 4:1. If
you’re creating a ProDOS disk, select 2:1 except in the rare circumstance that you have (or will

be using the disk on) an Apple UniDisk 3.5 drive (the white Apple 3.5” drive usually used on-

C/‘ j = 1} theApple lic)—in that case, select 4:1. (The interleave option adjusts the disk’s formatting so

that it can be accessed most rapidly on the machine it will be used on most of the time.)

= Note!
If you’re unsure which format or interleave or disk format to choose, just accept the dialog as it
{s. The default settings will work for most users.

A By The Way...
You can’'t change a disk’s interleave without reformatting it. If you need to change a disk’s
interleave for better performance on another system, format a new disk with the desired
interleave and copy the old disk’s contents to the new disk.

Initialization (or erasure} will begin when you click the “Initialize” or “Erase” button at the
bottom of the dialog (or press &-Return). Erasing a disk takes only a few seconds; initializing can
take a minute or s0. When the operation is complete, the new disk will appear on the desktop.

A By The Way...
It is sometimes possible to recover data from disks that have been accidentally erased (not
initialized) using utilities like ProSel-16 or Salvation-Deliverance. Don’t count on it, though—
always make sure you don’t need any of the information on a disk before erasing it.

= Note!
We suggest using the Initialize option when reusing older disks. The Initialize option will
rewrite and verify every part of the disk to make sure it’s still good. Additionally, initialization
makes sure that the interleave on the disk is set for maximum access efficiency.
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Verifying Disks
It's often useful to verify a disk to make sure it’s still readable—for example, when you haven’t

Verify operation reads all the blocks on the disk to ensure that they’re all readable. Just click the

, &used a disk for a long time or when you're having any kind of trouble accessing the disk. The
Y &
e

F:u,ll’f‘)

icon you want to verify and select “Verify” from the Disk menu. If any blocks can’t be read, the
Finder will display the bad block numbers in a window,

This low-level verification does not check the integrity of the files on the disk, nor does it ensure
that the data contained in the disk is valid. (It’s possible for each block on the disk to be
perfectly readable, yet for the disk itself to be unusable due to corrupted folder data or other bad
information stored on it.) To verify that each file on the disk can be read, click the disk icon and
select “Validate” from the File menu. If any files can't be read, the Finder will display the names
of the bad filesin a window.

If either of these tests detects a problem on your disk, copy any readable files to another disk
and stop using the bad disk immediately. Programs such as ProSel-16, Salvation-Deliverance,
and RepairWorks can often retrieve some or all of the information from defective disks.

= Note!
You can’t Verify network volumes, since individual disk blocks are not available across an
AppleShare network. You can, however, Validate network volumes.

Working With 3.5” Disks

We've already talked about one way to eject a 3.5” disk—by dragging its icon to the Trash. You
can also eject a 3.5” disk by clicking its icon and selecting Put Away from the File menu, or by
pressing G-Y. This permanently ejects a 3.5” disk—the Finder will forget about it and stop
displaying an icon. (This doesn’t mean that you can’t put the disk back in, only that the Finder
won't keep track of it.)

To temporarily eject a 3.5” disk, simply press the eject button on the front of the drive, or click
the disk’s icon and select “Eject” from the Disk menu (or press &-E). When you temporarily eject
a disk, the Finder displays the disk as a dimmed icon, reminding you that it’s not in any drive. If
you try to work with that disk (for example, copy another disk or file onto it), the Finder will
remind you to put the disk back into a drive.

This latter is the key to copying disks if you have a single 3.5 drive. You’ll usually put the target
disk in first, then eject it temporarily. Then you'll insert the source disk and drag it onto the
dimmed icon of the target disk. The Finder will tell you when to switch disks and will ask for the
disk it needs by name.

® New & Improved
System 6 automatically detects 3.5” disk insertions when it requests a particular disk. There’s
no need to click “OK” or press Return when the computer asks for a 3.5” disk; just put the disk
in any avallable drive.
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To make the Finder forget about a temporarily ejected disk, drag the dimmed icon to the Trash
(or select “Put Away” from the File menu). It's not necessary to insert the disk before getting rid
of the dimmed icon.

Working With 5.25” Disks

Because the Finder can’t tell when you remove and insert 5.25” disks., it displays both the drive
and the disk as icons on the desktop. Anytime you remove a 5.25” disk and insert a new one,
double-click the drive icon to tell the Finder that you've switched disks. The Finder considers
the disk you took out temporarily ejected (showing a dimmed icon) and adds the new disk to
the desktop. The Finder will ask you to insert the removed disk again if you try to do anything
with it—just insert the disk and click the “OK” button (or press Return).

To permanently eject a 5.25” disk, click the disk’s icon and select “Put Away” from the File
menu (or drag the icon to the Trash). Then insert the new disk and double-click the 5.25” drive
icon. The old disk’s icon will be completely removed and the new disk’s icon will appear. (You
can also do it in the reverse order—drag the dimmed icon to the Trash after the new disk
appears on the desktop.) If you don’t want to put a new disk in the drive, just drag the disk’s
icon to the Trash and remove the disk from the drive.

If you insert a blank disk in a 5.25” drive and double-click the 5.25” drive icon, the Finder will
grind the drive for a while, then ask if you want to initialize the disk. (The same thing may
happen if you double-click the icon when no disk is in the drive.) We've already discussed the
Initialize dialog earlier in this chapter.

A By The Way...
The Finder automatically checks your 5.25” drives for disks when it starts up. If you don’t use
5.25” disks very frequently, the grinding sound your empty drive makes when the Finder tries
to read it will eventually begin to annoy you. When it does, turn off the “When starting up,
check 5.25” drives” check box in the Finder Preferences (accessed under the Special menu).
The Finder will then display your 5.25” drive icons but won't automatically display the disks in
them. If you want to use a 5.25” disk, just insert it and double-click the drive icon.

® New & Improved
The Finder preference for not looking at 5.25” drives uniess you double-click them is a new
(and welcome) feature of System 6.

Working With Hard Drives & CD-ROMSs

As we mentioned earlier, your hard drive may be divided into multiple partitions, each with its
own icon. The ProDOS format only supports drives 32 megabytes and smaller, so drives larger
than 32 megabytes must be partitioned into two or more partitions, each smaller than 32
megabytes. To the IIGS, each partition is a separate disk, and you’ll manipulate them as if they
really were separate, even though they’re all physically on the same drive.
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A By The Way...
You can get around this limit by re-initializing part of your hard drive in HFS (Macintosh)
format. (You can’t reformat the whole drive for HFS; System 6 must start up from

HFS

partition.) However, access to HFS partitions is slower than access to ProDOS partitions, and HARD

HFS partitions are inaccessible to older (ProDOS 8) programs like AppleWorks. Our suggestion
is to stick to ProDOS unless you're swapping the drive between a 11GS and a Macintosh.

Most hard drives can’t be “ejected,” so the “Eject” and “Put Away” menu options have little
effect on them. But some hard drives do have cartridges that can be ejected—45 megabyte
drives based on the SyQuest mechanism are the most popular. Ejecting a cartridge manually
(using the controls on the drive) ejects it temporarily; the Finder displays a dimmed hard drive
icon like other ejected disk icons. (You can use this feature to copy information from one
cartridge to another—it’s cumbersome but it works.) To eject a cartridge permanently, drag the
dimmed icon to the Trash (or do a “Put Away”). If there’s more than one partition on the
cartridge, you'll need to drag all the icons to the Trash.

CD-ROM (Compact Disc) drives behave similarly to cartridge drives. However, many CD-ROMs
have both Macintosh (HFS) and High Sierra partitions in addition to the usual ProDOS
partitions. (High Sierra is a universal format designed to allow CD-ROM discs to be used on
many different models of computers.) All these types of partitions will appear on your desktop.
As with cartridge drives, the Finder considers the disk temporarily ejected when you remove the
CD-ROM. Drag the dimmed partitions to the Trash to permanently eject them.

Working With Network Volumes

If you're on an AppleShare network, you'll probably have shared disks (or network volumes) on
your Finder desktop. The process of telling the 11GS which network volumes you want to use is
called logging on to the AppleShare file server, or mounting the network volumes. It’s
accomplished from the AppleShare control panel.

To unmount a network volume, just drag it to the trash, or Eject it or do a Put Away. (Eject and
Put Away have identical effects on network volumes.)

== Note!
Since all AppleShare servers are Macintosh computers, network volumes follow the same
naming rules as Macintosh disks. Disk names can be up to 27 characters in length and can
contain any character but colons; file and folder names also cannot contain colons and can be
up to 31 characters long.
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Working With Files & Folders

As we mentioned earlier in this chapter, all the information you put on a disk is stored in files.
The System Software itself is stored in a collection of files, and every program you use and every
document you create is also stored in a file. The word “file” is a generic term for any collection
of data. Let’s take a ook at some of the files on your System Disk. Put your 3.5” System Disk in
a drive and double-click it.

A window appears displaying the contents of the disk. The window, which can be moved,
resized, and scrolled like any standard 11GS window, contains four icons—two folders called
System and Icons, and two program files called ProDOS and BASIC.System. Just below the title
bar is the info bar or the header—it tells you what kind of disk this window is from (ProDOS, in
this case; other possibilities are HFS, DOS 3.3, Pascal, High Sierra, and AppleShare), how many
files are in the window, how much space is used by the files on the disk, and how much space
is left on the disk.

A disk’s icon and its window are intimately linked. In fact, in many ways, a disk’s icon and its
window are the same thing. If you drag a file onto a disk’s icon, it appears in the disk’s window.
You can also drag a file directly into a window to copy it to a disk. If you drag a file out of a
disk’s window and onto the same disk’s icon, nothing happens, because you've told the Finder
to move the file to where it already is.

The concept of each window being linked to a particular icon is an important one. (To find out
which icon a given window is linked to, just click the white space inside the window. The
corresponding disk icon will turn black. It's now selected for any operation you care to perform
on it—just as if you'd clicked the icon directly.)

The two folder icons represent, logically enough, folders—the two diamond-shaped icons with
hands, which resemble sheets of paper being written on, are programs. (There’s an “8” written
on the icons, indicating that they’re 8-bit programs.)

A By The Way...
Many programs have custom icons. If you see an icon you don’t recognize, it's usually
possible to make a guess. |cons with folded-down corners are usually documents, icons that
resembie folders usually are; diamond-shaped icons are usually applications. When in doubt,
use the “Icon Info” option on the Special menu to find out exactly what an icon represents.

Icons in a window can be colored, moved around, and renamed, just like icons on a desktop.
(You can’t have two icons in a window with the same name, just as you can’t have two disks on
the desktop with the same name.) The Finder remembers the colors you assign to icons in
windows, as well as the positions of the icons within the window and the position (and size) of
the window on the screen.
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= Note!
Your Desktop is saved when you close a window, when you eject a disk using “Put Away,”
when you shut down or quit the Finder, and when you launch a program or open a document.

Remember, you can only color black and white icons. You might assume, then, that you can’t

color folder icons, since they’re yellow. Actually, you can color folder icons—they’re an
exception. (Folders are actually white to begiivwith—the Finder just colors them yellow the

instant they're created. They really are black and white icons at heart.) You can also color the

You'll find the “Clean Up” option (on the Special menu) useful for keeping your icons
organized. It moves all your icons so they’re evenly spaced along an invisible grid, Try dragging
some of the icons in the window a short distance, then choosing “Clean Up” and watching the
icons dance back to the nearest point on the invisible grid. (Think of the “grid” as a bunch of
evenly spaced “magnets” beneath the window’s surface that “pull” the icons to them.)

Changing Views

The View menu is useful for displaying the contents of a window in different formats. “By Icon”
is the default view; there’s also a “By Small Icon” which allows you to see more files in the
same window space. Instead of showing the icon’s name under the icon, the name is displayed
to the right of a miniature icon. When you first switch to the “By Small Icon” view, the icons
will have a lot of space between them; you can move them as desired and choose “Clean Up”
to align them.,

wa Shortcut
A faster way to arrange your “By fcon” or “By Small lcon” view is to hold down the Option key
while you pull down the Special menu. The “Clean Up” item will now read “Clean Up By Name.”™ L
When you select it, the Finder will pick up all your icons and rearrange them alphabetically in oK
the grid. If you’re viewing by icon, “Clean Up By Name” arranges the icons into rows so that .z
you can scroll the window up and dOWR 16 View ther. If you're viewing by small icon, the ;. «Dowss
Finder arranges the icons in columns so that you can scroll the window left and right to view
them. “Clean Up By Name” doesn’t permanently alphabetize your icons—new icons will be

added to the bottom of the window—nbut it's a good place to start.

The other views—"By Name,” “By Date,” “By Size,” and “By Kind"”—are list views, not icon
views. In list views, you can’t drag the icons around to new positions; positions of the icons are
defined by the view you've selected. You can’t drag a rectangle around a group of files to select
them; you must instead use the shift-click technique to choose multiple files. List views can only
be scrolled vertically, not horizontally; resize the window to read the other columns of
information (size, kind, and modification date). The list views are:

By name: Lists files alphabetically by name

By date: Lists files according to the date they were last changed, most recent first

By size: Lists files according to the amount of space they use on the disk, largest first
By kind: Lists files according to the kind of file they are—similar files (for example,
AppleWorks documents) are grouped together alphabetically
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Folders

We've mentioned that folders are special kinds of files that can hold other files. Let’s look inside
a folder on the System Disk. Double-click the System folder icon.

Imagine that. Another window! This window is titled System and is linked to the System folder
icon in the System.Disk window. The new window is probably blocking your view of most of
the System.Disk window, so move it out of the way by grabbing the title bar with the mouse
pointer and dragging it to an unused portion of the screen.

The System window is linked to the System folder icon in just the same way the System.Disk
window is linked to the System.Disk icon. They are, for all practical purposes, the same thing in
two different guises. When you're looking at the window titled System, it’s just as appropriate to
say that you're looking at the System folder, because the window is the folder.

We say that the System folder’s parent is the System.Disk, because the folder icon is in the
System.Disk window. (The System window is also a child of the System.Disk window.) A given
folder has only one parent (because it can only be inside one other folder or disk) but it can
have many children (because you can put as many folders as you want in a disk or folder.)

In the System window is another set of icons, some of them folders. Browse through them using
the scroll bar on the right side of the window.

The idea of folders is an important concept, not only on the Apple IIGS but on most other
computers you'll encounter. Imagine trying to find anything on a hard drive where everything is
displayed in one window! The System Disk itself contains over 40 files and folders; your hard
drive includes all these files and more if you've installed System 6 on it, plus files for all the
programs you've installed and your documents. It wouldn’t be too bad on a floppy disk (even a
3.5” disk), but even viewing files by name or by type won't help you keep things organized
when several megabytes’ worth of files are all displayed in one window.

That's what folders are for. The System files are organized into folders by their function. For
example, fonts (typefaces) go in one folder; desk accessories go in another; sounds go in a third.
All of these folders (plus a few others) are stored inside the System folder. So when you want to
find the system files, you know just where they are—inside the System folder and the various
folders it contains—but you're not faced with all those files every time you open a disk. The
system files are grouped together and assigned a name, via the concept of a folder,

You can create your own folders, too. Just use the “New Folder” option on the File menu (or
press G-N). A new folder called “Untitled” will appear in the frontmost window. (You may need
to scroll the window to find the new folder if the window is crowded.) The folder is selected
and ready to rename—just type the name you want to give the folder and press Return.

Most Finder users create one folder on their hard drive for each of their programs, then place
each program’s files in the folder assigned to it. Additional folders are created to store
documents used with these programs. With folders, you can keep yourself organized and avoid
spending your valuable time hunting for that one important document,
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Window Management

Now let’s open a few more windows—double-click the Fonts and Desk.Accs folders. We're not
really concerned about the contents of these windows right now; we’ll be using them to
illustrate a few handy window management techniques. The screen tends to get cluttered when
more than a couple of windows are open; these tricks can help minimize the confusion.

You're already familiar with the ways you can manipulate 1IGS Desktop windows like those you
see in the Finder. You can drag them around, resize them by dragging their zoom box, and you
can bring any window to the front by clicking anywhere in it. You can close a window by
clicking its close box, by choosing “Close” from the File menu, or by pressing &-W.

You can also close all open windows by choosing “Close All” from the File menu. Even experts
get confused sometimes, and closing all open windows returns you to a clean Finder slate.

You may also find it useful occasionally to close other open windows as you open new ones.
There’s nothing at all that says you have to keep the System.Disk and System windows open
once you get to the Fonts window. The trick we'll discuss in a minute gives you a way to reopen
a window's parent folders without having to go all the way back to the original disk icon.

s Shortcut
You can also close all open windows by holding down the Option key while you close a

_window, or while' you press &-W. You can drag a window without bringing it to the front of the
stack By holding ¢ as you click in its title bar.

A By The Way...
We’re not quite sure what &-W is supposed to be short for—maybe “window"—but perhaps it
was chosen because it's on the left side of the keyboard. It's very easy to zip through Finder
windows with your left hand on the keyboard and your right hand on the mouse. The & Key is
right there, along with the Shift key for shift-clicking, A for Select All, E for Eject, and W for
Close. It's not really a shortcut, just a useful observation.

Another big help is the Window menu. When the window you want to work with is buried
under two or three other windows, just pull down the Window menu for a list of all open
windows, then select the one you want to work with. No need to close or move the other
windows. Or choose Stack Windows from the Window menu; all the windows will arrange
themselves neatly on the screen, ready for you to choose one. The order of the windows doesn’t
change, only their positions. (Open up some windows and try that one out. It’s nifty.)

me  Shortcut

Holding down Option while selecting a window from the Windows menu closes it without first
bringing it to the front.
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The Pop-Up Folder Menu

Occasionally you'll open two windows with the same name. For example, it’s possible to open
the System folder from two different disks if you want to copy files from one disk to another—
it's even possible to have two folders with the same name on the same disk, as long as they
have different parent folders. You might even have a disk named System and a System folder on
your hard drive.

So once you've opened two windows called Fonts, for example, how do you keep track of
which one is which? Simple—hold down the < key while you press the menu title. A pop-up

menu will appear under the pointer, Tisting the folder itsélfand, under it, all the folders that the
folder is in, all the way back to the disk name (sce Figure 6H). (This trick only works on the front
window—holding down & while clicking a background window is how you drag a window
without bringing it to the front of the stack.)
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Figure 6H—Pop-Up Folder Menu

In this case, the pop-up menu lets us know that this is the Fonts folder, which is inside the
System folder (the Fonts folder’s parent), which is on the disk called System.Disk (the System
folder’s parent). If you just wanted to know which window belonged to which disk, now you
know, so you can release the mouse button. However, it is a pop-up menu—you can select a
folder or disk name from the menu. If you do that, the Finder will open the folder or disk (or
bring its window to the front if it's already open).

® New & Improved
The pop-up folder menu is a new feature of System 6.

70 Chapter Six




Tunneling

It sounds like something a rodent might do (appropriate on a mouse-driven computer system),
but tunneling is really just a handy way to automatically close old windows as you open new
ones. Follow along on a simple demonstration.

Close all the open windows except for the main System.Disk window. Now hold down the
Option key while you double-click the System folder. As usual, the Systern window appéars—

‘but then the System.Disk window disappears. Congratulations, you have just tunneled!

Using tunneling, you can go deep within your disks’ folder structure without ever becoming
overwhelmed by the number of open windows on your screen. Try it again—tunnel into the
Desk.Accs folder. You're now three “levels” into the System Disk with only one open window!

If you want to go backward along the folder path, the pop-up folder menu comes to the rescue.
Hold down the & and Option keys while you select an item from the pop-up menu, and the
current folder will disappear after the new one is opened. This feature is called reverse
tunneling. Now you can move up and down through the various “levels” of your disks while
keeping only one window open from each disk. As you can imagine, tunneling can
considerably ease the confusion caused by a dozen open windows.

® New & Improved
Tunneling and reverse tunneling are new features of System 6.

Windows, Icons, and Directories

When we're working with icons and windows in the Finder, we're really working with
directories. A directory is a special file which the computer uses to keep track of all the other
files on the disk. Each disk has a volume directory, or main directory, that is used to keep track
of the files you see when you open the disk. Folders are stored as subdirectories, which are
secondary lists of files that appear in the main directory. Subdirectories can, of course, contain
other subdirectories.

= Note!
ProDOS disks can contain only 51 files in their main directories. Some of these files can be
subdirectories, of course, and subdirectories can contain a virtually unlimited number of files.
(Under ProDOS, folders are not only useful for organizing your files, they’re a necessity for
getting around the 51-file limit.). Macintosh (HFS) disks have none of these limitations.

Both the main directory and subdirectories can be generically called directories. The Finder

displays the contents of all directories graphically in windows. Main directories are represented
by disk icons; subdirectories are represented by folder icons.
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In some programs, you'll be asked to specify pathnames for a file. A pathname is just a list of
every folder the file you're accessing is in, starting with the name of the disk it's on and ending
with the name of the file it's on. For example, the pathname of the Calculator desk accessory, if
you've installed it on a Q Drive, is :Q1:System:Desk.Accs:Calculator. This tells the computer
that the file is on the disk Q1, and that to get to it you must first open the System folder and then
the Desk.Accs folder before finding the Calculator desk accessory (Figure 6)).

Pathname :Systen.Disk:System:Desk.Accs:Calculator

.

System.Oisk

.

| cons

Fonts Too | s

Figure 6J—How System 6 Follows Pathnames

A By The Way...
In System 6, you can use colons (:) or slashes (/) to separate the folders in a pathname, but
you have to be consistent (you can’t use both separators in the same pathname). When you're
using a ProDOS 8 program, like AppleWorks, you have to use slashes.

The 1IGS Desktop is supposed to protect us from having to concern ourselves about directories
by representing them graphically. We mention the concept for two reasons:

First, a lot of older programs still use the subdirectory terminology, so it's important to relate the
two ways of talking about your disk contents. Graphic user interfaces are relatively new, and
the Apple II's been around for a long time.

Second, a lot of old-time Apple users are familiar with the subdirectory concept but have less
experience with windows and icons. The two concepts are just different ways of thinking about
a hierarchical organization, and that's important to know.
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Copying & Moving Files

To copy or move files, just select the files and drag them from one window to another (or to a
disk or folder icon). If you drag the icons to a different disk, the files will be copied to the target
disk (the original copies will remain intact on the source disk). If you drag the icons to a
different folder on the same disk (or to the disk’s main directory) the files will be moved to the
new location,

If you drag a folder, everything in the folder (including any folders and their contents, even
folders inside folders inside folders) will be copied or moved.

Here’s an example. Let's assume that we've received some fonts we want to install on our hard
drive. The Fonts folder is inside the System folder on our Q Drive; the name of the Q Drive’s
first partition is Q1. The new fonts themselves are in the main directory of a 3.5" disk and are
the only files on the disk.

We'll start with all windows closed. Next, we'll open our Q Drive’s Q1 icon (double-click) and
tunnel into the System folder (hold down Option while double-clicking the System folder). We'll
locate the Fonts folder by scrolling the window until it is visible.

Now we’ll open the 3.5” disk containing the fonts we want to install. We may need to position
our windows so they don’t overlap too much—we need to be able to see the Fonts folder in the
System window so we can drag the new fonts into it. Next we'll bring the window containing
our new fonts to the front by clicking in it once, then select all files by pressing 3-A. Finally,
we'll drag the font files to the Fonts folder on our Q Drive, making sure that the pointer is
directly on the Fonts folder and that the Fonts folder is blackened before releasing the mouse
button. (If the Fonts folder isn't black, the Finder will copy the fonts into the System folder.) We
release the mouse button and copying begins.

If some of the fonts we're copying are already in the Fonts folder on our hard drive, the Finder
will give us the choice of replacing them or skipping over duplicate items. We'll probably click
“Skip” under All, since we'd just be wasting time copying those fonts.

s  Shortcut
To specify in advance how you want the Finder to handle items that already exist in the target
directory, hold down the Option key as you drag the files. The Alternatives dialog has buttons
that allow you to resolve duplicates on a case-by-case basis or to replace all or no duplicates.

Yes, it really is that simple. We could have opened the Fonts ¢ Ider and dragged the new fonts
into the Fonts window—remember, the window and the folder it is linked to are, essentially, the
same thing. If the files we were copying were in a folder on the 3.5 disk, we would have
tunneled into that folder after opening the disk—the rest of the procedure would be the same.

Here’s another example, this time focusing on moving (not copying) fites. Let's assume we've
got some AppleWorks documents in our hard drive’s main directory that belong in a folder. The
folder is called AW.Files and is inside the AppleWorks folder, which is in the hard drive’s main
directory, Q1. As before, we'll start with all windows ¢losed.
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First we'd open our Q1 icon. Next, we'd open our AppleWorks folder, then tunnel into the
AW .Files folder (hold down option while double-clicking). (We won’t be doing anything with
the AppleWorks folder itself; we only opened it to find cur AW.Files folder, so we automatically
closed it by tunneling.) We position the windows so that we can see both the files we want to
move (or at least some of them) and the folder we want to move them into.

Now we select the AppleWorks document icons. We may have to scroll the window with the
scroll bars to find all the files we want to move; we'll select those by shift-clicking them. Once
they're all selected, we drag any one of them to the AW.Files folder, making sure that the
AW.Files folder icon is blackened before we release the mouse button. When we release the
mouse button, the files are moved.

Filename Translation

When you copy a file from one type of disk to another, and the name of the source file doesn't
follow the rules of the target disk (for example, if you're copying a file from a Macintosh disk to
a ProDOS disk and the file’s name is longer than 15 characters), the Finder presents a dialog
(Figure 6K) that allows you to specify a new name for the file. The Finder tries to turn the
original file’s name into a name that will fit the ProDOS disk, then offers that to you as a default
name. You can edit the name before saving the file (or you can skip copying the file entirely).
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Figure 6K—Filename Translation Dialog

If you want the Finder to automatically translate the names of the rest of the files you're
copying, click the “Translate bad names” button. If you want it to automatically skip any files
which have bad names, click the “Skip bad names” button.
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A By The Way...
You'll get a similar message in other applications if you try to save a document to disk with a
name that doesn’t fit the naming rules of the disk you're saving it on.

Copying On The Same Disk

When we drag files to another directory on the same disk, the Finder assumes we want to move
them (instead of making copies) because most of the time, we don’t need or want two copies of
the same file on our disks. When we actually do want to make a copy of a file on the same disk,
we have a couple of alternatives. Unfortunately, none of them are particularly elegant, but
they’ll have to do. Thankfully, it’s probably not something you'll need to do very often.

First is the File menu’s “Duplicate...” command. Select the icon you want to make a copy of,
then choose this option (or press &-D). The Finder will present you with a dialog (Figure 6L)
which allows you to name the new copy of the file. (You can’t use the same name as the
original because the duplicate copy will be placed into the same window as the original file.)
Type a new name or leave the Finder’s default name, and click “OK” (or press Return). Now
you can drag the duplicate file to its final resting place. If it's important that the new file has the
same name as the original, you can rename it after it's been moved.
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Figure 6L—Duplicate (Make A Copy) Dialog

If you want to copy a group of files that are in a folder, it may be more convenient to duplicate
the folder the items are in instead of the individual items. Use the pop-up folder menu to bring
the folder’s parent window to the front, then select the folder and choose “Duplicate...” from
the File menu (or, again, press 3-D). Click “OK” (or press Return) to accept the name for the
new folder. Now you've got two copies of the folder; the contents of both folders have identical
names. {The files can have the same names because they’re in different folders, but the folders
have different names.) Now you can move the duplicated files—or the whole folder.
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A final way to make a copy of a file on the same disk is to simply copy the file to another disk,
then back to the original disk, and finally delete the temporary copy from the second disk. Often
this is the long way around, but if your system contains a RAM Disk, you may actually find it
the fastest and most convenient way.

The Trash

The Trash is used to remove files and folders from your disks. Think of the trash as a holding
place for things you want to get rid of. The items aren’t deleted immediately, but are instead
held in the trash for a while to give you a chance to change your mind. When the trash has
something in it, it bulges (Figure 6M).

AREEr) Figure 6M—The Bulging Trash Can

The trash is emptied automatically when you copy or move a file, when you launch a program
or open a document, or when you shut down using the “Shut Down” option on the Special
menu. You can also empty it manually with the “Empty Trash” option under Special.

If you decide you don’t want to delete a file you put in the Trash, you can open the Trash like
any other icon by double-clicking it. Select the items you changed your mind about and select
“Put Away” from the File menu. The files will return to their original folders and disks.
Alternately, you can drag them to where they belong if you don’t want to return them to their
original locations.

= Note!
if you turn off the computer’s power before the Finder empties the trash (i.e., if you don’t use
the “Shut Down” option), the contents of the trash return to their original windows.

Files On The Desktop

It's possible to drag files out of their windows and deposit them on the Finder’s desktop. The
Finder will remember the positions and coloring of these icons, so they’ll stay there until you
want them to go away. By doing this with frequently-used files and folders, you can streamline
how you work with your disks in the Finder.

Prime candidates for desktop icons include your most frequently used programs, like
AppleWorks or AppleWorks GS, plus any other programs you use more than occasionally.
Placing a folder on the desktop allows easy access to the entire contents of the folder with just a
double-click. By placing files and folders on the desktop, you can turn the Finder into a
customized program launcher that rivals most commercial packages.

Since the Finder places your disk icons on the right side of the screen, most users place their
other desktop icons on the left side of the screen or along the bottom.
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== Note!
When you move an icon to the desktop, it doesn’t really go anywhere. The Finder doesn’t show
it in the window it used to be in, but most other programs will. If you move a file or folder to
the desktop and need to find it from another program, you’ll find it in the same directory it was
in before you moved it to the desktop.

A By The Way...
The “Put Away” option on the File menu works on desktop files, too. Click the icons you don’t
want on your desktop anymore and choose “Put Away,” and the icons will move back to the
directory from whence they came. (You can, of course, still move the files manually.) “Clean
Up” (Special menu) can be used to align the icons on the desktop to a grid; just close all open
windows (“Close All” under Filg) first.

Working With Programs & Documents

Opening Programs

To open, or launch, an application, find the program’s icon (usually a diamond icon with a
hand writing on it—see Figure 6N) and double-click it.

™ -;’f\\
@ & G

Non-Desktop ProDOS 8 Desktop Applesoft BASIC
Application Application Application Application

Figure 6N—Standard System 6 Icons for Applications

System 6 supports several different types of application programs. To remain compatible with
older Apple Il models, System 6 can run 8-bit SYS applications such as AppleWorks. These
programs are identified by the hand-writing-on-paper icon with a numeral “8” in it. Many 8-bit
applications have names that end in the word “System.”

System 6 can also run Applesoft BASIC programs directly from the Finder. These programs
usually have an icon which looks like a regular document with several lines of rainbow-colored
writing on them. Applesoft applications frequently have the name “Startup.” Some BASIC
programs will return to the Finder on their own; if you find yourself looking at an Applesoft
prompt (1) when the program has finished running, type the word BYE and press Return to go
back to the Finder. (You can also use the BYE command if you accidentally run BASIC.System.)
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A By The Way...
Applesoft BASIC programs are treated as documents by the Finder—that’s why they have the
folded-down corner. The documents “belong” to the program named BASIC.System. See the
next section for more on documents and how they can “belong” to application program.

Of course, System 6 can also run modern Desktop-based programs like AppleWorks GS. lcons
for desktop programs have a tiny menu bar. Many such programs have names that end in
“Sys16.” There are also 16-bit programs that don’t use the Desktop; they're indicated by the
generic application icon-—the plain diamond with the hand writing on it.

= Note!
When you run an 8-bit SYS application, an Applesoft BASIC program, or a non-Desktop 16-bit
program, you leave the Apple Desktop environment . Some programs mimic the Apple Desktop
in part or in whole, but in general, each non-Desktop program is different.

Opening Documents

One of the Finder’'s most powerful features is its ability to open document files in the program
that created them. If you double-click a document icon, the Finder will open it if it knows
which program it “belongs” to. That is, the Finder will run the program that the document
belongs to and tell it to open your document. (If the Finder doesn’t know which program owns a
document, it will display an “An Application Can’t Be Found For This Document” alert.)

As shipped from Apple, the Finder knows only that BASIC programs belong to a program called
BASIC.System, and that standard text files belong to a simple word processor (included with
System 6} called Teach.

You tell the Finder about what documents go with which programs via icon files. Icon files
contain special icons for the files that are associated with a program. They also contain the
information the Finder needs to “link” the program and its documents. Many programs come
with icon files; when you install such programs on your hard drive, you should also copy the
program’s icon file into the Icons folder on your hard drive.

® New & Improved
Under System 6, it's possible for a programmer to include the icons within the application
program. In that case, copying the program to your hard drive is all that’s necessary—new
icons for the program and its documents will appear automatically. More and more new
programs will use this technique, making icon files a thing of the past.

Sometimes the Finder will know that a document goes with a particular program, but will be
unable to find the program because the program isn't in the folder that the Finder is looking in,
or because the disk the program is on isnt a drive. When this happens, the Finder will alert you
that it can’t find the program and permit you to Cancel, Try Again (after you've inserted the disk
that contains the program), or Locate. If you choose Locate, a Standard File dialog appears so
you can show the Finder where the program is. (We'll cover Standard File dialogs in the next
chapter.) Once you've located a program for the Finder, the Finder remembers where the
program is so that it knows how to open that kind of document in the future.
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The Finder also allows you to override a particular document-application link temporarily by
holding down the Option key while you double-click the document. The Finder will present a
Standard File dialog to allow you to open the document with a different application. The link
will be temporary—only the selected documents will be opened using the application you
choose. To make a new link permanent, hold down both Option and Control while you double-
click a document; the Finder will forget the old application and remember that the new
application should be used to open all documents of that type.

= Note!

The Option and Control-Option features only work when there’s already a link in place for a
specific kind of file. For example, Option-opening a font has no effect if the Finder doesn’t
already know that fonts should be opened with a particular application. (More specifically, the
Finder doesn’t create new links for unlinked documents, only update existing links.) To create
links of your own, you need an application called an icon editor. Two popular icon editors are
IconEd by Paul Elseth and DicEd by Dave Lyons; both are shareware and are available from
user groups, online services, and public-domain software distributors.

;= Note!

If you previously used System 5, the Finder may occasionally ask for an application called
BASIC.Launcher when you try to launch BASIC programs. (Remember, the Finder considers
BASIC programs to be documents for the BASIC application.) The BASIC.Launcher application
is no longer present (or necessary) in System 6. Use the Locate button to re-link the BASIC

program to BASIC.System. (Alternately, you can Duplicate the BASIC System file and name the
copy BASIC.Launcher; then the Finder will always be able to find BASIC.| aungher. :
= rreed A /17

The Finder can also tell the application to print your document automatically. Just Select the
document(s), then select “Print” from the File menu. The Finder will launch the application and
tell it to open your documents and print them.

== Note!

Some programs don’t support automatically opening document files. Others support opening
document files, but can’t automatically print them. The SynthLab program that comes with
System 6 ig one of the former; the Teach mini-word processor is one of the latter.
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Other Finder Features

The Finder has several features we haven't discussed yet. We'll cover them in order, from left to
right across the menu bar. Many of these features are quite useful, but they didn't fit in very
neatly with our tutorial-style Finder instructions.

About The Finder (& Menu)

The “About the Finder” option opens a window (Figure 6P) which tells you what version of the
System and Finder you're using, how much memory your computer has, and how much
memory is available for running applications. The amount of memory used by the Finder, the
System, desk accessories, and setup files is also displayed. This window is a standard 1IGS
window and can be dragged, moved behind other windows, and closed.
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Figure 6P—About The Finder

Help (& Menu)

Choosing “Help” displays the Finder Help window. At the top of the window is a pop-up menu
which allows you to select the topic you need help on. All the basics of Finder operation are
right there, including tunneling, file copying, selecting and coloring icons, and shortcuts. Like
the “About” window, this window can be moved around. You can scroll it to view the contents
of long help sections, and you can leave it open while you're using the Finder to have easy

access to the help any time.
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Validate (File Menu)

We touched on this feature briefly when we talked about verifying disks. Individual files can be
validated, as well. If you select more than one icon, they will be validated separately, with
separate summary windows. For this reason, if you want to validate all the items in a particular
folder or disk, it's best to select the disk or folder instead of the files themselves. Validating a
disk or a folder validates all the files in the folder, including the contents of any folders, ad
infinitum. If any unreadable files or folders are found, a summary window can be displayed; the
summary window is a standard Finder window and can be dragged, closed, and can remain
open while you continue to use the Finder.

Show Clipboard (Edit Menu)

The Show Clipboard menu item displays the contents of the 11Gs Clipboard, which can contain
text, graphics, or other data. You can use this feature to verify that the data you cut from one
application is still on the Clipboard before launching another application. The clipboard
window can be repositioned, resized, and scrolled, and can stay open while you use the Finder.

Preferences (Special Menu)

The Finder Preferences Dialog (Figure 6Q) lets you configure certain aspects of the Finder's
operation, so you can customize the Finder to the way you work. (Like most good programs, the
Finder is flexible enough to accommodate nearly everyone’s needs.)
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Figure 6Q—Finder Preferences
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The four checkboxes listed under “List Views” allow you to select which columns of
information you want to see in the list views (“By Name,” “By Date,” “By Size,” and “By Kind").
If you don't often care when a file was last modified, for instance, you can turn that column off
by clicking the “Show date” checkbox.

The “Show disk info in header” also affects list views. Usually list views have two lines of
header information. The first line tells you the disk’s type (ProDOS, HFS, etc.), the number of
files in the window, and how much space is used and available on the disk. The second line
provides labels for the columns. If you'd rather see more files and less disk information, turn off
this checkbox and the first line will disappear. (Icon views always show the disk info.)

“Save Finder information onto disk” controls whether or not the Finder saves the locations,
sizes, and views of your windows and the positions and colors of your icons. The Finder saves
this information in hidden files known as Finder.Data files—one in every window you’ve ever
opened in the Finder. If you'd rather not have the Finder leaving its droppings all over your
disks, turn this checkbox off. Any Finder.Data files the Finder has already saved will remain.

= Note!
You can override this feature temporarily by holding down the Contro! key while you close a
window. The Finder won't save the data for that window. (If the Finder has previously saved the
information in this folder, it will not be updated—the next time you open the folder, any
changes you made to the appearance of the window will be gone.) The Control key forces the
Finder to do the opposite of the Preferences setting—if you turn “Save Finder info” off, holding
down the Control key when you close a window will cause it to be saved.

A By The Way...'
If you hold down Control while you open a folder or disk, the Finder will ignore any information
it's already saved for that window and display it at the default location with the default size (the
view will be set to “By Icon.”)

If you'd like to be able to see Finder information files and other normally hidden files, turn the
“Hide invisible files” checkbox off. (Turn off “Save Finder info” and “Hide invisible files,” to
seek out and destroy Finder info files without recreating them as quickly as you delete them.)

A By The Way...
The Finder saves information in the following files: Finder.Data (position of windows and
icons), Finder.Root (position of icons moved to the desktop), and Finder.Def (preferences).

If you uncheck “When starting up, check 5.25” drives,” the Finder will display only the 5.25"
drive icon, and won't try to read the disk. You'll have to double-click the drive icon to make the
Finder look in the drive. If you have 5.25” drives but rarely use them, you can uncheck this box
to avoid the nasty grinding sound the Finder makes when it checks empty drives.

If you uncheck “Color selected icon’s background instead of its outline,” the Finder’s Color
menu will color an icon’s outline instead of filling it with color. (You normally get this effect by
holding down the Control key when you choose a color; changing this preference reverses the
function of the Control key when choosing colors.)
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Once you've selected your preferences, click “Accept”
effect immediately. If you didn’t really want to change t

Icon Info (Special Menu)

Selecting an icon and choosing Icon Info (
(Figure 6R). You can get info on files, folders and disks—even the Trash,

The info window can be moved around and behind other windows—it
window. In the window you'll see up to four “i
Click the tab on the desired index card to flip to

’

that card. The four cards are:

@ File Edit Windows View Disk Special Color Extras

=

Kind:
Size:

Contents:
Created:
Modified:

DATA.SERVER

AppleShare File server
267.3 MB in disk, 16.0 MB free

use calculate icon...
Sun, Mor 8, 1992, 4:00 PN
Mon, Apr 27, 1892, 12:55 PN

Info on "DATA.SERVER® ==cre=x

T 1122 200

to save them. Your new preferences take
he preferences, click “Cancel.”

or pressing &-1) will display an “Info On...” window
if you feel so inclined.
s a standard Desktop
ndex cards” (some icons will have fewer cards)

| _General [T Where J Comment J| Rocess

Figure 6R—Icon Info Window

* General: Tells you what the icon represents (e.g., “ProDOS 3.5” Disk”), how much of
the disk’s storage space is used (or how much is used by a particular file), and when it
was created and last modified. There’s a calculator icon on disk and folder cards
which, when clicked, causes the Finder to scan through the directory and report
exactly how many files and folders are contained by the icon. For file icons, there's a
checkbox to lock the file (protect it from accidental deletion or modification) and, on
many system icons (desk accessories, drivers, and so forth) there’s a checkbox to
deactivate the file to keep the system from using it on the next startup.

* Where: Tells you the name of the device the icon is on (e.g., APPLEDISK3.5A) and the
icon’s complete pathname. The icon’s pathname lists all the folders it’s in (starting with
the disk it's on, working its way down through the folder hierarchy, and ending with
the name of the icon itself).
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e Comment: Allows you to add comments to your files and edit these comments. If the
file doesn’t have a comment, an “Add Comment” button will appear; click it to add a
comment.

@ Warning!
Once you've added a comment to a file, you can’t access the file from older (ProDOS 8)
programs. For this reason, you probably won't want to add comments to, for example, your
AppleWorks files—AppleWarks would no longer be able to read them! 11GS Deskiop programs
would, however, still be able to access the files. An exception to the rule—if you move the file
to a network volume, you’ll be able to access it again. You'll get an alert to this affect when you
add a comment to a file; click “Attach” if you decide to really attach a file.

¢ Access: Displays your access privileges on shared disks (network volumes). Access
privileges can be changed in the FolderPriv control panel.

e Shortcut
You can use the keys -1 through -4 to view the four cards of the Info window.

Shut Down (Special Menu)

Use the Shut Down option at the end of a Finder session. When you select “Shut Down” from
the Special menu, the Finder Shut Down Options dialog (Figure 6T) appears. Your options are:

W file Edit Windows View Siskmecior Extras

ProD04 ® Shut Down (turn off system power)
O Restart

| O Quit to previous application

Icons} T

Figure 6T—Shut Down Dialog
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¢ Shut Down (turn off system power): Use this option at the end of a computing session
to make sure all files are saved. The Finder emptics the trash, saves the position of all
open windows (if the “Save Finder info” preference is on), ejects all 3.5” disks, and
presents an alert that tells you it's safe to turn off the computer. It's not always
necessary to use this option—in fact, you can turn the computer off in the middle of an
application program if you want—but returning to the Finder and shutting down
insures that you remembered to save all your files and that you didn’t leave any disks
in your drives. You neat freaks will always shut down this way.

* Restart: Performs a shutdown, then automatically restarts the computer. Do this after
installing new system elements (desk accessories, fonts, etc.).

* Quit to previous application: The Finder is a Desktop application and it’s the one most
IIGs users start up into, but it's possible to start up into a different application (for
example, a program launcher such as Wings or ProSel) and only run the Finder when
necessary. To return to your original launcher, choose this option.

wr  Note!
If you choose “Quit to previous application” but there is no previous application, System 6's
built-in “mini-launcher” (described in the next chapter) will appear.

Once you've selected your shutdown option, click “OK” to shut down, or “Cancel” to return to
the Finder without shutting down. :

s Shortcut
You can press the S, R, and Q keys to choose “Shut Down,” “Restart,” or “Quit.” {You can also
use the up and down arrow keys to move the radio button from one option to another.)

The Extras Menu

Since the Finder can't be all things to all people, Apple provided a way for programmers to add
new features to the Finder via Finder extensions. These new featurcs appear in the Extras menu
(for the most part—some extensions don’t have a menu item but instead enhance some other
Finder feature). If you haven't installed any Finder extensions, you won't have an Extras menu.

A By The Way...

Finder extensions are installed by copying them into the System.Setup folder (inside your
System folder) on your hard drive or startup disk. Alternately, yo. can create a folder inside the
System folder called FinderExtras and copy them into that folder. Finder extensions in
System.Setup are loaded at startup time and take up memory no matter what program you're
using. Extensions in FinderExtras are loaded only when the Finder is active; they don’t take up
any memory when you're using other programs, but they must be reloaded from disk
whenever you return to the Finder, which can slow things down.

The Quality Computers System 6 Bonus Pack includes two Finder Extensions, called IR and
QuickLaunch. These Finder Extensions are covered in a later chapter.

Working With The Finder 85



86



Chapter Seven

WORKING WITH APPLICATIONS

More About The Desktop

As we've been mentioning pretty much continuously throughout this book, most Desktop
programs operate in pretty much the same way. In Chapter 5 we covered the features that most
Desktop programs have in common. In Chapter 6, we took an in-depth look at the Finder and
covered concepts pertaining to documents, files, and folders at the same time.

Since you know about using the Desktop’s elements and how to launch applications from the
Finder, you know enough to use most Desktop-based programs. However, you'll get further
faster if we give you a few more pointers on dialogs you'll see again and again as you use
Desktop applications under System 6.

One of these dialogs is the Standard File dialog. You use a Standard File dialog when you tell an
application which document you want to work with and when you save and name a document.
System 6 provides Standard File dialogs to keep the user interface consistent—it’s just one more
way to make all programs work the same.

You'll also see standard dialogs when you print your documents. One dialog, Page Setup,
allows you to tell the application what size paper you'll be using and other information the
computer needs to determine how to divide your document into pages. The Print dialog appears
when you actually print your document and allows you to specify the number of copies you
want printed, which pages to print, and whether to use draft or letter quality print.

The other dialog we'll cover is the mini-launcher. We mentioned it in passing in the last
chapter; it's a small program that appears when you quit a program and there’s no previous
application for the program to quit to. (In reality, it's little more than a Standard File dialog.)

Remember, these features are a part of System 6 itself and are available in all Desktop programs.
Learning how to use these dialogs will make Desktop programs even easier to use.

Let’s get into a program that works with documents so you can follow along in our discussion.
We suggest the Teach program from the “SystemTools2” disk. (It may also be on your hard drive
if you installed System 6 there.) Teach is a sort of miniature word processor that's intended for
reading and creating short text documents. The Finder uses it as the default application for text
files. For now, just double-click the “Teach” icon to start the program.
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Documents & Standard File

The Standard Open Dialog

Pull down Teach’s File menu and select “Open” to see an Open dialog. If you're running the
program from the SystemTools2 disk, the dialog will look like the one in Figure 7A,

o B3R fdit Font

Style Size

Please select file to open.

1 &) SystemTools? & (Probls)
L Applelalk S
O lcons

3 Read.Me
9 Shortcuts
[ System

Figure 7A—Standard Open Dialog

At the top of the dialog, the program tells you what you're supposed to do—in this case, “Please
select file to open.” Each application can fill in this message—some are less formal. (We know
of at least one program that simply asks “Whaddaya want?”) Below this instructional message is
an icon representing the disk you're using, the name of the disk, and its type: ProDQOS, in our
case. {There’s also a padlock icon there if your disk is write-protected.)

The dialog is dominated by an alphabetical list of the files on the disk. The list will have a scroll
bar if there are more files than will fit in the window. In the example, we're looking at the main
SystemTools2 directory, which contains three folders and two documents.

i Note!
Most Open dialogs show only the files that the program can apen, along with folders. If you
look at SystemTools2 with the Finder, you'll see that there are two applications (Teach and
Archiver) in the main directory in addition to the documents. Teach doesn’t show you those
files in its Open dialog because Teach doesn’t open applications; it opens text documents. The
same thing would happen if there were graphics documents or other non-text documents on
the disk; they, too, would not appear in Teach’s Open dialog.
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A By The Way...
Some applications show all the files in a directory, but the ones the program can’t open are
dimmed so you can’t select them. You can only select files that are displayed in black.

Let’s open the “Read.Me” file. This document tells you who in the System 6 development team
did what. First, click the Read.Me file; then click the Open button. The file will be opened and
displayed on your screen, and Teach will be ready for you to read or edit it.

The Open button has a double border, making it the default button, so we could have simply
pressed Return to open the file once we'd selected it. (Most applications also accept 3-O to
trigger the Open button.) Or we could simply have double-clicked the file we wanted to open.
There’s a Cancel button there, too, which obviously would dismiss the Open dialog without
opening any file (you can also use its key equivalent, &-Period.)

Instead of clicking the file we wanted to open, we could have used the up and down arrow keys
to select it. We could even have typed the first letter of the file’s name, and the black bar would
have jumped immediately to the first file in the list that starts with that name. In fact, you can
type the first several characters of the file’s name (as long as you type them quickly enough) and
the black bar will jump to the first file starting with the letters you type.

For now, make no changes to the “Read.Me” file. Just close it. (You can click the close box in
the upper left corner of the window, or use the “Close” option on the File menu or its key
equivalent.) Now bring up the Open dialog again—we’ll take a-look at some of the other
features of the Standard File dialog.

Let’s look inside a folder. Double-click the System folder. Not surprisingly, there are no files in
the System folder that Teach knows how to open, so you just see a lot of folders. Double-click
the Sounds folder to look in there. Nope, no openable files there. Click the Close button (or
press Escape) to move back upward through the hierarchy to the System folder, then double-
click the Fonts folder. Disappointment—no openable files there either. (There aren’t any files on
the SystemTools2 disk that Teach can open other than the two in the main directory.)

Press the downward-pointing triangle next to the disk name to access the pop-up folder menu.
This menu shows you how deep in a disk you are, starting with the current directory and
working backward through parent directories to the disk name. In our case, we see the Fonts
folder, the System folder, the disk’s main directory, and, curiously, a level called “Desktop.”

From this pop-up menu, you can select any directory in the hicrarchy and the Standard File
dialog will immediately display the contents of the directory For example, we could select
“SystemTools2” and immediately “pop back” to that directory. It should be becoming clear that
the Standard File dialog represents your disk’s directories in a sort of “flattened” fashion. (In
Standard File, unlike the Finder, you see only one directory at a time.)

A By The Way...
If it helps, think of the Standard File directory as having built-in tunneling. When you open a
new folder, the old one is automatically closed.
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Selecting the “Desktop” level from the pop-up folder menu or clicking the “Volumes” button
displays the names of all the disks in drives connected to your computer (Figure 7B). Double-
click on the disk you want to use and you’ll immediately move to that disk’s main directory.
The “Desktop” or “Volumes” level lets you switch to any other disk you want to use in seconds.

= Note!
In some Standard File dialogs, the “Volumes” button may read “Disk” or “Drive.” It serves the
same function regardiess of its name.

Sy it Font_Sigle Size

Volumes on-line;
B DATA.SERVER ! Yalumes )
&0l ]
o (2
-RANS g
51 SystemTools?2 m
(__ Concel )

B Cmel D)

Figure 7B—Volume Selection (in Standard Open)

Some applications add other buttons to the Standard File dialog. These buttons’ functions differ
from program to program. Consider Teach’s Import File dialog—note the four radio buttons at
the bottom of the dialog that tell Teach what kinds of fites you want to see in the dialog. But the
basic elements of the Standard File dialog are still there at the foundation.

we Shortcut
The following shortcuts are available in most Standard File dialogs:
&-Tab Move to next disk (like going to Volumes and selecting it)
&-Period Cancel (same as clicking Cancel button)
&-Up Arrow, Escape Move to parent folder (same as Close button)
&-Down Arrow, G-0 Open folder or document (same as Open button)
&-Escape, ¢-D Jumps to the Volume list (Disks)
Insert 3.5” disk Display that disk’s main directory
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The Multi-File Open Dialog

A multi-file Open Dialog looks much like a Standard Open dialog, except that in addition to
having a button marked “Open,” it has one marked “Accept.” And the message at the top of the
dialog will tell you to select the files you want to open, not the (singular) file. You can select
multiple files by holding down the & key while clicking second and subsequent files in the list.
(You can also select a range of files by clicking the first file in the group and holding down Shift
while you select the last file in the group.) To unselect a file you selected in error, hold down &
and click the file.

When you've selected the file or files you want to open (you can sclect just one if you like),
click the “Accept” button.

The Standard Save Dialog

The Standard Open dialog is used when you tell an application you want to work with an
existing file—when opening files, or even, in some cases, when deleting a file or performing
other operations on it. The Standard Save dialog (Figure 7C) appears when you save a document
you haven’t named yet (using the “Save” option on the application’s File menu) or when you
save an existing document under a new name (using “Save As”).
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Figure 76—Standard Save Dialog

The Standard Save dialog has all of the features of the Standard Open dialog, plus a “New
Folder” button and a line-edit ficld for entering the name of your document. You may also
notice that the Save dialog shows all the files in the current directory (dimmed, of course), not
just the ones the application can use, so you can make surc that the name you give your
document isn’t already used by another file.
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To save your document in the current directory, just type its name (or edit the existing name)
and press Return. To move to another directory first, you can scroll through the list and open
folders just as in the Open dialog; the pop-up menu and Volumes button work as usual too. (To
type a file or folder’s name to jump to it immediately, you must first press Tab to make sure the
file list has a bold black border around it. Otherwise, whatever you type will go into the dialog’s
line-edit field.)

To save the document into a new folder, first type the name of the folder into the line-edit field,
then click the “New Folder” button. A new folder will be created and opened inside the current
disk or folder. Now type the name of the document and click “Save” (or press Return) to save
the document in the new folder. If you give the document a name that matches an existing file,
you'll get an alert that asks you if you really meant to do that—click “Replace” in that dialog to
save the new document and remove the old one.

= Note!
The “Save” button has a double-border in the Save dialog and will be activated by pressing
Return. To open an existing folder, use the “Open” button (or its keyboard equivalents)—you
can’'t just press Return as you can in the Open dialog.

- Shortcut
The shortcuts in the section on Standard Open dialogs also work with Standard Save dialogs.

More About Documents

Documents are at the heart of everything you do on the IGS. Documents reside on disk while
you're not working on them; they’re copied into the computer’s memory when you open them.
The file on the disk isn't updated unless and until the document is saved.

The File menu in most applications has several options for managing your documents.

e New: Begins a new document. The new document is usually called “Untitled” until
you save it for the first time, at which time you give it a name.

e QOpen: Starts working with an existing document. Many applications allow you to
work with more than one document at a time. Those that don't will remind you to
save your current document before you open a new one.

e Save: Saves the current document to disk. If the document has never been saved, a
Standard Save dialog appears to allow you to name the document and specify the
directory in which to save it. If the document has already been named, the document
is saved back to disk in its original location without presenting any dialogs or alerts,
updating your disk copy of the document to be the same as the document in memory.

° Save As: Allows you to save an old document under a new name by presenting a
Standard Save dialog. When you do a Save As, the original file remains untouched
and you begin working with the new copy of the file—all future Save operations will
update the new copy without changing the old one.
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* Close: Closes the document you're working on. If you've made changes to the
document but haven’t saved them yet, the application asks if you want to save the
changes and performs a Save operation if so.

* Revert: Throws away the changes you've made to the document since the last Save
operation and opens a fresh copy of the document from the disk.

A By The Way...
Some programs call Standard File dialogs by the names programmers use when writing
software. (You'll usually see these terms when the same person wrote both the program and
the manual). For the record:

Programmerese English
SFGetFile Standard Open Dialog
SFMultiGetFile Standard Multi-file Open Dialog
SFPutFile Standard Save Dialog
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Figure 7D—Page Setup Dialog (ImageWriter)

Printing Documents

The Page Setup Dialog

When you create a document, most applications assume that you'll be printing upright on a
standard letter-size sheet of paper. If you won't, you can use the File menu’s “Page Setup”
option to tell the application what size paper you will be using, and set other printer options
such as reduction and enlargement, condensed printing, and so on.
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It's important to adjust your page setup as soon as possible so that the application can
accurately display your document on the screen. (This feature, called What You See Is What
You Get, or WYSIWYG, allows you to lay out your document on the screen and be sure that
your final printout will look pretty much the same.)

The actual appearance of the Page Setup dialog depends on which printer you've selected in
the Control Panel, since each printer supports different paper sizes and resolutions. We'll cover
the ImageWriter Page Setup dialog (Figure 7D) in detail, then pointing out the parts of other
such dialogs that differ from the ImageWriter dialog.

At the top of the Page Setup dialog you'll always see your printer’s name and the port it's
connected to. In this case, we've got an ImageWriter connected to the Printer port. (Other
choices for the printer include StyleWriter, ImageWriter LQ, and Epson; other choices for the
port include Modem port, Parallel Card, or ApplcTalk. The LaserWriter Page Setup dialog
simply says “LaserWriter.”) If this information is not correct, use the DC Printer or Net Printer
Control Panels to choose a printer. (More information on these Control Panels appears in
Chapter 9.)

Next, the ImageWriter Page Setup dialog has a pop-up menu to sefect the paper size. The
ImageWriter supports standard U.S. and international paper sizes, as well as #6 envelopes and a
variety of labels. (Other printers may support fewer sizes and use radio buttons rather than a
pop-up menu to choose among them.)

Below that is a pop-up menu to select the document’s intended print size—either full-sized, or
reduced to 50%. Some printers have more choices here—the ImageWriter LQ lets you select
33% or 66% sizes (but not 50%) and the LaserWriter has a line-edit field that lets you select any
percentage reduction (less than 100%) or enlargement (greater than 100%). The Epson driver
has a checkbox for 50% adjustment,

The two checkboxes below allow you to select No Vertical Gaps (blank space at the top or
bottom of pages) and Vertical Condense. The 11GS screen doesn’t have a square aspect ratio—
that is, if you draw a square on the screen with exactly the same number of dots both
horizontally and vertically, it will look like a tall rectangle because the dots aren’t square.

If Vertical Condense is turned off, what appears on your printer will look just like what's on
your screen—if you draw a circle that looks right on your screen, it will look right on the printer,
However, most text will ook too tall. {f you turn on Vertical Condense, text will be the right size
but graphics may look squashed.

The Epson driver displays radio buttons for selection of Normal or Condensed Vertical Sizing.
These are the same as Vertical Condense off and on, respectively. The LaserWriter allows you to
select Normal (same as Vertical Condense off), Intermediate (a compromise setting that squashes
graphics a little and stretches text a little), and Condensed (same as Vertical Condense on). The
StyleWriter supports Normal (Graphics) and Condensed (Text) settings.

Finally, in the ImageWriter Page Setup dialog, you can select upright (portrait) or sideways

(landscape) printing modes. Most other printers (except for the StyleWriter) also print sideways
or upright.
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The ImageWriter LQQ has two additional checkboxes for darker printing and unidirectional
printing. With unidirectional printing, the print head only prints when traveling from left to
right, for better alignment in graphics.

The LaserWriter has two checkboxes for smoothing and font substitution. Smoothing can help
reduce the jagged edges encountered when printing graphics and certain kinds of text. Font
Substitution makes the printer use Helvetica in place of Geneva and Courier in place of Monaco
when printing text; since Helvetica and Courier are built into the printer but Geneva and
Monaco are not, this can improve the print speed and the quality of the final output.

The StyleWriter driver has a pop-up menu to allow you to choose either automatic or manual
sheet feed and another to select one of two print qualities. With manual sheet feeding, the
computer will pause and ask you to insert a sheet of paper before each page is printed.
Changing the print quality allows you to trade off your time for better print quality—360 DPI
printing is much slower than 180 DPI.

Once you've set your Page Setup options, click “OK” or press Return to accept them. Page
Setup options are saved with each document. If you decide you don’t want to change the
options after all, click “Cancel” or press Escape. Now you’re ready to work on your document,
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Figure 7E—Print Dialog (ImageWriter)

The Print Dialog

Once you've completed a document and are ready to print it, choose “Print” from the File
menu. The Print dialog (Figure 7E) will appear. As before, we'll concentrate on the ImageWriter
version of this dialog and mention how other printers’ Print dialogs differ from it.
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The first thing is a line-edit field for specifying the number of copies to be printed. Below that
are radio buttons that allow you to print all of the document or only a range of pages and two
line-edit fields for specifying the starting and ending pages. As usual, you can use the Tab key to
move from one line-edit field to another. (Tabbing into the From or To fields automatically
switches the “Pages” radio buttons to “Range”—thus, to print a range of pages, just hit Tab after
specifying the number of copies and enter the starting page number, then tab again and enter
the ending page number.)

The ImageWriter driver supports four print modes, which can be selected from the Quality pop-
up menu. Text-only uses the built-in ImageWriter typeface to print a draft of your document
without any graphics; Fast prints a draft of your document using the typefaces you chose and
the graphics you included. Standard does a little better job, and Best yields the best results but
takes a long time to print and uses more ink. The Epson driver supports three print modes—
Better Text, Better Color, and Dratft,

The Chroma pop-up menu allows you to choose either black and white or color printing (the
option for color printing is dimmed if a color ribbon isn't installed in the printing). And the
Sheet Feed option lets you select whether the printer stops before every page to allow you to
insert a sheet of pre-cut paper. The StyleWriter driver also allows you to re-specify the print
quality (360 DPI or 180 DPI) in the Print dialog.

Once you’ve chosen your options, click “OK” or press Return and the printing operation will
begin. (Or click “Cancel” or press Escape to exit the dialog without printing anything.)
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Figure 7F—The System 6 Launcher
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The System 6 Launcher

On occasion, when quitting a program, you'll see the System 6 Launcher (Figure 7F). This
launcher appears when you quit a program and there’s no “previous” application to return to
(for example, when quitting the Finder), or when you boot System 6 and the application you set
in the SetStart Control Panel is not available.

The Launcher is a Standard Open dialog that allows you to select the next application you want
to use. Both Desktop and non-Desktop programs are available, though BASIC applications are
not. Find the program you want to launch as usual, using the “Volumes” button and the pop-up
folder menu and by opening the appropriate folders to get to the application. Then double-click
the application to launch it.

If you want to shut down the computer, click the “Cancel” button, then select “Shut Down”
from the File menu.

= Note!

The Finder is a standard application file and can be launched by the Launcher. Just open the
System folder of your startup disk and launch the file called Finder.
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Chapter Eight
WORKING WITH DESK ACCESSORI

About Desk Accessories

The Apple 1IGS supports two different kinds of desk accessories. Desk accessories are the
electronic equivalent of the tools you keep on your real desk—things like calculators, notepads,
and calendars—that are usually kept to the side of your regular work but are always available at
a moment’s notice. (To the computer, of course, desk accessories are just more programs.)

Classic Desk Accessories, also called CDAs or text desk accessories, use the IGS's text screen
(the screen used by AppleWorks and most older programs). Most are accessible from both
Desktop and non-Desktop programs. To see a list of available CDAs, hold down & and Control
while pressing and releasing Escape.

New Desk Accessories, also called NDAs or graphic desk accessories, appear in windows in
your Desktop programs. NDAs are listed in your & menu.

Desk accessories (both NDAs and CDAs) are installed by placing them in the Desk.Accs folder
inside your startup disk’s System folder. After you install any desk accessories, you must restart
the computer before they are available for your use.

A By The Way...
If you bought the Quality Computers System 6 Bonus Pack, there’s a Finder Extension called IR
that allows you to install desk accessories without having to restart, and without the desk
accessories needing to be in the Desk.Accs folder. Keep reading for more details.

Finder extensions are similar to NDAs.—they’re essentially desk accessories that work only in
the Finder. Instead of appearing in your @ menu, Finder Extensions appear in the Finder’s Extras
menu (which appears only if you have installed one or more Finder Extensions). Finder
extensions are installed by placing them in the System.Setup folder inside your startup disk’s
System folder.

A By The Way...
Finder extensions can also be placed in a folder called FinderExtras—this folder doesn’t exist
on a normal System disk, so you must create one first. Finder extensions installed in the
FinderExtras folder only use memory while you're in the Finder but cause the Finder to take
longer to start up; extensions in the System.Setup folder use memory all the time but don’t
slow down the Finder.
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In this chapter, we’ll discuss the CDA menu (and the enhancements made to it under System 6)
briefly. There are no new CDAs included with System 6, though (there’s one in the System 6
Bonus Pack), and the old ones work the same way they always have. The text-based Control
Panel, for example, is a built-in CDA and it's well documented in your IGS Owner’s Manual, so
we won’t cover it in this manual.

We'll be covering the NDAs that come with System 6 in some depth, though, along with the
Finder extensions. These accessorics are all new or completely revised in System 6—plus there
are even more in the System 6 Bonus Pack! (Bonus Pack desk accessories are marked with an
asterisk. If you didn’t buy the Bonus Pack, you won't have these accessories.)

Classic Desk Accessories

100

Classic Desk Accessories (CDAs) are accessed by holding down & and Control while pressing
and releasing Fscape. You select the CDA you want from the list displayed on the screen (Figure
8A) by using the Up and Down arrow keys; press Return to open the highlighted CDA.

n

ernate Displau Mods

Memory Pesker o
Uisgit Applescft BASIC
Uisit Monitor

Quit

¢ Desk Accessor le:

Select: - 1 Cpen

Figure 8A—Classic Desk Accessory Menu

® New & Improved

System 6 enhances the CDA menu to allow you to use &-Up Arrow and &-Down Arrow to
move the highlight bar a screenful of CDAs at a time (if you have that many installed). You can
also move the highlight bar to the first CDA starting with a certain letter by pressing that letter,
Pressing Escape moves the highlight bar directly to “Quit.” Some of these features were
previously available on the ROM 03 I1GS; System 6 brings them to all [IGS models.
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Activating The Built-In CDAs

All Apple 11GS models have two built-in CDAs called “Visit Monitor” and “Memory Peeker.”
Depending on which Apple IGS model you have, though, these CDAs may not appear in the
CDA menu automatically. While documenting the use of these CDAs is beyond the scope of
this manual (they're rather technical and useful mainly for debugging programs) we're not
beyond telling you how to install them:

* Double-click the BASIC.System icon on your startup disk

* When the BASIC prompt (1) appears, type “CALL-151" (without the quotes) and press
the Return key.

* When the Monitor prompt (*) appears, type a number sign (#) and press Return.

* Finally, type “BYE” (without the quotes) and press Return.

Upon returning to the Finder, access the CDA menu and note the two new CDAs. The CDAs
will disappear each time you turn off the computer.

Visit Applesoft BASIC*

The System 6 Bonus Pack includes a new CDA called “Visit Applesoft BASIC.” If you're familiar
with the 1IGS’s built-in “Visit Monitor” CDA, you'll like this one. From any Desktop program,
select “Visit Applesoft BASIC” from the CDA menu and you're plopped into Applesoft BASIC.

Disk commands are not available, and you should not use graphics commands if you want to
avoid crashing your computer. Press an ampersand (&) followed by Return to exit to the CDA
menu. This CDA does not work from ProDOS 8 programs.

It's mainly for hackers—for people who occasionally would like to pop into BASIC and do a

quick calculation or cobble together a short program to test some idea they’ve had. But we
thought some of you would find it useful, so we included it.

New Desk Accessories

New Desk Accessories (NDAs) are activated by choosing them from the # menu of most
Desktop applications. NDAs appear in their own windows which can be manipulated like any
other Desktop window. You can even leave NDAs open while you work on something in your
main application program—a click in their window will bring them back to the front. You can
have a virtually unlimited number of NDAs open at any time.

NDAs can be closed by clicking their close box (in the upper left corner of their window) or by

choosing “Close” from the File menu or by pressing &-W. Additionally, all open NDAs are
closed automatically when you quit a program.
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Calculator

The calculator NDA (Figure 8B) is a simple four-banger that can be operated with the mouse or
via the 1IGS numeric keypad (notice that the calculator’s on-screen layout is the same as the
numeric keypad’s physical layout; the asterisk, “*” is used for multiplication and the slash, “/”
is used for division). The calculator doesn’t understand precedence—it performs all operations
in the order you choose them. (If you're used to algebraic calculators where multiplication and
division are always performed before addition and subtraction, well, this one isn’t quite that
sophisticated. The System 6 Bonus pack includes a scientific calculator that’s quite a bit more
powerful, though.)

w File Fdit tHadows View Bisk $p

Calculator 2|

Figure 8B—The System 6 Calculator

A By The Way...
Clicking the Calculator’s zoom box (upper right corner of its window) or pressing the 2’ key
expands the calculator’s keypad to include a hexadecimal keypad. Click the “Hex” button to
switch the calculator to hexadecimal mode. (You programmers will know what that is—it's
next to useless for ordinary mortals, though.) Pressing the ‘H’ key toggles the calculator
between hexadecimal and decimal mode. The calculator’s hexadecimal keypad does not nead
to be visible to be used.

ms  Shortcut
Use the “=" key to repeat the last operation. For example, to count upward by odd numbers,
type “1+2 =====."Typing “/” followed by “=" calculates the reciprocal of the number in the

display (same as dividing it into 1). For example, “4 / =" yields 0.25.
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The contents of the calculator’s display can, of course, be cut and pasted. “Copy” copies the
contents of the calculator’s display to the clipboard, ready for pasting into a spreadsheet or
other document. “Cut” does the same and clears the calculator’s display. “Paste” passes the
contents of the clipboard to the calculator just as if you were typing it on the keyboard. This
means you can paste an entire expression (like 5/ 7 + 25 =) to the calculator and get the result
in the display. Any keystrokes that the calculator doesn’t recognize will be ignored.

CD Remote, Media Controller, & VideoMix

These NDAs are part of Apple’s Media Control package. CD Remote allows you to play audio
CDs on an Apple CD-ROM drive using an on-screen “remote control.” Media Controller lets
you control videodiscs and other devices, also using an on-screen remote. VideoMix lets you
control the Apple Video Overlay Card from within any Desktop application.

Control Panels

The Control Panels NDA is used to access the System 6 control panels. Control panels are small
accessory programs, much like desk accessories, which are used to configure the operation of
your lIGS, System 6, and other things.

There are so many control panels that we've given them a chapter of their own (the next one, in
fact). We'll skip over this NDA for now.

CloseView & Video Keyboard

Video Keyboard displays a windoid with a simulated Apple 11GS keyboard, which you can click
instead of typing. CloseView allows you to enlarge the screen display. These two NDAs are part
of Apple’s Special Aids package that allows physically handicapped people to use the lGS more
easily. {Actually, CloseView isn't an NDA, though it does appear in the # menu.)

CPU Use*

The CPU Use NDA is a simple tool for showing you how much of your computer’s capacity is
being used by the program you're using. It's a well known fact that computers spend much of
their time waiting for you, the user, to do something. And the faster the computer, the more time
it spends waiting.

Just choose CPU Use from the ® menu for a bar graph display (Figure 8C) that's updated every
half a second. You can even leave CPU Use open while you work to see just how much CPU
activity the things you do generate.

CPU Use is freeware by Bill Tudor.
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Figure 86—CPU Use NDA
Enigma*
Enigma (Figure 8D) is a game of logic for one player in the tradition of Mastermind. The object

of the game is to use the process of elimination to arrange colors in the grid to match a secret
code sequence that has been randomly chosen by the computer.
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Figure 8D0—The Game of Enigma in an NDA
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When you open Enigma from the & menu, you'll be ready to start a game. The empty rectangle
at the top of the window is where the sccret code will be revealed. There are twelve rows of five
pegs each where you'll put your guesses. To the left of cach row are five characters that tell you
the results of your guess. The guess you're currently working on has “???2??” next to it.

Click a color followed by a peg to place a color on that peg. When you've placed an entire row
of colors, click “OK” to reveal the computer’s clue. If you've picked any of the correct colors in
the secret code, an “0” will appear in the clue for each correct color chosen. If you've picked a
correct color and placed it in the correct position, an “X” will appear in the clue for each color
you've placed correctly. (When you get five “X”s, you've solved the puzzle and the correct
answer is revealed).

If you use up all twelve rows and still don’t solve the puzzle, you've lost and Enigma displays
the correct answer. To start a new game, click “New;” to quit the current game and reveal the
answer, click “Quit.”

Enigma is from the GS Desk Accessories package, © 1989 Beagle Bros, Inc.

File Manager*

File Manager (Figure 8E) is a sort of “mini Finder” that is available from within all your
programs. It allows you to move, copy, delete, and view the contents of files; create new
folders; view and modify files’ Icon Info; format, erase, and rename disks; and find files based
on a partial name (much like the Find File NDA).

w File Edit Hindows Yiew Disk Speciol falar Extras

File Manager
v2.02 ©1990-92 Jeff Hartkopf
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Figure 8E—The File Manager NDA
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*  Move: Click the Move icon and a Standard Opcen dialog will appear to select the files
or folders you wish to move. (You can select more than one.) Click Accept and a
Standard Save dialog will appear to et you select the target directory for the file being
moved and the file’s new name. Click Save to begin the Move operation. If you move
the file to the directory it's already in but usc a different name, the file will be
renamed. If you move the file to a different disk, it will be removed from the source
disk. Each file you have chosen to move presents a different Save dialog, so you can
easily move files to entirely different folders.

* Copy: Click the Copy icon and a Standard Open dialog appears. Select the files or
folders you wish to copy. As with Move, you can select more than one. Click Accept
and a Save dialog appears. Select the target directory and the file’s new name, then
click Save to begin copying.

¢ Remove: Allows you to remove a file from a disk, just like dragging it to the Trash.
The difference is that the file is removed immediately—it doesn’t go to the Trash first.
Choose the files to be removed from the Standard Open dialog

* New: Allows you to create a new folder. Use the Standard Save dialog to move to the
folder you want to create the new folder in, then enter its name and click the “New
Folder” or “Save” button. (Since System 6 has a New Folder button built into all its
Standard Save dialogs, you may not use this feature very much anymore.)

* Info: Allows you to view and change a file’s Icon Info. Use the Display pop-up menu
to view the file's size, type, access permission, and creation/modification date. Most
of these displays also allow you to change the file’s attributes—something the Finder
doesn’t allow—but you should be very careful in doing that! Changing a file’s type
usually makes it useless for its intended purpose, for example. Use the “Next” button
to view the next file you've selected.

* Device: Allows you to initialize, erase, and rename disks. As you click a device name
in the dialog, the corresponding disk name appears in the “Name” line-edit field (the
field is blank if the disk is unformatted or if no disk is in the drive). Type a new name
and click “Initialize,” “Erase,” or “Rename.”

* Find: Allows you to find files based on a partial or complete name. Unlike the Find
File DA, you can select to search a folder instead of searching an entire disk via the
Standard Open dialog, and you also can tell File Manager whether to ignore upper-
lower case differences . However, File Manager won't search in the background, and
it displays found files by their pathnames.

¢ View: Allows you to view the contents of files. This is most useful for text files, but
you can view any file (most files will look like garbage). After selecting a file using the
Standard Open dialog, you can scroll through the file, search for a specific string, and
select and copy contents of the file to the clipboard for pasting to another document.

106 Chapter Eight



We've only touched on the features of File Manager. It's a very feature-rich program that's sure
to make using System 6 easier. For further information, consult the documentation file
“FileMgr.Docs” in your Desk.Accs folder.

File Manager is shareware © 1992 Jeffl Hartkopf. The usual shareware fee js $20. Through special
arrangement with the author, owners of the System 6 Bonus Pack can use the included version of File
Manager without paying the shareware fee. This applies only to this version of File Manager; for future
upgrades, payment of the new version’s shareware fee will be required. If you register the current version,
you'll receive a complete printed manual and upgrade notices for future versions.

Find File

Even the best organization sometimes falls flat on its face. You know you saved that file
somewhere, but it's not where you expect it to be. Not to worry—the Find File NDA (Figure 8F)
can find it, as long as you remember part of the name.
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Figure 8F—Find File NDA

Use the pop-up Disks menu to tell Find File which disk to search. Type however much of a file’s
name as you can remember—usually a few letters or one word will be enough—into the line-
edit field. Use the pop-up menu to the right of the line-edit field to tell Find File whether you
think the name of the file contains what you typed (the most general search), matches it exactly
(the most specific search), or begins or ends with what you typed. Then click the “Find File”
button and the search begins.

You can continue working while Find File works. Just bring your document window to the front

and Find File will continue searching in the background. (it searches faster while the Find File
window is in front.)
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When Find File finds a file that matches the search criteria, it displays its name in the list just
below the line-edit field. If you've chosen a phrase that occurs a lot on your disk (try searching
for all files that contain the letter £, for example!), you’ll end up with a long, scrollable list. You
can scroll this list while Find File continues searching——it takes the system a second to
acknowledge a mouse click while Find File is working.

Click any file on the list to find out where it is (Figure 8G). In this example, we’ve clicked the
file SCSI.Manager. The folder list (below the file list) tells us the file is in the Drivers folder,
which is in the System folder, which is on the volume Q7.

Extras
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Figure 8G—Checking the Found Files List

When Find File finishes searching, you can continue looking at the locations of the files that
Find File has found, or prepare another search by typing a new search word.

Key Find*

Most ligs fonts support extra characters that can be typed using the Option key. Most of these
are foreign characters and symbols. You may occasionally find these useful to include in your
document, but it's not always easy to remember that Option-2 produces the “™" character. Key
Find (Figure 8H) to the rescue!

Click on any character in Key Find’s grid and Key Find displays the keystrokes necessary to
produce that character (for example 7 is Option-N followed by a lowercase “n”), as well as a
large-size view of that character. Use the Copy command (3-C) to copy the character to the
clipboard, then return to your document and paste it in.
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Figure 8H—KeyFind NDA

The Font pop-up menu lets you determine which font is displayed inside the grid—sometimes
different fonts have different special characters. There’s only one quirk—it takes a second or two
for Key Find to be ready after you first click on the grid. Keep pressing and eventually Key Find
will spring to life.

Key Find is freeware by Alfredo Velella.
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Figure 8J—Memory Bar NDA
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Memory Bar*

The Memory Bar NDA (Figure 8}) makes a good companion to the CPU Use NDA. In graphic
form, it shows you just how much of your computer’s memory is in use and how much is
available for use. Unlike the Finder’s “About The Finder,” the Memory Bar NDA is available
within all Desktop applications, because it's an NDA.

The yellow portion of the bar represents the amount of memory in use. The green portion
represents the amount of memory that is in use but will be released if another program needs it
(purgable memory). The pink portion indicates the largest contiguous block of memory
available—how much memory a program can allocate all at once (MaxBlock). And the white
area represents how much memory is not in use but is not included in MaxBlock (the white and
pink bar together represent free memory).

To find out exact memory sizes for any of the bars, click on the bar you're interested in or press
the numbers 1-5. You can also use Tab to cycle through the available bars.

Click the “Compact” button to get rid of as much purgable (green bar) memory as possible and
make it available for reuse by the system. Usually you won’t need to use the “Compact” button
because the system will give up purgable memory as it's needed. However, you may find this
button useful before launching some memory-hungry programs.

@ Warning!
Don’t compact memory while you're running AppleWorks GS. Evidently that program marks
part of its memory as purgable when it really isn’t Compacting memory is a good way to crash
AppleWorks GS. .

Memory Bar is public-domain software by Dave Lyons.

Minstrel*

Minstrel (Figure 8K) allows you to play SoundSmith and SynthLab songs in Desktop programs
while you continue to work! It's like a jukebox for your 1IGS. SynthLab is a program included
with System 6 for recording and playing back high-quality music. Now you can listen to those
songs any time you like.

Minstrel keeps track of a list of songs in its “jukebox.” To add a song to its jukebox, click the
Insert button (you'll have to do this first because there are no songs in the jukebox to begin
with). Using the Standard File dialog, open a SoundSmith or SynthLab song. It appears in the
list. Add any other songs you might want to listen to, too. You can add as many as you want
from one folder—hold down the Shift key while clicking to select all the files from the current
selection to the click location; use the & key while clicking to select and unselect individual
files. Click Accept to add the files you selected. (To remove a song from the list, click “Eject.”)

To play a song, select it from the list and click the “Play” button. To play all the songs in the list
in a random order, click “Shuffle.” To repeat the currently playing song, click the “Repeat”
button. The “Rewind,” “Forward,” and “Pause” buttons are functional during playback. “Stop”
works just as you'd expect,
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Figure 8K—Minstrel, the Music NDA

Minstrel will continue playing songs even if you bring your document to the front and resume
working. Your main program will run somewhat slower while Minstrel is playing sounds. (An
accelerator helps.)

Minstrel, by Chris McKinsey, is copyright © 1991 by Softdisk G-S, a monthly disk publication. Used by
permission. For subscription information, call 1-800-831-2694 Ext. 1005.

Note Pad*

Ever wish you had a place for jotting notes to yourself? If you're like us, your desk is covered
with little tiny slips of paper with things scribbled on them—or worse, those sticky Post-It notes.
The Note Pad (Figure 8L) is an electronic solution to the clutter problem. Just type your notes
into the Note Pad and they’ll always be handy in any Desktop program.

The Note Pad contains eight numbered pages for your jottings. To move from one page to the
next, click the upturned page corner in the lower left . To move to the previous page, click the
edge of the page showing under the upturned corner.

Note Pad is from the GS Desk Accessories package, © 1989 Beagle Bros, Inc.

ScientCalc*

If you prefer a full-featured scientific calculator to Apple’s functional but wimpy four-banger, try
ScientCalc (Figure 8M). It has all the functions of a TI-30 or similar calculator, including
memory, factorial, hexadecimal and binary functions, logarithms, trigonometric functions, and
even something no real calculator we've ever seen has—built-in help!
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Figure 8L—The Note Pad NDA

Figure 8M—The ScientCalc NDA
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If you're familiar with scientific calculators, using this one should be a breeze. The built-in help
(click the “2” button) lists which buttons do what, and which keys on the keyboard activate
buttons on the keyboard (most buttons can be activated from the keyboard). We've also
included a documentation file that you can read with Teach—look in the Desk.Accs folder.

ScientCalc (also known simply as Calculator) is shareware © 1992 Jeff Hartkopf. The usual shareware fee is
$15. However, through special arrangement with the author, owners of the System 6 Bonus Pack can use
the included version of ScientCalc without paying the shareware fee. This applies only to this version of
ScientCalc; for future upgrades, payment of the new version’s shareware fee will be required. If you register
the current version, you’ll receive a complete printed manual and upgrade notices for future versions.
Note: We changed the name to ScientCalc to avoid conflict with Apple’s Calculator, which has the same
name. However, the rest of the NDA is the same as the shareware version.

Scrapbook*

The clipboard is useful for copying information from one application to another, but it only
holds one item (text or graphics) at a time. The Scrapbook (Figure 8N) gives you a place to store
all your clip art and text where it can be accessed easily. Use the scroll bar at the bottom of the
Scrapbook window to view your clips.
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Figure 88—The Scrapbook NDA

To store text or graphics into the Scrapbook, just use the “Cut” or “Copy” commands to place
the desired material on the clipboard from the desired application. Then open the Scrapbook (or
bring it to the front if it's already open) and select “Paste” (or press G-V).
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You can also use the “Get File” button to add a clip to the Scrapbook. You can place any
standard (Apple Preferred format) graphics file, or any standard text file, on the clipboard this
way. A Standard Open dialog will appear; select the file you want to use and the entire file (up
to 32K of graphics or 16K of text) will be placed on the Clipboard. Then paste it into the
Scrapbook using &-V.

To copy text or graphics from the Scrapbook into an application, use the scroll bar to view the
clips until you find the one you want to use. (Or use the Select button to bring up a Standard
Open dialog to allow you to select the scrap by name.) Then select “Copy” (or press 3-C),
switch back to your application, position the insertion point where you want the scrap to be
inserted, and select “Paste” (or press G-V). You can also select part of an image in the scrapbook
by dragging a rectangle around the section of the image you want to use before Copying it.

Scrapbook is from the GS Desk Accessories package, © 1989 Beagle Bros, Inc.
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Figure 8P—ShowPic Graphics Display/Conversion NDA

ShowPic6*

ShowPicé (Figure 8P) lets you view virtually any graphics you may encounter, no matter what
format they may be in. ShowPic can load and display:

Unpacked graphics (Screen) files

Eagle/Packbytes format graphics

Apple Preferred Format graphics

PaintWorks (320/640) format graphics

Print Shop GS color graphics

Normal & packed 3200-color piclures (APP & APF)
Graphics Interchange Format (GIF) 87a & 89a
MacPaint graphics
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Just click the Show button. A Standard Open dialog will appear; select the files you want to
display and click “Accept.” To save a displayed graphic in screen format (which can be read by
most paint programs), press -S and use the Standard Save dialog to specify the name and the
target directory for the file. ShowPic functions both as a simple “slide show” program (adjust the
time delay in the line-edit field) and a simple graphics converter.

There’s a lot more, too. Unfortunately, we don’t have the space to go into it. Click the “Help”
button for more information; we've included a documentation file (called “ShowPic.Docs”) as
well. (This documentation file is placed in your Desk.Accs folder when you install the Bonus
Pack Desk Accessories.. Double-click it to open it in Teach.)

ShowPic is freeware by Dave Leffler and Lunatic Jonathan Bruce E’Sex.

Finder Extensions

As we've mentioned, Finder extensions are desk accessories for the Finder. There’s one
included with System 6 and two more in the System 6 Bonus Pack.

EasyMount

EasyMount is used to create small documents that automatically mount network volumes when
double-clicked in the Finder. Just click the shared disk you wish to create an auto-logon
document for, then choose “Create server alias” from the Extras menu. The FasyMount server
alias can then be double-clicked to log onto that network volume.

IR*

IR"is a Finder extension developed by Matt Deatherage at Apple. Originally, IR stood for “Init
Restarter” and was used to load init files (files usually loaded by the system during startup) after
the system had already been started. It has evolved into a tool for loading NDAs, CDAs, drivers,
inits, and Finder extensions—all of which usually must be loaded at boot time—just by double-
clicking them in the Finder.

Okay, that's what IR does—but what does it do? In practical terms, having IR in your system
means that you don't have to keep infrequently used system elements (particularly DAs) in your
System folder all the time. (Having lots of desk accessories in your system folder means less
memory for your programs and longer boot times.) Even though these DAs don’t normally
appear in your % menu, you can double-click them in the Finder and they’ll open like magic—
and automatically be added to your % menu until you restart your computer. The same is true of
drivers (you might leave your 5.25” driver out of the System folder if you rarely use 5.25” disks,
then double-click it if you decide you want to use it in a Finder session—voila, your 5,25”
drives appear on the desktop) and Finder extensions. Even inits—like Apple’s GSBug debugging
utility (not included) and the System 6 Special Aids—can be installed with IR.
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=  Note!
There are few DAs and Finder extensions that don’t like to be opened up by IR. All the ones in
the Bonus Pack work fine, but be sure to try IR with other new DAs before relying on it to
work. Some of them just won’t—that's not a bug in IR, it's just a fact. We decided that even
s0, IR is more than useful enough to include in the Bonus Pack.

IR also has a Preferences item on the Extras menu (Figure 8Q). Check “Install NDAs instantly” if
you want IR to install NDAs in the ® menu immediately (if you uncheck this box, the # menu
isn’t updated until you launch an application). “Open NDAs if possible” tells IR whether or not
to automatically open NDAs after they're installed (if not, they’re only installed in the & menu).

IR Preferences 201

B Install NDAs instantly
Gpen NDRs if possible

Install Finder extensions
permanently

[ Give others first shot at files
[<] Tell me about problems

If you choose an instolled file....
O Install a new copy

@ Try to remove the old one
(O Always remove the old one

H Coave ) (TCancel ) Accept )

Figure 80—IR (Say “Ear”) Preferences

“Install Finder extensions permanently,” if checked, tells IR to install Finder extensions for the
remainder of the session (until you restart); if unchecked, Finder extensions go away when you
leave the Finder. “Give others first shot at files” allows applications to see these system files (as
documents) when they’re double-clicked; only if there’s no application for those files will IR
open them. “Tell me about problems” tells IR to put up alerts when errors occur.

The radio buttons let you tell IR what to do if one of the things you're installing is already
there—install a new copy, try to remove the old one (if that’s not possible, install the new one
anyway), or always remove the old one (if that's not possible, do nothing).

When you're done setting preferences, click “Accept” (to save the changes in memory until you

restart) or “Save” (to save the changes permanently to disk). “Cancel” dismisses the dialog
without saving your changes.
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ws Shortcut
The following keys activate various buttons in the IR Preferences dialog:
&-N Toggle “Install NDAs Instantly”
-F Toggle “Install Finder extensions permanently”
-l Select “Install a new copy”
-T Select “Try to remove the old one”
-A Select “Always remove the old one”
-S Click “Save”

GO aO

We've included the original documentation written by Matt Deatherage. Look in your
System.Setup folder for “IR.Docs” after installing the Bonus Pack.

IR 2.01 by Matt Deatherage © 1992 Apple Computer, Inc. Licensed for use with the System 6 Bonus Pack.

Quick Launch*

Quick Launch (Figure 8R) is an Finder Extension that lets you add your most frequently used
applications to the Extras menu. No more digging through your folders or moving windows out
of the way of the desktop items to launch applications! Select “Quick Launch list” from the
Extras menu to tell QuickLaunch which applications to put in the Extras menu.

& File Edit Windows View Disk Special Color RIUIETN

Quick Lounch: -
Create a list of your favorite applications

Applesoft . - BEETEENE | ¢
08 Shrinklt |

Platinum.Paint Remove
SuperConvert
synthLAB

Figure 8R—CQuickLaunch Configuration Dialog

Click the “Add” button and a Standard Open dialog will appear. Select the application you
want to add to the menu and click “Open.” Then click “Done” and check the Extras menu. Your
new application should be listed just under “Quick Launch list” with a tiny application icon to
its left. Removing an application from the list is just as simple—click the item in the Quick
Launch dialog, then click “Remove.”
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You can also edit your applications once they've been added. For example, if you add
Aplworks.System to the list, you can edit the item on the menu to read “AppleWorks”—in plain
English. You can also assign a keystroke to launch that application: in the Menu keys line-edit
field, just type the character you want to use. (If you're using a letter, “A” for example, type “Aa”
to assign both upper and lower-case versions of the letter to the application.) Then you can
press, for example, G-A to launch the application instcad of pulling down the menu.

Full online help is available. Click the “Help” button and choose an appropriate topic from the
“Topic” pop-up menu. When you're done setting up your application list, click “Done.”

Quick Launch by Steve Stephenson © 1991-1992 Seven Hills Software Corp. Used by permission.
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Chapter Nine

WORKING WITH CONTROL PANE

About Control Panels

You're probably familiar with the built-in 1IGS Control Panel. It's a Classic Desk Accessory and
is accessed by holding down & and Control while pressing and releasing Escape, then selecting
“Control Panel” from the CDA menu. (If you're not familiar with the built-in Control Panel, grab
your I1GS Owner’s Manual and take a few minutes to learn about it.)

You use the built-in Control Panel to view and change the various settings of your 1IGS—how
fast the keys repeat on the keyboard, whether a particular slot in the computer is connected to a
card or to a port on the back panel, and things like that. The built-in Control Panel is always
available from the instant you turn on your computer, and it remains available in most programs
(they don’t have to be Desktop programs).

System 6s control panels perform the same function, except that they only work in Desktop
programs. Instead of having one big desk accessory for all functions (like the built-in Control
Panel), there’s a control panel for each function—one for choosing a printer, one for adjusting
the functionality of your keyboard, one for adjusting your slot mapping, and so on.

® New & Improved
In Systems previous to System 6, the NDA itself was called the Control Panel, and each control
panel in it was called a Contro! Panel Device, or CDev for short. Each CDev appeared in the
same window (part of the Control Panel NDA window) so only one CDev could be open at a
time. In System 6, each control panel appears in its own window: the new Control Panels NDA
is just a convenient way of opening the control panels (they can now be opened by the Finder).

A By The Way...
The terminology change from “CDevs” to “control panels” parallels a similar change recently
made on the Macintosh, when Apple released Macintosh System 7.

Control panels are stored in a folder called CDevs inside the System Folder. Installing new
CDevs is as simple as dragging them into this folder. Usually, control panels can be stored in
other folders, too, but there are a few control panels that definitely need to be in the CDevs
folder because they do something at startup time.
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Opening Control Panels

There are two basic ways to open control panels in System 6. First, as depicted in Figure 9A,
you can open them with the Finder by opening the CDevs folder (inside the System folder) and
then double-clicking the desired control panel.

@ File Edit Windows View [Disk Special Color Extros

01 | B
System
ProB0S _ 18items 11UMBused 8.5 MBfree}

YystemSetup DeskHces Start

Fonts Tbéis evs
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Figure 8A—Opening a Control Panel with the Finder (One Way To Do It)

md  Shortcut
Holding down ¢, Option, and Shift while pressing and releasing Escape opens the CDevs folder
on the startup disk, without having to open the other two windows to get to the CDevs folder.
Another popular shortcut is to drag one or more control paneis out of the CDevs folder and
onto the desktop. (They'll still appear in the Control Panels NDA, too!)

Double-clicking a control panel, obviously, only works when you're in the Finder, and it'd be
rather inconvenient to have to quit the program you're using every time you wanted to change
some aspect of your IIGS’s functionality. Therefore, System 6 also includes a Control Panels
NDA (Figure 9B) that can be accessed in any Desktop program.

m Shortcut
Hold down <& and Shift while pressing and releasing Escape to pull up the Control Panels NDA.
{This is analogous to the ¢s-Control-Escape sequence used to access the Control Panel CDA)

Scroll through the list of installed control panels, then double-click one to open it. (Alternately,

you can use the “Open” button to open the highlighted control panel, or click the “Help”
button for more information a control panel).
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% File Edit Hindows VYiew Disk Special Color Extros

Figure 9B—The Control Panels NDA (The Other Way To Do It)

® New & Improved ,
In System 5’s Contro! Panel NDA, you only needed to click the icon of the desired CDev gnce
to activate it. Apple decided that this was inconsistent—CDevs are displayed as icons, and you
should double-click icons to open them. Thus, in System 6 you double-click.

w Shortcut
You can also use the arrow keys to select a control panel in the Control Panels NDA, and press
Return to open the selected control panel. Typing the first few letters of a control panel’s name
also works to select it.

With the Control Panels NDA, you can open as many control panels as you like. Control panels
even stay open when you close the Control Panels NDA. Control panel windows can be moved
around wherever you like on the screen, and you can even leave them open while you work by
clicking a document window and bringing it to the front.

The rest of this chapter is a reference describing each control panel included with System 6.
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The Control Panels

DC Printer

The DC (for Direct Connect) Printer control panel (Figure 9C) allows you to tell the system
which printer is connected to your computer and how it’s connected. The top list allows you to
choose the printer port, the modem port, or a parallel card in slot 1; the bottom list allows you
to choose an Epson, ImageWriter, ImageWriter LQ), LaserWriter, or StyleWriter printer. Click the
appropriate settings for your system, then close the control panel.

I

122

@ File Edit Hiadows View

Disk Special Color Extrus

Control Panels

B

EC== 0 Printer

$§

elect g Port:

Nodea’
Parallel.Card

8

elect a Printer Type:

etPriv 3]

‘ Fold

Imagellriter
Imageldriter.L
LaserWriter

Figure 9C—The Direct Connect Printer Control Panel

Note!

The ports and printers listed will depend on which printer drivers you've installed. If you don’t
taller to see if it has a driver for your printer. If it does, install it.
party driver packages, such as Vitesse’s Harmonie and Seven
Hills" Independence, which provide drivers for a wide range of printers that Apple doesn’t

see your printer, check the [ns

If it doesn’t, investigate third-

support directly.

Shortcut

The DC Printer control panel,
the keyboard. Use the Tab key
down arrow keys (or letters on
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General

The General control panel (Figure 9D) allows you to change a number of 11GS system settings,
all of which are controlled by a pop-up menu. (The default, or normal, settings are displayed in

italic type in the menu.)

Menu Blinking{_1Time i ™3
‘ § Cursor Flash: REn e
G Systenm Speed:

Nouse Speed: ’
Double Click: B

| Keubourd: DATASERVER
{ Translation: [ Standard)} At

ﬁﬁ@w

Braffiti

[Reies )
Keyboard E

Alphabetize DRs Troch

Figure 90—General Control Panel

Menu Blinking: Controls how many times an item in a pull-down menu flashes after
you select it.

Cursor Flash: Controls how quickly the insertion point flashes. Also controls the
flashing cursor in some (but not all) older, 8-bit programs, especially BASIC ones.
System Speed: We suggest keeping this set to “Fast” at all times.

Mouse Speed: Controls how far you have to move the mouse to move the pointer
across the screen. The faster the Mouse Speed, the Jess you have to move it. (ROM 01
[1GS owners can choose two settings here; ROM 03 owners have more choices.)
Double Click: Controls how fast you must click the mouse for the computer to
recognize two clicks as a double-click instead of two separate click. Set this too fast,
and the computer may not recognize your double-clicks; set it too slow, and the
computer may recognize a double-click when you really intended two single clicks.

Monitor: Determines the display language for the screen. Most of you are ‘murricans,
so the default setting of “U.S.A.” should be fine.

Keyboard: Determines the keyboard layout. “U.S.A.” should be fine for most of you.
Translation: Controls keyboard translation (for foreign and special characters). If a
program isn't responding properly to Option keystrokes, set this option to “None.”
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There’s also a check box that determines whether NDAs are displayed in alphabetical order (the
default) or in the order they appear in the Desk.Accs folder.

Keyboard

The Keyboard control panel (Figure 9E) lets you set attributes of your keyboard with a variety of
pop-up menus and checkboxes. The options are:

]
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Keyboard Buffering ;

Shift Caps/Lowercase
B Fast Space/Delete

Keyboard Mouse: [

Initial Deluu: '
Receleration: [_0.0Sec J |

Keyboard

it

edia Cerl |33

Figure 9e—Keyboard Controf Panel

* Speed: Sets your keyboard’s repeat speed, in number of characters per second.
Longtime HGS users will keep this set at its highest setting.

* Delay: Sets the amount of time you need to hold a key down before it begins to repeat.
Again, old hands will set this to its minimum.

* Dual Speed: Controls whether the arrow keys, space bar, and Delete keys can be
further accelerated during repeat by pressing the Control key.

* Keyboard Buffering: Controls whether the [1GS “buffers” keystrokes. If the computer is
not responding to your keystrokes as quickly as you like, the buffering feature allows
you to “type ahead” of the computer without losing keystrokes. Some older programs
are incompatible with this feature. To clear buffered keystrokes before the program
“sees” them, hold down & and Shift while pressing Delete.

* Shift Caps/Lowercase: Controls whether the Shift key produces lowercase letters when
the Caps Lock key is down.,

* Fast Space/Delete: Controls whether the space bar and delete keys repeat faster than
the rest of the keys.
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The Keyboard Mouse feature is available on ROM 03 1IGs machines, and on ROM 01 if the Easy
Access feature is installed. (Easy Access is not installed by the “Easy Install” procedure.) The
pop-up menus here control how fong it takes the Keyboard Mouse to begin accelerating, how
fast it accelerates, and its maximum speed.

You activate (and deactivate) the Keyboard Mouse by holding down & and Shift while pressing
the Clear key. The numbers around the “5” key on the numeric keypad move the mouse in the
obvious direction—for example, “7" moves the mouse up and to the left, and “2” moves the
mouse down. The “5” key clicks the mouse button; the “0” key holds the mouse button down
(for dragging) until you release it by clicking the “5” key once.

MIDI

The MIDI control panel allows you to specify which type of MIDI (musical instrument) interface
you have attached to your I1Gs. This Control Pancl is installed when you install the SynthLab
application or the Media Control package.

Modem Port & Printer Port

These two control panels (Figure 9F) are virtually identical, so we'll cover them together. We
won't cover the settings in detail—they’re covered in your [IGS Owner's Manual in the section
on the Control Panel CDA. The most important thing to remember-is that the standard settings
are almost always fine for both the modem and printer ports.

EDI=== Nodem Port === Printer Port

Device Type: Your Cord Device Type: Printer

Parity: Parity:
Boud: Baud:
Line Lensth:‘ Line Length:{ Unlimited} |-
Data/Stop: Data/Stop:

E<IDelete LF after CR CJDelete LF after CR
[JRdd LF after tR B Rdd LF after CR
[TlEcho [JEche

[1Buffering A | Buffering

0C0 Handshake BCB Kundshake
OSR/DTR Handshake | B DSR/DTR Handshake
] RON/XOFF Hondshake | [T XON/X0FF Handshake

(_Standord Settings ) (_Standard Settings )

i i

Figure 9F—Modem Port & Printer Port Control Panels
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On the Printer Port control panel, you may (very rarely) need to set Baud to something other
than “9600” if you’ve hooked up a printer other than a standard Apple printer. The “Add LF
after CR” checkbox is also one to keep an eye on—if your printer double-spaces everything, try
turning it off. If your printer prints everything on one line, try turning it on.

The Modem Port control panel will hardly ever need to be changed, because most modem
programs set these parameters for you automatically. You don’t need to set the Baud to “2400"
if you have a 2400 baud modem; your telecommunications package will handle this. (The
exception is when you’re using the built-in modem firmware to telecommunicate; hardly
anyone ever does this, but if you do, you alrcady know what all these settings do anyway.)

= Note!
The America Online software requires nonstandard settings for both the Printer Port and the
Modem Port. f's the only software we know of that does, and the manual for the software tells
you how the ports need to be set.

If you plan to attach a modem to the Printer Port, or a printer to the Modem Port, you'll first
need to use the Slots control panel to tell the [1GS that the appropriate slot should be connected
as the right kind of port. Then open both the Modem and Printer Port control panels (as we've
done in Figure 9F) so that you can easily set the parameters of one to match the other.

Monitor

The Monitor control panel (Figure 9G) tells the 11GS what kind of monitor is attached to your
computer and the various attributes of that monitor. As usual, the default (or factory-normal)
settings are displayed in italic type. The pop-up menus are:

Special Color Extros

‘ Bpen i

Monitor ‘:gugudﬁitbr BUlIIL
CH rype: R

Columns:
Text: -
Back: Dark Blue |-

Border:

Net Printer Y

Figure 9G—Monitor Control Panel
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* Type: If you have an RGB monitor, leave this set to “Color.” If you have a
monochrome (green or amber) monitor, set it to “Monochrome.” You may
occasionally find it useful to switch this setting if the screen is unreadable in one mode
or the other. (If you have an RGB monitor, this setting only makes a difference in one
place—the double-hi-res graphics mode, used by Publish It! and a few other
programs.)

* Columns: Controls the number of columns the computer reverts to after a reset (or at
power-up). We strongly recommend leaving this item set to “40.” This does not mean
that 80-column programs (like AppleWorks) won’t work—they will.

e Text: Selects the color of the text.

* Back: Selects the color of the background. Naturally, this can’t be the same color as
the Text color.

° Border: Selects the color of the border.

RAM

The RAM Control Panel (Figure 9G) allows you to sct the size of your RAM Disk and cache. In
addition, it displays the same kind of information on memory usage as the Finder’s “About the
Finder” window and the Memory Bar NDA included with the Bonus Pack.

@ File Edit #indows View Disk Special Color Extros
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Figure 9H—RAM Control Panel

The RAM Disk is a IGS feature that acts as a very fast, but volatile, disk drive. “Volatile” means
that the contents of the RAM Disk vanish when the power is turned off. By setting the RAM Disk
to 800K (if you have enough free memory to do $o0), you can perform a fast disk-to-disk copy of
the System Disk (or any disk you use a lot) when you first start the system, then restart from the
RAM Disk for accelerated access.
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A By The Way...
The FlashBoot utility included with the Bonus Pack makes this even easier, and allows you to
painlessly save the contents of the RAM Disk to 3.5” disk. See the FlashBoot manual.

The RAM Cache keeps the most frequently used information from your disks in memory, so that
when you access your disks, a lot of the information the computer needs is already in memory.
This can definitely speed your disk access when it works properly. It’s usually not a good idea to
allocate more than 128K worth of cache, though—larger sizes are self-defeating, since the
computer spends more and more time looking to sce if the block is in the cache before it looks
on the disk. (You might want to try various cache sizes and time the activities you perform most
often. If the cache doesn’t seem to help much, release the memory.)

The cache doesn’t really use the memory it uses. (Say what?) What we mean is, the memory the
cache uses is purgable, so if it's needed by another program, the other program will be able to
take it. The cache will not cause out-of-memory errors.

A By The Way...
Even if you set the Ram Cache to zero K, the system still maintains a small (16K) cache.
According to Apple engineers, this is the smallest setting which provides acceptable
performance with 3.5” drives.

SetStart

The SetStart control panel (Figure 9)) determines which program your computer starts up into.
The pop-up menu offers: Finder (the default), the current application (open SetStart while you're
using application you wish to start up into and choose this option), or another application.

w File Edit Hindows View Disk Special Color Extras
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Figure 9J—SetStart Control Panel
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If you choose “Select application,” a Standard Open dialog appears to allow you to choose the
startup application.

= Note!
Even if you start up into some other application, the Finder is still considered the “previous”
application when you quit the startup application.

ue  Shortcut
If you occasionally want to start up into the Finder instead of the startup application you've
selected with SetStart, hold down the & key while your computer starts up. When the SetStart
icon appears with a red “X” drawn through it, release the & key. The Finder will start up instead
of your normal startup application. The next time you start the computer, the application you
selected in SetStart will appear.

Slots

The Slots control panel (Figure 9K) works the same as the Slots option in the Contro! Panel
CDA. There are pop-up menus for each slot, plus another pop-up menu to decide which slot the
computer starts up from. We won't cover the settings of these items in depth; they’re covered in
the Apple 1IGS Owner’s Manual. If you've used the Control Panel CDA to set your slot status
and startup slot, you'll feel right at home here.
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Figure 9K—Slots Control Panel
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Sound

The Sound control panel (Figure 9L) allows you to set the volume and pitch of your I1GS’s beep,
plus it allows you to select a number of other fun sounds for your normal system beep and a
number of other events. (The Sound control panel is not installed by the Easy Install. If you have
a hard drive, you'll definitely want to install it.) The System 6 Bonus Pack also includes over fifty
other fun sounds that you can assign to events in the Finder and other programs.
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Figure 9L—Sound Control Panel

Most of the Events you can assign sounds to are self-explanatory. For example, if you assign a
sound to the “Can’t click there” event, you'll hear that sound whenever you click outside an
alert or dialog window, because you're not supposed to click there. The Whoosh Open and
Whoosh Closed sounds are played when a window “zooms” open or closed. The sound you
assign to the “You Have Mail” event will probably never be heard—we don’t know of any
electronic mail packages for the Apple I1GS.

To assign a sound to an event, first choose the event you want to assign a sound to from the
Event pop-up menu. Then choose the sound from the Sound pop-up menu. The Sound pop-up
menu also allows you to assign silence to any event, or to assign the regular “bonk” beep to the
event (the “Standard Beep” in the Sound menu). If an event is “Not assigned,” the IIGS will
either be silent or use whatever sound you've assigned to the System Beep, depending on the
event, (For example, if “Can’t click there” isn't assigned to any sound, then the System Beep
sound will be used.)
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= Note!
The “Pitch” scroll bar only affects the Standard “bonk” Beep. It does not affect any of the other
sounds in the Sound pop-up menu. Additionally, the pitch and volume are global—you can’t
assign different pitches and volumes to different events. (To do this, check out the Sonics
module in Q Labs’ Signature package.)

Time

The Time control panel (Figure 9M) sets the 11GS's clock and date/time formats, plus reveals the
current time and date—even how many days have passed this year and how many are left.
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Figure 9M-—Time Control Panel

To set the time or date, click the part you want to change (for example, the hour or the seconds)
and use the tiny arrows that appear to adjust the number (or month, or AM/PM) up and down.

ns  Shortcut
You can use the Tab key to move from field to field in the time and date. The up and down
arrow keys scroll through the valid settings of the fields. You can type new values directly into
the number fields (for example, to set the hour to 11 just type “11”) and the AM/PM field
(press “A” or “P”).

The radio buttons below the clock settings are used to select the 1GS's default time and date
display formats. Most Americans are used to seeing the month first, but in other countries the
day comes first. You can also view the date with the year first, then the month and the day. The
time can be displayed in AM/PM or 24-hour formats. These settings are used by most I1Gs
programs that display the date or time.
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The Time control panel can also take care of Daylight Savings Time for you. If you live in an
area that goes into Daylight Savings Time half the year, check the “Auto daylight savings” box
and you’ll never have to worry about springing your HGS clock ahead or falling back—at least
until the government changes when DST starts and ends again. If you live in an area which
doesn’t use Daylight Savings Time, or if you want to control your IlGS clock manually, uncheck
the “Auto” box and click the appropriate radio button for standard or daylight time.

A By The Way...
If you believe in Santa Claus, click the text that tells you how many days are left in the year.

132 Chapter Nine



Chapter Ten

WORKING WITH OTHER PROGI@; M

About The Other Programs

In addition to the parts of System 6 we've talked about so far, the System 6 package also
includes several applications that work with the System Software. Since these programs
generally do something useful from a system standpoint, we call them utilities. These
applications are;

Installer: installs and de-installs System 6 updates

Advanced Disk Utility (ADU): Formats and partitions SCS! hard drives

Teach: A simple word processor for reading documentation files and writing things
Archiver: For making backup copies of disks and files

SynthLab: A nifty music and synthesis program ‘

Apple Bowl: Okay, so it’s not so useful. As games go, it's not even particularly state-of-
the-art. For sheer nostalgia value, though, it's a winner.

The System 6 Bonus Pack adds:

¢ The Bonus Pack itself—a collection of DAs, Finder Extensions, clip arts, sounds, and
other good stuff

HyperSound: Converts System 6 “resource” sounds to HyperStudio-type sounds
FlashBoot: A RAM Disk management utility

Shrinklt: A data compression/archival utility

A couple other nifty things

The Installer

We already introduced you to the Installer way back in Chapter 2, but some further verbiage is
in order, since we only touched the surface of the Installer’s capabilities.

The Installer has two modes—"Easy Update” and “Customized” installation. You use the “Easy
Update” most of the time; you use “Customized” installation when you want to install more
than the “standard” configuration of system software (or when you want to remove part of the
system software you're not using). We'll cover each mode separately—they’re almost like two
separate programs.
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Easy Update

The Installer’s Fasy Update screen (Figure 10A) is a non-threatening dialog that allows you to
select the disk you want to install the update on and begin installation, all by clicking buttons.
The disk that will be updated is indicated by the message “Click ‘Easy Update’ to install Apple
[1GS System Software on the disk ‘Q1””—or whatever the disk name might be. The buttons have
the following functions:

& File {3t Help

Aople 1168 Installer - Easy Update
Click “Easy Update” to install Apple 1165
§9051t.en Software version 6.0 on the disk ( Eusy Update B

Click “Change Disk” if *Easy Update” is ( ; ?
disabled. *Easy Updote” can’t modify the Change Disk
current startup disk, the Installer Eect )

disks, or non-ProD05 disks.
v

3 §6

Figure 10A—The Installer's “Easy Update” Screen

“Easy Update”—begins installation on the selected disk
“Change Disk”—changes to the next disk connected to your HGS
“Eject”—ejects the chosen disk if the disk can be cjected
“Customize”—switches to customized installation

“Quit”’—-quits the Installer

“Help”—displays a summary of the Installer’s purpose

¢ © & & o o

Additionally, the menu bar remains active—you can select the following menu items:

“About” (€ menu)—displays credits for the Installer

¢ “Erase disk” (File menu)—erases the selected disk (you might occasionally want to
erase an old disk before beginning installation)

* “Quit” {file menu)—quits the Installer

* Help menu—allows you to select from a variety of helpful hints

The “Easy Update” procedure generally installs the following system software on a drive that
contains no existing system software (the software installed may vary based on your system
configuration and the size of the disk vou're installing to0):
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System 6 and the Finder

The Control Panels desk accessory

The General, RAM, Printer, Slots, and SetStart control panels

Drivers for Apple 5.25” and 3.5” drives—but no printer drivers

Drivers for a SCSI Hard Drive connected to an Apple SCSI Card

A File System Translator to access System 6 to access ProDOS disks
Standard fonts (unless space is limited; then minimum fonts are installed)

® © ¢ © © ©° o

If you perform an “Easy Update” on a disk that already contains system software (such as a hard
drive that has System 5 installed on it), the Installer updates all the currently installed system
software to new versions and deletes any files which are no longer needed.

A By The Way...

We recommend “Easy Update” as a good starting point for most System 6 installations. The
Installer’s help screens recommend a different installation procedure for hard drives (the
“System 6: Hard Disk” script in custom installation, to be exact), but we don’t recommend that
method because it installs the Special Aids tools for disabled users, which most users won't
need and which are incompatible with many popular programs (for example, AppleWorks GS).

Custom Installation

The Installer’s “Custom” installation screen (Figure 10B) allows you to select various system
updates from a scrolling list just by clicking the mouse. You can select multiple updates by
holding down the & key while clicking the second and subsequent updates (the same maneuver
unselects an update if you selected one accidentally). We've described each of these updates in
some detail in Chapter 2; we won't repeat that information here.

& File fit Help

B ((Tstall
¥System B; Ho "Stort" Update |

*Sgstem 6: Un SUOK stk ..........................
Application: Adv. Disk Utility
fipplication: fpple Bowl gl

Application: Archiver i
fipplication: synthLAB (-————)
Quit

o lIpdate Selection ———— = Rpplication Folder Selection ==

—  bisk YO Gen )
Easy Update l k ( Hiest Y( dewTolder.. )

Please select the desired update and the disk or folder where you want to
install the update.

Figure 10B—The Instailer's “Customized Installation” Screen
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if you've selected an application (for example, Teach) for installation, the right side of the screen
will become a Standard Save dialog, complete with “Open” and “New Folder” buttons and a
pop-up folder menu, so you can tell the Installer where to put the application(s).

A By The Way...
The SynthLab application, since it consists of multiple files and folders, does not allow you to
select a folder for installation. Instead, SynthLab is always installed in a folder called SynthLab
in the main directory of the disk you've selected for installation.

As with the “Easy Install” screen, the “Customized Installation” window is controlled by clicking
on buttons. The buttons are:

“Install”—Installs the selected update(s)

“Remove”’—Removes the selected updatel(s)

“Help”—Displays information about the selected update.

“Quit”"—Quits the Installer

“Easy Update”—Returns to the “Easy Update” screen

“Disk”—Chaoses the next disk for installation

“Eject”—Ejects a disk if it's removable

“Open”—Opens a folder (accessible if you're installing one or more applications)
“New Folder”—Creates and opens a new folder (accessible if you're installing one or
more applications)

®¢ © &6 & © o ¢ o o

The menus remain active here, too—see the “Easy Install” section for details on each.,

A By The Way...
You can write your own “scripts” to tell the Installer how to install software you develop.
Explaining how to do that is, however, heyond the scope of this book. Consult [1GS Technical
Note #64 (available from most user groups, online services, and via the Apple Programmers’
and Developers’ Association) for more details.

Advanced Disk Utility (ADU)

The Advanced Disk Utility (ADU) are useful mainly for preparing hard drives to store
information; while it will work with other kinds of disks, most of the functions it performs can
be performed just as well by the Finder if you're only dealing with floppies.

If you have only one hard drive and want to use ADU on it, you'll need to boot from a copy of
the 3.5” System Disk.

The main ADU screen (Figure 10C) is the “launch pad” for the entire program. From here, you
can perform the following functions by clicking on buttons:
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( zero. ) (Initialize..)

( Info ) ( Erose. )

The disk name is (1

Figure 10C—The Advanced Disk Utility

Disk: Chooses the disk on which to perform an operation.
Quit: Quits the Advanced Disk Utility.

Initialize:Prepares the disk to receive data. If your disk was a parking lot in which cars
(files) can be parked, initializing it would be equivalent to painting lines and numbers
on the pavement to divide the lot into parking spaces.

Zero: Zeroing a disk erases all the data on it, including the operating system and the
directory itself. After a disk has been zeroed, it must be initialized before any data can
be stored on it. Zeroing a disk can take some time; it's equivalent to re-paving the
parking lot.

Erase: Erasing a disk removes all the cars from the parking lot, but leaves the lines and
numbers in place by writing a new directory.

Partition: Divides your parking lot into smaller parking lots. Each lot can hold different
kinds of cars (files). Additionally, since ProDOS parking lots can have a maximum of
thirty-two million spaces, you partition large hard drives into smaller ones so that you
can use the whole drive.

Info: Displays information about your parking lot, er, disk.

Warning!
The Initialize, Zero, and Partition operations erase al! the data on the disk you use them on!
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Partitioning A New Hard Drive

Usually you'll use ADU to prepare a new hard drive you've just received. (Most hard drive
retailers do this for you, but you may come across a drive that isn‘t partitioned..) Here’s how:

¢ Plan your partitions. We suggest making as many 32 megabyte partitions as you can,
and assigning the remainder of the space to a spare partition. Another approach is to
divide it equally—this works well on'a 100 megabyte drive, which divides nicely into
four 25 meg partitions (or three 32 meg partitions and one 4 meg partition). You could
also make an HFS partition larger than 32 meg if you frequently use the hard drive on
a Macintosh.

¢ Click the “Disk” button repeatedly until the drive you want to initialize is selected.
(This will probably be the one without a name, as evidenced by the message
“Uninitialized or no disk in drive” in place of the disk name.)

¢ Click the “Partition” button. The partition screen (Figure 10D) will appear. At first, the
entire drive will be assigned to a single partition called “UNTITLED1.”

& File fdit

] UNTITLEDL

— UNTITLEDL (100%)

Figure 10D—Advanced Disk Utility: Partitioning A Hard Drive

¢ Type the name of the first partition. If you're not too creative, you can name your hard
drive partitions Hard1, Hard2, Hard3, and so forth. Or you can name them after the
Seven Dwarfs or the Seven Deadly Sins. Whatever floats your boat. Just make sure that
the name conforms to regular ProDOS naming conventions.

* Set the partition’s size using the Size scroll bar. The bar graph to the right of the screen
displays the relative size of each partition.
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Press Return to confirm the name and size you specified.

Click New to create the next partition. Name it and set its size. If you try to assign
more than the total amount of unassigned space, ADU will display a message to that
effect and assign the rest of the space on the disk to the partition. Continue to create
and assign new partitions until you've created all the partitions you want.

Finally, make any last-minute changes to partition names and sizes. To change a
partition’s name or size, just click the partition’s name in the partition list and make
the changes to its name or size. If you have already allocated all the space on the drive
and want to make a partition larger, you must first make one of the other partitions
smaller.

By The Way...
If you partition a drive that’s already been partitioned, you'll come directly to the above screen
to change the partition sizes.

Now click the “Partition” button. Each partition will now be initialized; select its
operating system (usually ProDOS is OK) from the standard Initialize dialog. Quit to
the Finder and your newly partitioned hard drive should appear!

&
|

File Edit Font Style Size
e Shortcuts

System 6.9 Tips end Shertcuts

There is usually more than one woy to perfoI; a function on your Apple 116S. A
number of shortcuts have been built-in to the System 6 software to provide the
greatest flexibility and efficiency. This document lists o number of tips and
shortcuts that may or moy not have been described in the manual. You moy have
ulready discovered some of these for yourself, but many are not obvious.

Note: if you run across terms which are unfamiliar to you, please check the glossary
at the back of the System § User's Reference. This document assumes some
familiority with the operation of your 65 and with sustem software. Consult your
manual if you run acroess an area which is unfomiliar to you.

System Startup Uptions

When turning on the computer or rebooting, hold down the 'Shift’ key to inhibit
loading of non-system Inits (in the System Setup folder) and all desk actessories
(in the Desk.fecs folder). This can be useful if you've recently added an init or DA
that orevents the sustem from booting normallu. You can use the ‘Shift’ kew to boot

Figure 10E—Teach, System 6's Mini Word Processor
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Teach

Teach (Figure 10E) is a simple word processor included with System 6. It includes the basic
features you need to browse through files and to write and print short notes, although a full-
featured word processor like Graphic Writer 11l or AppleWorks GS is better for larger projects. It
supports as many simultaneously open files as you have memory for.

The windows are all standard 1GS windows that can be moved, resized, and scrolled. The
regular text-edit actions are available for changing the text. The standard File options are all
available, as well. To apply a font, first select the text, then select the desired font from the Fonts
menu. Same with Style and Size. If you’ve been following along in our discussion of the
Desktop, there’s nothing here you haven’t seen before.

@ File {div Special

Welcome to Archiver!

(O Back up entire volume
@ Back up files
C Restore backup

Figure 10F—The Archiver: Opening Screen

Archiver

The Archiver, too, is straightforward. It's a simple program for backing up the contents of your
hard drive to floppies (or to a tape drive), or for backing up the contents of floppies into files on
a hard drive. For this section, we're going to assume you’re familiar with backing up your hard
drive in some way and the basic concepts of backups.
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The Archiver’s opening screen (Figure 10F) allows you to select whether you want to back up
an entire volume (as would be the case when making a backup of a 3.5” disk into a file on a
hard drive) or the files on a volume (usually the case when making a backup of a hard drive—
the Archiver has the capability to back up only the files that have changed after a certain date,
making hard drive backups much more bearable). Or you can restore a backup you've already
made (for example, when recreating your hard drive’s contents after a crash),

Back Up Entire Volume

Backing up an entire volume is the simplest backup operation. The Volume Backup screen
(Figure 10G) lets you select the volume to be backed up (via the “Volume” button), and whether
you want to back up to a device or a file. If you want to back up an entire hard drive onto a set
of floppy disks, select the “Device” radio button and click the “Device” button to select the
drive that you'll put the disks into. If you'll be backing up a floppy disk into a file on a hard
drive, click the “File” radio button and then click the “File...” button to create and name the file
with a Standard Open dialog.

& File fdit Special

Yolume Backup

Backup from:

01

Backup to: (@ Device
OFile APPLEDISK3.5A

(Contains :SystemTools?)

Figure 16G—Archiver Volume Backup Screen

When you've chosen those options, click “Back Up.” On the next screen, enter a comment for
this set of backup disks and click “Begin.” And the operation will, in fact, begin. The Archiver
will prompt you to switch disks when necessary, and will automatically initialize blank disks
when they’re inserted.

The “Back Up Entire Volume” operation backs up everything on the source disk on a block-by-
block basis. It doesn’t care about files, folders, or anything else. Thus, when you restore a
volume backup, you must restore it to a volume of the same size, and the restoration operation
will erase the existing contents of the volume.

Waorking With Other Programs 141



Back Up Files

“Back Up Files” is more flexible. Selecting that brings you to the Selected Files Backup screen
(Figure T0H). As before, you tell Archiver what volume you want to back up from, and the
device (or file) you want to back up to. Usually, you'll select a 3.5” drive or SCSI tape drive,
though you can also back up to a file on another hard drive.

& File 3t Special

Selected Files Backup
Backup from: T
0
Backup to: (@ Device EEFE
Ofile APPLEDISK3.5A

(Contains :SystemTools2)

Figure 10H—Archiver File Backup Screen

Click “Files” and the Archiver will ask you if you want to use a saved file list. (The Archiver can
remember a list of files you regularly back up, then back those up automatically.) For now, click
“No.” This brings you (in a few seconds) to the file selection screen (Figure 10)).

Here’s where you tell the Archiver which files you want to back up. Initially, all the files on the
volume you've chosen will be marked for backup. To mark or unmark a file or folder for
backup, click the file’s name and click “Mark” or “Unmark.”

A gray folder indicates that some or all of the files in the folder are marked. You can double-
click a folder to open it—the contents of the folder will be displayed, indented, below it. Each
level of folder indents the listing further to the right. This way, you can mark and unmark
individual files for backup, no matter how deep in the folder dungeon they are. Double-click
the folder again to close it and hide its contents.

You can choose “Select All” from the Special menu, then click “Mark” or “Unmark” to mark or
unmark all files for backup. (Marking a folder automatically marks all of its contents).
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The “Auto” button is one of the Archiver’s most powerful features. Click it and the Auto-Mark
screen (Figure 10K) appears. Using a fill-in-the-blanks approach, you can tell the Archiver to
mark (or unmark) certain files. To back up only the files that have changed since your last
backup, you might first unmark all files, then use Auto-Mark to mark all the files whose
modification (“mod”) date is on or after your last backup date. You can also use this feature to
mark all the files whose names meet certain criteria.
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Figure 10J—Archiver File Selection Dialog
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Figure 10K—Archiver Auto-Mark Dialog
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You can use “and” and “or” logic to mark or unmark all files whose names start with the letter
“A” and also were modified since the last backup date (“and” option), or to mark all the files
containing “Data” and “ApplcWorks” in one swoop (“or” option). Fill in this dialog then click
“OK" to mark or unmark files according to the criteria you selected. The Archiver even goes into
all your folders and applies your tests there.

Click “Back Up” and you'll have a chance to enter a name for your backup, just as before. Click
“Begin” and you'll get started. As before, the Archiver will tell you when to switch disks.

Restore Backup

When you need to restore a backup (which we hope you never do—may your hard drive
always run smoothly), use this option (Figure 10L). Tell the Archiver which kind of backup you
want to restore from (File or Device) and identify the file or device. The Archiver will tell you
the comment you entered when you made the backup.

Restore
Restore from: @ Device i
Ofile APPLEDISK3.5A

(Contains :SystemTools2)
Backup set comment: {insert Archiver disk..)

Disk/Tape number:
Tetal backup size:

Restore to:

(Cancel J ([ Files. P

Figure 10L—Archiver Restore Screen

Click “Files” to select which files you'll be restoring (this only works when you're restoring a
file-by-file backup). The file selection screen for this operation is much the same as when you
backed up the fites originally.

Click “Folder” to tell the Archiver where to put the restored files {again, not available with
volume backups).

Click “Begin” and the restore will begin. Follow the prompts and insert the disks when
requested.
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Save File List

The “Save File List” menu option (on the File menu) allows you to save a list of the files you've
marked with the Back Up Files option. If you often back up the same set of files, select this

option from the pull-down menu and give th
back up by file the next time.

Preferences

The Special menu’s “Preference” option displ

e sct a name. Then you can use that set when you

ays the Archiver Preferences dialog (Figure 1T0M).

@ File fdi

For backup:

Preferences

Verify disks after writing

Erose destination media without asking
Interrupt backup for file read error
Compress volume backup
Yolume back up only blocks in use

For restore:

] Always reploce files with duplicate nomes
[ Translate illegal filenames automatically

Use these settings: @ now

\

O always

Figure 10M—Archiver Preferences Dialog

e Verify disks after writing—makes sure that the archived data was written correctly after

filling a backup disk. We recommend le

aving this option checked.

* Frase destination media without asking—allows the Archiver 1o erase the disks you're

using for your backup without asking

* Interrupt backup for file read error—I
continue backing up your hard drive
files), uncheck this option.

first, even if there's already something on them.
fyou have errors on your hard drive but want to
in the event of an error (to back up all the good

* Compress volume backup—Uses data compression to make backing up a volume

smaller.

* Volume back up only blocks in use—For most disks, you can leave this option

checked. If the volume's bitmap is dam
back up all the blocks on the disk, even

aged or invalid, you can uncheck this option to
if they're not marked as being used by files.
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¢ Always replace files with duplicate names—Check this option if you always want to
replace files already on the disk with older versions from the backup.

» Translate illegal filenames automatically—Forces the names of the restored files to fit
the format of the disk you're restoring to without asking.

¢ Use these settings now—Uses the settings for the current Archiver session but doesn’t
save them for the next session.

o Use these seitings always—Saves the settings for future Archiver sessions and uses
them for the current session as well.

SynthLab

SynthLab (Figure 10N) is a nifty program for recording and playing music on your lIGS.
However, its sound design and sequencing facilities require some knowledge of synthesis and
MID! technology, and it's not our goal to teach you these things. Most users will use it only for
playing back pre-recorded songs (several are included), and that's all we’re going to explain. If
you're adventurous, you may be able to figure some of the rest of it out by yourself. (If you're a
programmer or musician, contact the Apple Programmers” and Developers’ association for more
involved documentation on SynthLab and the MidiSynth toolset.)

Figure 10N—SynthLab Music & Synthesis Utility
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SynthLab is a psuedo-desktop program. It looks like a desktop program and it’s controlied by the
mouse, but it behaves somewhat differently from most desktop programs. For example, the
menu bar doesn’t pull down the menus in sequence if you drag across the menu bar; you have
to release one menu before choosing another. The # menu, too, doesn’t list all your NDAs,
Why Apple itself would release a program that doesn’t follow the most basic of Desktop user
interface guidelines is beyond us, but there it is,

The “Open Sequence” option on the File menu is where most users will start. The Standard
Open dialog opens up to the Seq.And.Instr folder inside the SynthLab folder, but you can also
maneuver it to other folders. To play a sequence you’ve loaded, click the “Play” button (the one
with the rightward-pointing arrow). Simple cnough, right?

To quit the program, choose “Quit” from the File menu.

Apple Bowl

As we've mentioned before, this program isn't really good for much but nostalgia value. Well, it
is a pretty good little bowling game—if you don’t mind the fact it was written about ten years
ago for the Apple Il (not the I+, not the lle—the Apple Il). The program, in fact, appeared on an
early Apple I system disk. (Or maybe it was a cassette tape—we can’t remember that far back.)

The program is self-explanatory, or at least self-documenting, and it’s also a good demonstration
of how you can be running a IIGS program and still not be using the Desktop. Have fun.

A By The Way...

Apple Bowl was originally written in Integer BASIC (remember that?). Apple engineers used
The Byte Works” ORCA/Integer Basic compiler to convert it to a standalone 11GS program.

The Bonus Pack

We've already explained how to use some of the Bonus Pack’s components—the desk
accessories and finder extensions, in the chapter on Desk Accessories. The Fonts, Sounds, and
Icons, when installed in the proper places in your System folder, are automatically available to
you—the fonts appear in any application that allows you to choose fonts for your text, and the
sounds appear automatically in the Sounds control panel. The icons show up in the Finder—
we've included icons for many popular applications and documents.

A By The Way...
We've included TrueType versions of five of the Bonus Fonts. If you have WestCode’s Pointless
software, unpack the file Truetypes.SHK from the Bonus Fonts 2 disk to your TrueType font
directory and configure Pointless to use them. If you don’t have Pointless, don’t worry; the
same fonts are also included as standard 11GS fonts.
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The clip art files are standard Super High Resolution (SHR) graphics screens and can be loaded
by programs that use graphics such as Platinum Paint, HyperStudio, HyperCard [IGS, and
AppleWorks GS. Some are 640-mode graphics, which have fine detail but are limited in color,
and others are 320-mode graphics, which have plenty of color but not as much fine detail.
Check your graphics programs to see which files they’ll deal with.

HyperSound

The sounds we've included are in System 6 format, known among the technically-minded as
“rSound” (or resource sound) format. System 6 and HyperCard IIGS can use these sounds fine.
But HyperStudio and many other popular programs can’t use these sounds. So we've included
an exclusive program called HyperSound, which converts “rSound” sounds to “HyperStudio”
sounds, which HyperStudio (naturally) and other programs can use. The program is on the
Bonus Stuff disk and can be launched from the Finder.

The program converts the sounds “in place”—meaning that when the program has finished
running, you won‘t have rSounds anymore. Therefore, you shouldn’t use HyperSound to
convert the sounds in your startup disk’s Sound folder. Make another copy of the sounds you
want to use with HyperStudio (or other programs) first so you don't lose the original rSounds.

HyperSound is quite simple to operate. There aren’t any menus because the program only does
one thing. Just use the multi-file Open dialog to choose the file(s) you want to select (hold down
the G key to select the second and subsequent files, or select all the files in a directory by
clicking the first one, then shift-clicking the last one). Then click the “Accept” button and
HyperSound will convert the sounds.

FlashBoot

FlashBoot allows you to use the HGS's RAM Disk to store your most frequently used programs
and switch between them quickly, and to also streamline loading and backing up your RAM
Disk each time you use it. It's ideal for users without hard drives.

= Note!
Instead of including a separate (but nearly empty) FlashBoot disk, we included the FlashBoot
program on the Bonus Stuff disk. Start up via the Bonus Stuff disk to use FlashBoot.

We've included a separate manual for this program. The manual was written before System 6
was released, but hardly anything has changed. Use the Installer to perform an Easy Install on
the RAM Disk after preparing it with FlashBoot, then install your favorite programs as described
in the FlashBoot manual.

== Note!
Pardon the blatant sales ploy here, but did you know you can now buy a whopping four
megabytes of RAM for your computer—making it into a perfect machine for FlashBoot—for
less than $200 from Quality Computers?
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Shrinklt

You've already used Shrinkit (on the Bonus Stuff disk) to install the Bonus Pack. It's a good
general-purpose data compression utility and is frequently used to archive files for transfer via
modem. By compressing your least frequently used files with Shrinklt, you can keep them handy
on the hard drive but free a good deal of the space they usually take up. You'll have to unpack
them again before you can use them, of course, but Shrinklt is good for storing old files you
won’t need to reference very option.

A documentation file for Shrinklt is included on the Bonus Stuff disk. Use Teach to read it. We
highly recommend this utility for all Apple 11GS users!

= Note!
Shrinkit author Andy Nicholas now works for Apple. In fact, he wrote the System 6 Finder
(along with Dave Lyons, whose Memory Bar NDA is included in the Bonus Pack).

The Other Nifty Things

Gee, as if the Bonus Pack isn’t enough—we’ve also included ZZCopy (which you used to back
up your original System 6 disks). (You did back up your original System 6 disks, right?)
Documentation for the program can be printed or viewed from within the program—click the
blank panel in the middle of the bottom of the screen, then click the printer or monitor icon
(next to “Documentation”) to read or view the instructions.

The ZZCopy disk had some extra space, so we included a few other programs—an icon editor,
a font editor, and a few other things. Insert the ZZCopy disk at the Finder to access these files.
Some of these programs are shareware, which means that you should send the author of the
program a fee if you find the program useful. These extra programs are not strictly part of the
Bonus Pack, and buying the Bonus Pack does not entitle you to use the shareware programs
without paying the required fee.

All these programs have included documentation files, which can be opened and printed with
Teach. The ZZCopy disk only can be distributed to your friends; please don’t make illegitimate
copies of the other disks in the Bonus Pack.

= Note!
We are acting only as a distributor for the programs on the ZZCopy disk (including ZZCopy
itself). We do not guarantee that these programs work for any particular purpose, nor do we
provide technical support for the programs. And we’d like to remind you once again—pay for
the shareware programs if you use them. You have a legal and moral obligation to do so, plus
you'll be supporting the authors so they can keep producing shareware programs and thus
keep the Apple I market interesting.
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